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3D Basemaps 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. The capabilities have been replaced with 3D Buildings and Tree Data 

Management. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to 3D Basemaps 
3D Basemaps can be used to author and maintain a 3D basemap for your organization. 

It provides a series of workflows that streamline the creation and maintenance of a 3D basemap 

that supports diverse information needs. This optimized approach allows organizations to use 

existing data (for example, lidar, building footprints, utilities) and generate 3D visualizations that 

increase understanding and community engagement. 3D Basemaps is typically implemented by 

planning departments, emergency management agencies, GIS departments, and utilities that 

want to use 3D basemaps to visualize the built environment. 

The 3D Basemaps solution delivers a set of capabilities that help you use existing data (for 

example, lidar, building footprints, utilities), develop a standard set of 3D layers, and visualize 

your community in an immersive way. 

 

Requirements 
The 3D Basemaps solution requires the following: 

• ArcGIS Enterprise 10.6 - 10.8.1 

• ArcGIS Pro 2.6 - ArcGIS Pro 2.9 (Advanced) 

– ArcGIS 3D Analyst extension 

– ArcGIS Spatial Analyst extension 
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Information products 
3D Basemaps includes the following information products: 

Item Description 

Minimum user 

type 

 

3D 

Basemaps 

 

An ArcGIS Pro project used by GIS analysts and mapping 

technicians to create and maintain a 3D basemap for their 

organization 

 

GIS Professional 

Advanced 

 

Release notes 
The following are the release notes: 

Version Description 

 

1.2 

 

• Added an integrated mesh editing and maintenance workflow 

• Added the ability to color trees in lidar point clouds 

• Lidar class codes can now be preserved when classifying trees using deep 
learning 

• Improved stability of footprint segmentation 

• Fixed an issue with extracting tree points using cluster analysis 

1.1 • Added deep learning for tree classification in lidar 

• Added tree extraction using cluster analysis 

• Significantly improved the performance and quality of building footprint 
extraction 

• Added links to 3D analysis solutions that can use 3D basemaps layers 

• Fixed an issue with building footprint extraction in ArcGIS Pro 2.6 

1.0 • First release of 3D Basemaps 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 5 

Use 3D Basemaps 
The 3D Basemaps solution delivers a set of capabilities that help you leverage existing data (for 

example, lidar, building footprints, utilities), develop a standard set of 3D layers, and visualize 

your community in an immersive way. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Get to know 3D Basemaps 
You will assume the role of a mapping technician responsible for creating a 3D basemap for 

your community. The 3D Basemaps ArcGIS Pro project includes a series of tasks to help guide 

you through these workflows. The first set of tasks will help you get to know 3D Basemaps. 

1. Start the ArcGIS Pro application and open the 3D Basemaps project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Getting to know 3D 
Basemaps task and go through the various subtasks. 

 

Understand the 3D Basemaps solution 
The 3D Basemaps solution uses existing data within the organization such as lidar, building 

footprints, power lines, and underground pipe features. Your 3D basemap can be created at 

different levels of detail (LOD) depending on the quality of the input lidar data. This first task will 

guide you through the data requirements and help you learn how you can utilize your 3D 

basemap in other workflows and applications. 

 

Download sample data 
Sample data is provided to help you learn how to use the 3D Basemaps solution. Click to 

expand the Getting to know 3D Basemaps task group and double-click on Download sample 

data task. Click the sample data hyperlink to download sample data for Naperville and 

Philadelphia. Using the sample data the first time will help you learn how to use the tasks and 

how to organize your data. 

 

Start using 3D Basemaps 
The 3D Basemaps project includes a task workflow that provides a structured sequence using 

tasks and steps. Follow the steps in this task to learn how to use the 3D Basemaps solution. 

 

Publish data for your 3D Basemaps 
After you have reviewed the Get to know 3D Basemaps section, you can begin using the 

solution with your data. The following set of tasks will help you learn how to use 3D Basemaps. 

https://www.esri.com/en-us/privacy/overview
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1. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

2. In the Catalog pane, expand the Tasks folder, and double-click the How to use 3D 
Basemaps task and go through the various subtasks. 

 

Publish ground elevation surface 
Detailed elevation layers can be automatically generated from the input lidar data. These layers 

are used to create buildings and vegetation layers. The ground elevation layer can be used to 

enhance the existing elevation in your 3D scene. 

To publish your ground elevation surface, click the Publish ground elevation surface task and 

follow the steps provided. 

 

Extract elevation surfaces from LAS dataset 
This task extracts three elevation surfaces from the LAS dataset: a ground elevation (dtm), a 

surface elevation (dsm), and a normalized surface elevation (ndsm). These surfaces are used to 

create buildings and vegetation layers. The ground elevation layer can also be used to improve 

the ground in your scene. 

 

Publish ground elevation 
This task publishes the ground elevation layer to your organization. Reprojection to Web 

Mercator with height in meters is only required if you want to use the published layers in a global 

web scene. 

 

Publish buildings 
Buildings with simple roof structures can be generated automatically from the lidar. Attributes 

such as building height, eave height, and the roof form are extracted from the lidar and added to 

the building footprints. Procedural rules are then used to create the 3D roof structures. High-

density lidar (point spacing less than 3 feet) and building footprint segmentation are needed to 

model complex roof structures. 

Note: 

The quality of the roof structures is dependent on the quality of the input lidar and building 
footprint data. A lidar point spacing of 3 feet or less is required, 1 foot or less is 
recommended. Building footprints with one roof type within their boundary (for example, 
suburban areas) will produce higher-quality roof structures than footprints with multiple roof 
types (for example, city centers). These footprints require splitting, segmentation, and 
updating of the roof form attributes. 

To publish your buildings, expand the Publish buildings group task and follow the steps 

provided. 

https://www.esri.com/en-us/privacy/overview
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Extract building footprints (optional) 
Run the Extract building footprints task to optionally extract building footprints from lidar. It is 

not required if you have an accurate footprint feature class. 

 

Preprocess building footprints (optional) 
Run the Preprocess building footprints task to prepare the building footprints for a realistic 

3D visualization. Some building footprints may contain several roof types and roof parts. To 

accurately represent these buildings, they need be split into their separate parts. Building 

footprints can be split with another feature class or by differences in elevation. 

 

This image shows the result of building extraction before preprocessing of building footprints. 

 

https://www.esri.com/en-us/privacy/overview
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This image shows the result of building extraction after preprocessing of building footprints. 

Tip: 

Separate features of similar size into separate feature classes before running segmentation 
to improve segmentation quality. Use different spectral and spatial detail for each of these 
feature classes to tweak the roof segmentation for your data. Merge the feature classes 
when finished. 

 

Create buildings 
Run the Create buildings task to create a 3D building layer. This task uses the elevation 

surfaces and building footprints to find both flat and sloped planar areas within a roof area of a 

building. It estimates a standard architectural form for the roof based on the attributes collected 

from these planar surfaces. These attributes are then used to inform a procedural rule that 

generates these features in 3D. 

 

This image shows the roof types that will be automatically classified. 

 

Review buildings 
Run the Review buildings task to inspect your building roof forms. The Confidence 

Measurement tool reports the following measurement (attribute added to the building 

footprints): 

Note: 

The RMSE field shows the root mean square error of the generated building multipatch to 
the underlying surface model. The higher this number, the more likely that the building 
creation encountered an error in classification. In general, a value of 1 meter (3 feet) or less 

https://www.esri.com/en-us/privacy/overview
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is desirable, though this depends on the required application of the output features, and the 
resolution of the input data. 

 

Modify buildings 
Use the Modify buildings task to further improve the quality of the building roof forms. The 

building roof form is driven by the attributes that are generated by the Create buildings task and 

by the underlying the building footprint. To refine the building roof form, modify the attributes or 

the building footprint. 

Tip: 

The attributes that control the roof form are building height, eave height, roof direction, and 
the type of roof are BLDGHEIGHT,EAVEHEIGHT, ROOFFORM, RoofDirAdjust. By 
editing these attributes, you can adjust your building models to better match the lidar data. 

 

Building footprint attributes that control the roof form. 

 

Building height 

If the ridge of the building is not at the correct height, identify the elevation of a LAS point on the 

true ridge by clicking the LAS point while having the Explore tool active. You will need to 

subtract the BASEELEV value from the LAS elevation to get the correct BLDGHEIGHT value. 

 

Results of manual updating of the BLDGHEIGHT attribute are shown. 

 

Eave height 

Similar to building height, reference the lidar to obtain the correct eave height. You will need to 

subtract the BASEELEV from the lidar elevation to get the correct the EAVEHEIGHT value. 

 

https://www.esri.com/en-us/privacy/overview
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Results of manual updating of the EAVEHEIGHT attribute are shown. 

 

Roof form 

If your roof type does not match the lidar data, change the roof type by choosing the correct roof 

form from the drop-down list. 

 

Results of manual updating of the ROOFORM attribute are shown. 

 

Roof direction 

Adjust the direction of the roof by modifying the RoofDirAdjust field. The default value is 0. A 

value of 1 will rotate the roof counterclockwise 90 degrees, or a value of 2 will rotate it 180 

degrees. 

 

Results of manual updating of the RoofDirAdjust attribute are shown. 

 

Split roof segments 

Some building footprints may contain several roof types and roof parts. To accurately represent 

these buildings, you can split the footprints into separate features manually and update the 

attributes for each feature accordingly. 

To edit the building footprints, complete the following steps: 

1. Select the feature you want to segment. 

2. Use the Split tool in the Roof Segmentation task, or in the Modify Features pane to 
segment the selected feature. 

3. Edit the attributes as needed with the new sections of the building footprint. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 11 

 

Results of manual splitting of buildings are shown. 

 

Modify building vertices 

Sometimes building footprints may have been created incorrectly and do not represent the 

building adequately, resulting in lower-quality roof forms. 

To edit the building footprints, complete the following steps: 

1. Select the feature you want to modify. 

2. Use the Vertices tool in the Modify Building Vertices task, or on the Edit tab to modify the 
selected feature. 

3. Edit the attributes as needed with the modified building footprint. 

 

Results of manual updating of building vertices are shown. 

 

Create cross gable roof forms 

You can also use vertex editing to make cross gable roof forms. To do so, complete the 

following steps: 

1. Select the feature you want to modify. 

https://www.esri.com/en-us/privacy/overview
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2. Use the Split tool in the Roof Segmentation task, or on the Edit tab to segment the 
building footprint according to the roof forms present within the footprint. 

3. Use the Vertices tool in the Modify Building Vertices task, or in the Modify Features pane 
to extend one gable roof into the other one. 

4. Edit the attributes as needed with the modified building footprint. 

 

Results of manual updating of cross gable roof forms are shown. 

 

Fuse buildings 
If you have segmented some building footprints into separate features, you can use the Fuse 

buildings task to fuse the building features that represent building parts back together in the 

resulting 3D building features. 

Note: 

Review and modification of buildings is done on the building footprint layer with procedural 
symbology. Fusing saves the modification to multipatch format for texture adding and 
publishing. 

 

Add textures to buildings (optional) 
Use this task to add realistic textures to the previously extracted buildings. 

Note: 

Textures depict generic usage of buildings and are applied based on footprint size. Using 
high-resolution textures will result in large output, potentially leading to decreased 
visualization performance. 

 

Publish buildings layer 
This task publishes the building layer to your organization. Reprojection to Web Mercator with 

height in meters is only required if you want to use the published layers in a global web scene. 

 

https://www.esri.com/en-us/privacy/overview
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Update buildings (optional) 
Use this task if new lidar is available. It compares an existing 3D multipatch building layer with a 

new lidar dataset to verify whether there are any updates required due to new construction or 

demolition. If changes have been detected, these can then be merged back into the original 3D 

building layer. 

To update your existing buildings, you will need the following data: 

• Multipatch buildings 

• Lidar with ground and buildings classified 

The Update Buildings process accomplishes the following purposes: 

• Detects changes between input 3D multipatch buildings and new lidar. The output is 
building update polygons where changes have been detected depending on the input 
parameters. 

• Creates LOD2 update buildings using the building update polygons and the lidar. 

• Merges the LOD2 update buildings with the existing 3D buildings. 

 

Publish floors 
Building Floors can be created using the Publish floors task. The input is multipatch buildings, 

which can come from the Publish buildings task or from other sources such as CityEngine or 

third-party providers. The output is building floor plates and floor volumes. Floors can be created 

using a Building Space Use table where the building will be split into tiers or groups of floors, 

each with their own number of floors, floor height, space use, and color. Alternatively, building 

attributes such as number of floors, ground floor height, upper floor height, and roof height can 

be used to create the floors. 

Note: 

Splitting buildings into floors can take a long time to run, especially when the initial split 
failed, and a more time-intensive splitting algorithm must be used. Ensure you only split the 
buildings that are required. Also, factors such as building size and complexity will affect the 
processing time. 

In the Task Pane, click the Publish floors task and follow the steps provided. 

 

Create building floors 
This tool splits existing 3D buildings into floors based on building attributes. You can use the 

buildings created in the Publish buildings task or bring in your own buildings. 

One option to create building floors is to use the building space use table to split the building 

into tiers or groups of individual floors with defined space use. The building space use table has 

several attributes that describe the different tiers within the building. Each tier has an attribute 

defining space use, number of floors, floor color, and floor height. The BuildingTypeName 

attribute is the identifier that links the Building Space Use table to the building features. An 

https://www.esri.com/en-us/privacy/overview
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example building space use table can be found in the tables folder of the 3D basemaps ArcGIS 

Pro project. 

 

Create floor volumes 
If you require floor volumes, use the Create floor volumes task to create floor volumes out of the 

3D floor plates. The Extrude By Attribute geoprocessing tool requires a building feature class 

with space usage information that includes floor height. 

 

Publish trees 
Tree location, size, and width can be extracted from ground classified lidar as point features. 

Tree point features are then symbolized using procedural rules and can be schematic or 

realistic. If trees are classified in the lidar, the quality of the tree extraction will improve. 

In the Task pane, expand the Publish trees group task and follow the steps provided. 

 

Classify trees in lidar using deep learning 
Run this tool to optionally classify trees in the lidar using a deep learning model. Classified trees 

will improve the vegetation extraction but keep in mind that deep learning is computationally 

very intensive, and a powerful GPU is needed to process large datasets faster. Depending on 

data size and available hardware, it can take hours to finish. Start with one LAS file to see 

processing time on your system. 

To work with the deep learning tools in ArcGIS Pro, you need to install supported deep learning 

frameworks packages. See deep learning frameworks for ArcGIS. 

A tree classification model trained by Esri can be downloaded from ArcGIS Living Atlas of the 

World or you can create your own model using the Training a Deep Learning model for Point 

Cloud Classification notebook that can be found in the notebooks folder of the 3D basemaps 

ArcGIS Pro project. 

 

Extract tree points using surface analysis 
Use this tool to extract tree points from the lidar using surface analysis. This type of extraction is 

faster for large lidar datasets, but the results are less accurate than using cluster analysis for 

dense lidar (point spacing less than 1.5 feet/0.5 meters). 

 

Extract tree points using cluster analysis 
Use this tool to extract tree points from the lidar using cluster analysis. This type of extraction is 

slower for large lidar datasets, but the results are more accurate than using surface analysis. 

Note: 

https://www.esri.com/en-us/privacy/overview
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When creating the 3D trees, make sure to verify the Vegetation class code. The correct 
class codes for vegetation is typically 5. The tool will verify whether your lidar has this code, 
but trees might be represented by other codes as well. Visually review your lidar and verify 
what class code tree points have by clicking a tree lidar point. If the vegetation has not been 
classified, enter the class code that represents the vegetation, for example, 0 or 1. 

Tip: 

Use the Extract tree points using surface analysis tool to create an initial vegetation layer. 
Run the Extract tree points using cluster analysis tool for lidar files for which you need 
detailed trees and replace the trees from the initial layer with the more detailed trees where 
needed. 

 

Create colorized lidar trees 
Classified lidar can also be used directly to visualize trees. This step extracts just the tree points 

from the input lidar and uses aerial imagery to colorize them. 

 

Publish bridges 
If bridge surfaces are classified in the lidar and the lidar is dense enough, it is possible to extract 

the bridge surfaces as 3D polygons. 3D bridges can then be created by applying procedural 

rules. 

In the Task pane, expand the Publish bridges group task and follow the steps provided. 

 

Create bridges 
In the Extract bridge surfaces from lidar step, enter the following: 

• Class Code—The class code that represents the bridge surfaces. 

• Sampling Value—Experiment with this value to improve processing speed and output 
quality. 

• Bridge Area—This is the minimum area that defines a bridge surface. 

Note: 

The bridge surface should be a separate class code. If bridge surfaces are not classified in 
the lidar, you can interactively classify the bridge surfaces in ArcGIS Pro. 

Note: 

Only rectangular bridge surfaces and models are supported. 
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Publish power lines 
Use your existing GIS data to visualize distribution and transmission lines in 3D. Procedural 

rules are used to create the 3D support structures and conductors. A wide variety of conductor 

and tower configurations are supported. 

In the Task pane, expand the Publish power lines group task and follow the steps provided. 

 

Create transmission lines 
Run the Create transmission lines task to create 3D transmission lines. Enter the following: 

• Voltage—Select the voltage for the transmission line. The values for the voltage list are 
read from the TowerLUTable table located in the project tables directory. Change these 
values to modify conductor and tower features. 

• Tower configuration—Experiment with these parameters to create the desired towers. 

 

Create distribution lines 
Run the Create distribution lines task to create 3D distribution lines. Enter the following: 

• Pole configuration—Experiment with these parameters to create the desired poles. 

Note: 

Both tools support line and point feature input. You can use existing features, features that 
have been extracted from lidar, or manually create features. In the case of line features, the 
vertex locations are used to create towers. In the case of point features, a line and tower 
attribute must be present. The line attribute should describe which line the points belong to 
and the tower attribute should describe the tower order per line. Connected lines are not 
supported. 

Note: 

This tool requires that the Microsoft Access Database Engine driver is installed. 

 

Publish underground pipes 
You can turn your existing 2D underground utility features into 3D features using elevation 

attributes. 

In the Task pane, expand the Publish underground pipes group task and follow the steps 

provided. 
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Create gravity mains 
Run the Create gravity mains task to create 3D gravity-driven mains. The first time you run this 

step, you evaluate the current state of the gravity mains and highlight errors. After reviewing the 

errors and updating fields that are incorrect, run Interpolate gravity mains to calculate any 

remaining missing values. 

 

Create manholes 
Run the Create manholes task to create 3D manhole features. 

 

Create laterals 
Run the Create laterals task to create 3D lateral features. 

 

Create a surface trench 
Run the Create a surface trench task to better visualize underground pipe features. 

 

Publish integrated mesh 
An integrated mesh is a textured continuous meshed surface capturing a current state of an 

area or city. They are often derived from drone, aerial, or satellite imagery via photogrammetric 

processing. 

In the Tasks pane, expand the Publish integrated mesh group task and follow the steps 

provided. 

 

Add integrated mesh 
This step adds an integrated mesh to your scene. A mesh (.slpk) is typically created from 

photogrammetric sources, like imagery captured by drones and processed with Drone2Map or 

SiteScan. There are also several Esri partners that specialize in producing city-scale integrated 

mesh for purchase. 

 

Modify integrated mesh 
Use this step to make a modification to an integrated mesh layer. You can create a new 

modification or import from an existing polygon feature layer. Mesh modifications are useful to 

be able to show other 3D layers such as buildings, trees or bridges together with the integrated 

mesh. 
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Publish integrated mesh layer 
This step publishes the integrated mesh layer to your organization. Reprojection to Web 

Mercator with height in meters is only required if you wish to use the published layer in a global 

web scene. 

Run Share as new web scene to publish the entire scene as web scene to your organization. 

Remove all the layers that you don't want to publish from the scene before publishing. 

Run Share as scene layer if you need to add an integrated mesh to an existing web scene. 

 

Modify integrated mesh in web scene 
This tool modifies an integrated mesh in a published web scene without having to republish the 

entire mesh as a new web scene. 

 

Publish 3D Basemaps 
The 3D basemap is a web scene that can be used across the ArcGIS platform. 

In the Task pane, expand the Publish 3D basemap web scene group task and follow the 

steps provided. 

Tip: 

For more information on creating a web scene, see Get started with scenes. 
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Address Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Address Data Management 
Address Data Management can be used to maintain an authoritative inventory of road 

centerlines with address ranges, valid road names, site addresses, and related mailing 

addresses. 

It provides a series of workflows and standard address layers that streamline the maintenance 

of a central address repository that supports diverse information needs (for example, public 

safety, permitting, utility billing, assessment and taxation, and so on). This optimized approach 

allows organizations to capture the physical location of an address early in the development 

process and continuously improve the accuracy of address information over time. Address Data 

Management is typically implemented by planning departments, public safety agencies, GIS 

departments, and other local government organizations that want to develop and maintain an 

address repository that supports a variety of government functions. 

The Address Data Management solution delivers a set of capabilities that help you maintain a 

standard set of address layers that incorporate national guidelines, streamline address data 

management workflows, and continuously improve the quality of address information. 

 

Requirements 
Address Data Management requires the following: 

• ArcGIS Enterprise or 10.7.1 - 10.8.1 

• ArcGIS Pro 2.5 or later (Standard or Advanced) 

– ArcGIS Data Reviewer (optional) 
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Information products 
Address Data Management includes the following information products: 

Item Description 

Minimum user 

type 

Address Data 

Management 

An ArcGIS Pro project used to maintain an inventory 

of road centerlines, valid road names, site addresses, 

and related mailing addresses 

GIS Professional 

Standard 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Address Data Management 
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Configure Address Data Management 
Learn how to configure the Address Data Management solution to meet specific needs in your 

organization. 

 

Configure address data management project 
The Address Data Management solution includes an ArcGIS Pro project and sample data you 

can use to explore data management workflows. When you are ready to configure the project, a 

series of tasks are included to help you review the schema, make modifications to the maps and 

layers, load your data, and optionally migrate into ArcGIS Enterprise. 

1. Sign in to your ArcGIS organization and browse to the Address Data Management Desktop 
Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Address Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Address Data 
Management task. 

6. In the Tasks pane, expand the Configure Address Data Management task group. 

 

Review schema 
Included in the solution is a data dictionary that describes the feature classes, relationship 

classes, and domains included in the Address Data Management geodatabase. 

To review the data dictionary, browse to the Data Dictionary.htm file included with the 

Address Data Management project and open in your default web browser. 

 

Define spatial reference 
The Address Data Management project comes with two file geodatabases. Address Data 

Management Sample.gdb contains data designed to help test workflows supported in the 

solution. 

Address Data Management.gdb is an empty geodatabase with the same schema and a spatial 

reference set to Web Mercator. You can use this geodatabase to define your spatial reference 

and load your data. 

To define the spatial reference, follow the steps in the Define spatial reference task. 
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Configure maps, layers, and rules 
The Address Data Management solution leverages preconfigured attribute rules to automate 

many of the editing workflows. For example, when you create an address point, a unique ID is 

automatically generated for the point. 

In some cases, you may need to modify the default schema included with the solution to meet 

your organization’s needs. If you need to remove or rename fields that are used in any of the 

attribute rules, you must first update the rule to remove the reference to the field. Adding new 

fields does not impact the rules. You may also want to add additional rules or configure the 

feature templates to set the default attributes applied when a feature is created. 

To modify the schema, attribute rules, and feature templates of the layers, follow the steps in 

the Configure maps, layers, and rules task. 

 

Load your data 
When you have completed any schema modifications, you can load your existing data into the 

Address Data Management layers by following the steps in the Load your data task. 

 

Load into ArcGIS Enterprise 
While everything included with the Address Data Management solution is supported in a file 

geodatabase, some organizations may choose to manage this data in ArcGIS Enterprise. 

To copy the Address Data Management schema into ArcGIS Enterprise, follow the steps in the 

Load into ArcGIS Enterprise task. 

 

Configure data validation 
You can use Data Reviewer to validate, maintain, and improve the integrity of your address 

data. The Address Data Management map includes a collection of preconfigured checks that 

help you identify and resolve common errors in your address data. You can add, remove, or 

modify these checks to meet your organization’s needs. 

To modify the Data Reviewer checks, follow the steps in the Configure data validation task. 

 

Use logical block addressing 
Logical block addressing uses the starting address, an interval or distance between unique 

addresses, and the length of the road segment to calculate the address range for the block. If 

your organization uses logical block addressing, you can configure attribute rules to 

automatically calculate the left and right to address from the left and right from address. 

To enable the logical block addressing attribute rules, complete the following steps: 

1. Start the ArcGIS Pro application and open the Address Data Management project. 

2. In the Contents pane, right-click the Local Streets layer. 
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3. From the Design menu, choose Attribute Rules. 

4. In the Attribute Rules table, click the Logical Block Addressing (Left) rule. 

5. In the Expression Builder update the value for the addressIntervalDistance and unit to the 
distance your community uses between unique addresses along a road. 

  // Specify the interval or distance between unique addresses 
var addressIntervalDistance = 10; 
 
// Specify the unity of measure. Valid options are feet, meters, yards, 
miles, kilometers 
var unit = "feet"; 

6. Click the Save button  on the Attribute Rules tab. 

7. Click Enable Rule in the Attribute Rules group on the ribbon. 

8. Repeat steps 5 through 7 for the Logical Block Addressing (Right) rule. 

9. Click Save button on the Attribute Rules tab. 

 

Pull information from an intersecting feature 
You can configure additional attribute rules for the site address layer to automatically pull 

information from an intersecting feature when the address point is created or updated. For 

example, you can write the name of the municipality, ZIP Code, or the property identification 

number (PIN) the address falls within and write it to a field within the site address point. 

To add an intersecting feature attribute rule to your site addresses layer, complete the following 

steps: 

Note: 

This rule requires both the site addresses feature class and the intersecting feature class 
be in the same database. 

1. In ArcGIS Pro, from the Contents pane, right-click the Site Addresses layer. 

2. From the Design menu, choose Attribute Rules. 

3. From the Attribute Rules table, click the Add Rule drop-down arrow and choose Add 
Immediate Calculation Rule. 

4. Provide a Rule Name and Description for your rule. 

5. Click the Field drop-down arrow and choose a field in your Site Addresses layer where you 
want to write the attribute from the intersecting feature. 

6. Click Expression Builder  to open the Expression Builder dialog box. 

7. Copy the code below and paste it into the Expression Builder. 

  // replace 'FeatureClassName' with the name of the feature class to pull 
intersecting features from (ex. Cities, ZipCodes, Parcels) 
var intersectingFeatures = Intersects(FeatureSetByName($datastore, 
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"FeatureClassName"), $feature); 
for (var feature in intersectingFeatures) { 
     // replace 'fieldname' with the name of the field from the 
intersecting feature to pull the value from 
     var value = feature.fieldname; 
      if (IsEmpty(value)) continue; 
     return value; 
} 
return null; 

8. In the code, find and replace the text FeatureClassName with the name of the feature 

class to pull intersecting features from (for example, Cities, ZipCodes, or Parcels). 

9. In the code, find and replace the text fieldname with the name of the field from the 

intersecting feature to pull the value from. 

10. Click the Verify button and click OK to close the Expression Builder dialog box. 

11. In the details pane, under Triggers, check Insert. If you want the rule to run when the 
address is moved as well, check Update. 

12. Click the Save button  on the Attribute Rules tab. 

  This button is unavailable if you have any pending feature edits. Save or discard your edits 
to enable the Save button. 

  Note: 

  The rule is now active. When you create a site address point, the rule runs and pulls the 
attribute of the intersecting feature into the field specified by the rule. Repeat the steps 
above to add additional rules for different feature classes and field values. 

  Tip: 

  The code above is configured to return null if no intersecting features are found, and if 
multiple intersecting features are found (overlapping polygons), it returns the first nonnull 
feature attribute found. Below are some additional code samples for other common 
scenarios. 

 

Return multiple intersecting feature values as a comma-delimited list 
Copy this code and paste it into the Expression Builder dialog box to return a list. 

// replace 'FeatureClassName' with the name of the feature class to pull 
intersecting features from (ex. Cities, ZipCodes, Parcels) 
var intersectingFeatures = Intersects(FeatureSetByName($datastore, 
"FeatureClassName"), $feature); 
var values = []; 
for (var feature in intersectingFeatures) { 
     // replace 'fieldname' with the name of the field from the intersecting 
feature to pull the value from 
     var value = feature.fieldname; 
     if (IsEmpty(value)) continue; 
     values [Count(values )] = value; 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 25 

} 
return Concatenate(values, ", "); 

 

Return multiple intersecting feature values as a statistic (Mean, Min, 

Max, Sum) 
Copy this code and paste it into the Expression Builder dialog box to return statistic values. 

// replace 'FeatureClassName' with the name of the feature class to pull 
intersecting features from (ex. Cities, ZipCodes, Parcels) 
var intersectingFeatures = Intersects(FeatureSetByName($datastore, 
"FeatureClassName"), $feature); 
var values = []; 
for (var feature in intersectingFeatures) { 
     // replace 'fieldname' with the name of the field from the intersecting 
feature to pull the value from 
     var value = feature.fieldname; 
     if (IsEmpty(value)) continue; 
     values[Count(values)] = value; 
} 
return Mean(values); 

 

Publish address locators 
You can author the address locators described below in ArcGIS Pro from the layers managed in 

the Address Data Management solution: 

• Composite 

• Dual Range 

• Site address 

• Road name 

Once you have authored the locators, you can use them in ArcGIS Pro to locate places using 

addresses along the left or right side of a road, rooftop address locations, and road names. You 

can also share the locators with your organization and use them in many ArcGIS Solutions. 

Learn how to create an address locator and more about the components of an address locator 

in the ArcGIS Pro help. 
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Use Address Data Management 
The Address Data Management solution delivers a set of capabilities that help you maintain a 

standard set of address layers that incorporate national guidelines, streamline address data 

management workflows, and continuously improve the quality of address information. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Manage address data 
You will assume the role of a mapping technician responsible for maintaining an inventory of 

road centerlines, valid road names, site addresses, and related mailing addresses. The Address 

Data Management ArcGIS Pro project includes a series of tasks to help guide you through 

these workflows. 

1. Sign in to your ArcGIS organization and browse to the Address Data Management Desktop 
Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Address Data Management ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Address Data 
Management task. 

6. In the Tasks pane, click the How to Use Address Data Management task group to 
expand the collection of tasks. 

 

Add new roads 
Roads are line segments representing centerlines of all roadways or carriageways that support 

address geocoding and mapping. They are also a resource for the agencies responsible for the 

active management of the road network. Typically, this information is compiled from 

orthorectified aerial imagery and record drawings. 

The road features leverage a valid list of road names that can be assigned to a road and 

subsequent site address. The Master Road Names table includes the unique elements of a road 

name (for example, direction, name, and type) and uses an attribute rule to create a full road 

name. To ensure data integrity, a road name index is derived from the Master Road Names 

table and used to populate official road names when creating new road centerlines and site 

addresses. 

The feature classification and type schema for the roads is based on a functional classification 

of roads provided by the Federal Highway Administration (FHWA). Specific attributes and 

default values vary for each feature type. 

To update the road name index and add new roads, follow the steps in the Add new roads 

task. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 27 

Add site addresses 
Site addresses represent the location of a site or service delivery address assigned by a local 

government. Typically, site addresses are placed on top of the associated structure. 

Alternatively, they may be placed at the center of a parcel or in close proximity to the curb cut. 

Site addresses are related to two other address layers: 

• Address points that represent the location along the road network where the specific site or 
service delivery address has been assigned. 

• Entrance points that represent the location where the public, or a service provider, gains 
access to the specific site address. In urban settings, an entrance point can represent a 
driveway for a home that is on a corner lot and the address is assigned off an adjacent 
road. In rural areas, an entrance point can represent a shared driveway that provides 
access to many homes. Entrance points are optional and can be added on a case-by-case 
basis. 

Each site address may have one or more postal addresses associated with it. Postal addresses 

provide contact information for the owner or occupant of the building or buildings associated 

with a site address. The Owner / Occupant field indicates whether the postal address is for the 

owner, occupant, or both. 

The feature classification and type schema for the site addresses is based on a status field. This 

status field allows local governments to identify pending, temporary, and current addresses. 

To add a new site address and one, or more, related postal addresses and building entrances, 

follow the steps in the Add site addresses task. 

 

Update road names 
Road names may change during the plan review process and as a result, pending road names 

must be updated. When updates are made to the Master Road Names table and road name 

index, the changes are pushed to the road and site address features to ensure data integrity is 

maintained. 

To modify a pending road name and update related features, follow the steps in the Update 

road names task. 

 

Modify road and address parity 
In some cases, roads were not drawn in the direction of ascending address ranges and the 

direction of the line must be flipped to improve address geocoding. This may also mean the 

address range parity is incorrect and must be flipped as well. 

To modify the road direction or address parity, follow the steps in the Flip roads and swap 

parity task. 
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Create road intersections 
When creating new roads, existing roads are split at intersections along the new road. An 

inventory of road intersections with the names of relevant crossroads is often required by 911 

systems and to manage right-of-way assets. 

To create road intersections, follow the steps in the Create road intersections task. 

 

Validate address integrity 
You can use ArcGIS Data Reviewer to validate, maintain, and improve the integrity of your 

address data. The Address Data Management map includes a collection of preconfigured 

checks that help you identify and resolve common errors in your address data. 

To validate address integrity, follow the steps in the Validate address data task. 
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Address Field Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Address Field Operations 
Address Field Operations can be used to crowdsource missing address information from 

stakeholders, manage address fieldwork, and collect and verify address information while in the 

field. 

Current and accurate address data is an essential requirement for a variety of functions, 

including emergency management, as well as administration, research, publications, mapping, 

routing, navigation, and many other purposes. Successful address authorities assign addresses 

early in the development life cycle and improve the integrity of their address repository with 

quality control procedures that incorporate feedback from stakeholders. Address Field 

Operations is typically implemented by planning departments, public safety agencies, GIS 

departments, and other local government organizations that want to continuously improve an 

address repository that supports a variety of government functions. 

The Address Field Operations solution delivers a set of capabilities that help you solicit missing 

or inaccurate address information from internal and external stakeholders, verify these 

submissions in the office, or create work assignments and dispatch staff to verify and collect 

new address information from a mobile device in the field. 

 

Requirements 
Address Field Operations requires the following: 

• ArcGIS Enterprise 10.8 - 10.8.1 

• ArcGIS Workforce 

• ArcGIS Collector 

 

Information products 
Address Field Operations includes the following information products: 
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Item Description 

Minimum 

user type 

Address 

Crowdsourcing 

An ArcGIS Survey123 form used by addressing staff to 

crowdsource missing address information from 

stakeholders. 

Editor 

Address 

Assignments 

An ArcGIS Workforce Classic project used by addressing 

staff to manage address field operations. Field users access 

the Address Assignments project using the Workforce for 

ArcGIS mobile app. 

Field 

Worker 

Address Field 

Inventory 

An ArcGIS Collector map used by addressing staff to collect 

address information while in the field. 

Field 

Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Address Field Operations 
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Use Address Field Operations 
The Address Field Operations solution delivers a set of capabilities that help you solicit missing 

or inaccurate address information from internal and external stakeholders, verify these 

submissions in the office, or create work assignments and dispatch staff to verify and collect 

new address information from a mobile device in the field. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Submit a missing address 
You will first assume the role of an employee in the public works department. When attempting 

to issue a permit, you search for an address, but no result is returned. You will use the Address 

Crowdsourcing form to report the missing address. 

1.  Sign in to your ArcGIS organization and browse to the Address Crowdsourcing form. 

2. Open the item page and click Open in Survey123 > Open in browser. 

3. In the Address Crowdsourcing form, fill in the following details: 

  Questions   Answers 

  Address 
Number 

  Type an address number. 

  Full Road Name   Type the name of a road. 

  Municipality   Type the name of your municipality. 

  Select Location   Zoom and pan in the map to the approximate location of the 
missing address. 

  Full Name   Type your name. 

  Email   Type your email address. 

  Phone   Type your phone number. 

4. Click Submit. 

 

Assign a missing address for verification 
You will now assume the role of a supervisor at an addressing authority. As a supervisor, you 

are responsible for assigning field crews to verify missing or incorrect address reports from 

stakeholders. Using the Address Assignments ArcGIS Workforce Classic project, you will create 

a new assignment using the missing address report and assign it to one of your mobile workers. 

1. Verify that you are signed in to your ArcGIS organization and click the Apps button  in 
the header of the site. 

2. From the app launcher, click Workforce to open the app. 

3.  Under Classic projects, click Address Assignments to open the project. 
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  Tip: 

  When implementing the Address Field Operations solution in your organization, you must 
add anyone responsible for verifying addresses in the field to the Address Assignments 
ArcGIS Workforce Classic project with a Mobile Worker role. You can add users and 
assign roles in the configuration settings of the project. To access configuration settings, 
hover over Address Assignments project and click Configure. Click the Users tab. For 
the purposes of this exercise, ensure your named user account is assigned as a dispatcher 
and as a mobile worker. Click My Projects tab to return to your projects. 

4. On the map, select the address you created in the previous section and click the + Create 
Assignment at the bottom of the pop-up window. 

5. From the Create Assignment panel, fill in the following details: 

– For Assignment Type, choose Verify Address. 

– For Assigned to, choose a worker. 

– For Priority, choose Medium. 

– For Due Date, choose tomorrow. 

6. Click Create Assignment. 

 

Verify missing addresses 
You will now assume the role of a mobile worker at an addressing authority. As a mobile worker, 

you are responsible for verifying missing or incorrect address reports. Using the Address 

Assignments ArcGIS Workforce Classic project, you will review and update the status of your 

assignments and open the Address Field Inventory map in ArcGIS Collector to verify missing 

addresses. 

1. Download Workforce for ArcGIS and ArcGIS Collector apps onto your mobile device. 

2. Open the Workforce for ArcGIS app and sign in to your ArcGIS organization. 

3. Tap the Address Assignments project. 

4. Tap Verify Address from the To Do list. 

5. Tap Start. 

6. From the overflow menu, tap Collect at Assignment. 

  This opens the Address Field Inventory map in ArcGIS Collector and defaults to the 
location of the assignment and drops a pin. 

7. Tap Close to cancel the dropped pin. 

8. Tap the missing address point at the same location. 

9. Tap Edit to modify the details of the address. 

  At this point, verify the details of the address and make any necessary changes to the 
attributes and location of the address. 

10. Tap Verified and tap Yes. 

11. Tap Submit. 
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  The address point changes from red to green and now reflects any edits you made during 
verification. 

12. Return to the Workforce for ArcGIS app and tap Finish to complete the assignment. 

 

Collect new addresses 
You will continue your role as a mobile worker at an addressing authority. You are responsible 

for collecting addresses for a new subdivision in the community. You will use the Address Field 

Inventory map in ArcGIS Collector to collect new addresses in the field. 

1. From your mobile device, open the ArcGIS Collector app. 

  Tap the back arrow, if necessary, to go back to the Maps list. 

2. Tap the Address Field Inventory map. 

3. Tap Add. 

4. By default, the point is set at your current location. Adjust the location on the map as 
necessary and tap Add Point. 

5. Swipe up and enter the details of the address. 

  When adding multiple addresses, they may have common attributes such as the road 
name and municipality. You can create a copy of an existing address point by selecting it 
and tapping Copy. 

6. Tap Submit. 
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Adopt-A-Catch Basin 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Adopt-A-Catch Basin 
Adopt-A-Catch Basin can be used to operate catch basin adoption programs that allow 

volunteers to adopt storm drains and clean them for the community. 

Adopt-A-Catch Basin programs seek to improve water quality, decrease localized flooding, and 

reduce maintenance costs by leveraging individual volunteers and organizations to clean drains 

and keep water flowing. Program volunteers are typically asked to inspect their drains; remove 

leaves, trash, and other debris; and report damage or clogs at regular intervals. In some cases, 

they may even be asked to check on an adopted drain before a forecasted storm. This simple 

action has a big impact on the cleanliness of local waterways and reduces the chance of 

localized flooding during a storm. Adopt-A-Catch Basin is typically implemented by public works 

agencies or utilities that want to engage the community and maximize the capacity of operations 

staff. 

The Adopt-A-Catch Basin solution delivers a set of capabilities that help you engage volunteers 

to keep catch basins clear of debris and functioning properly, manage participants, and monitor 

the adoption program. 

 

Requirements 
Adopt-A-Catch Basin requires the following: 

• ArcGIS Enterprise 10.7 - 10.8.1 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

• ArcGIS Web AppBuilder (Developer Edition) 2.11 or later 

• SMTP Server 
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Information products 
Adopt-A-Catch Basin includes the following information products: 

Item Description Minimum user type 

Adopt-A-Catch 

Basin 

An ArcGIS Hub site used by the general public 

to learn how they get involved in the Adopt-A-

Catch Basin program 

Not required 

Adopt-A-Catch 

Basin 

An ArcGIS Pro project package used by 

stormwater personnel to configure the Adopt-A-

Catch Basin app and publish supporting web 

tools to ArcGIS Enterprise 

GIS Professional 

Standard with Web tool 

publisher permission 

Adopt-A-Catch 

Basin Manager 

A Crowdsource Manager app used by 

stormwater personnel to manage Adopt-A-Catch 

Basin participants 

Editor 

Adopt-A-Catch 

Basin 

Dashboard 

An ArcGIS Dashboards app used by stormwater 

personnel to monitor the Adopt-A-Catch Basin 

program 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Adopt-A-Catch Basin 
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Configure Adopt-A-Catch Basin 
Learn how to configure the Adopt-A-Catch Basin solution to meet specific needs in your 

organization. 

 

Publish the Adopt-A-Catch Basin app 
The Adopt-A-Catch Basin solution includes an ArcGIS Pro project used to publish the Adopt-A-

Catch Basin app. When you are ready to publish the app, a series of tasks is included to help 

you get started. 

 

Get started 
Use the ArcGIS Pro project to familiarize yourself with Adopt-A-Catch Basin. 

1. Sign in to your ArcGIS organization and browse to the Adopt-A-Catch Basin Project 
Package. 

2. Open the item page and click Download. 

3. Browse to and open the Adopt-A-Catch Basin project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Adopt-A-Catch Basin 
task. 

6. In the Tasks pane, expand the Getting to Know Adopt-A-Catch Basin task group. 

7. Double-click Understanding Adopt-A-Catch Basin task to review it. 

 

Configure Adopt-A-Catch Basin 
Use the ArcGIS Pro project to set up Adopt-A-Catch Basin. 

1. In the Tasks pane, expand the Configure Adopt-A-Catch Basin task group. 

2. Use the Configure Adopt-A-Catch Basin task group to access several tasks that guide 
you through: 

– Load your catch basins into the CatchBasin feature layer deployed with the 
solution. 

– Set up a user table in ArcGIS Enterprise to store program participants. 

– Publish the authentication geoprocessing webtool. 

– Configure the Adopt-A-Catch Basin app. 

 

Contact participants 
Use the ArcGIS Pro project to configure tools necessary for contacting participants in the Adopt-

A-Catch Basin program. 
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1. In the Tasks pane, expand the Contact participants task group. 

  The Contact participants task group contains tasks help you contact program participants 
by sending bulk emails or contacting a selection of participants by local or attribute. 

2.  Follow the task instructions to configure the bulk email model with your SMTP server and 
contact participants. 

 

Configure the Adopt-A-Catch Basin site 
The Adopt-A-Catch Basin solution includes the Adopt-A-Catch Basin ArcGIS Hub site that your 

organization can configure with your branding and can use to share information about 

participating in the Adopt-A-Catch Basin program with the public. 

 

Update with organizational information 
After deploying the Adopt-A-Catch Basin solution, the Adopt-A-Catch Basin site layout only 

requires a few updates to fit your local context. Consider what information you already have and 

what you can most easily find. This information can include the following: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-Catch 
Basin site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Statistics section listed under the title of the website.  

  The Catch Basins Adopted, Cleaned This Month, and Clogged Catch Basins statistics 
cards are already linked to the Adopt-A-Catch Basin solution’s CatchBasins_public feature 
layer. These stats automatically update as participants adopt catch basins and report 
cleanings and issues using the Adopt-A-Catch Basin app. 

5. Scroll to the Adopt a Catch Basin section, hover over the card and click settings button 

.  

6. Click the Adopt Catch Basin button and click Edit.  

7. Enter the Adopt-A-Catch Basin app published using the Adopt-A-Basin ArcGIS Pro project 
URL into the Link Destination text box and click Add Link button. 

  Tip: 

  Browse to the Adopt-A-Catch Basin app. Open the item page, click View Application, and 
copy the app URL. 

8. Scroll to the Frequently Asked Questions section, hover over the card and click the 
settings button, and update the questions and answers. 

9. Scroll to the Stormwater Data section, hover over the card and click the settings button, 
and in the site editor under Data update the category links using tags, categories, or 
groups that reference your open data. 
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10. To modify your site’s footer, click Customize Toggle  on the side panel. 

11. Click Footer.  

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

12. Click the HTML text box. 

  The HTML window appears. 

13. Make the necessary changes and click Apply. 

14. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Adopt-A-Catch Basin solution must be 

shared with everyone so they can be accessed by the public on the Adopt-A-Catch Basin site. 

To share your adopt-a-catch basin items with everyone, use the guide below and complete the 

following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-Catch 
Basin folder. 

2. Check the check box next to each of the items below: 

  Item   Name 

  Feature Layer (hosted, view)   CatchBasins_public 

  Web Map   Adopt-A-Catch Basin 

  Web Mapping Application   Adopt-A-Catch Basin 

  Site Application   Adopt-A-Catch Basin 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

 

Deploy related solutions 
This site references content from the Citizen Problem Reporter solution. To deploy the Citizen 

Problem Reporter solution, follow the steps in the Deploy an ArcGIS Solutions section. 

 

Update solution references 
This site references a solution deployed in the previous section. To update your site, complete 

the following steps: 
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1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-Catch 
Basin site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Report a Problem section. 

5. Hover over the Submit Report card and click settings button . 

6. Click on the Submit Report button and click Edit. 

7. Enter the Citizen Problem Reporter app URL in the Link Destination text box and click 
Add Link button. 

  Tip: 

  Browse to the Citizen Problem Reporter app. Open the item page, click View Application, 
and copy the app URL. 

8. Hover over the Contact Call Center card, click the settings button and edit the phone 
numbers in the card or remove if not applicable. 

9. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Citizen Problem Reporter solution must be 

shared with everyone so they can be accessed by the public on the Adopt-A-Catch Basin site. 

To share your citizen problem reporter items with everyone, use the guide below and complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Citizen 
Problem Reporter folder. 

2. Check the check box next to each of the items below: 

  Item   Name 

  Feature Layer (hosted, view)   CitizenProblems_health 

  Feature Layer (hosted, view)   CitizenProblems_utility 

  Feature Layer (hosted, view)   CitizenProblems_blight 

  Feature Layer (hosted, view)   CitizenProblems_road 

  Feature Layer (hosted, view)   CitizenProblems_animal 

  Feature Layer (hosted, view)   CitizenProblems_parktree 

  Feature Layer (hosted, view)   CitizenProblems_trash 

  Feature Layer (hosted, view)   CitizenProblems_landuse 

  Feature Layer (hosted, view)   CitizenProblems_snowice 

  Web Map   Health Problems 
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  Web Map   Water / Sewer Problems 

  Web Map   Blight Problems 

  Web Map   Road Problems 

  Web Map   Animal Problems 

  Web Map   Park / Tree Problems 

  Web Map   Trash Problems 

  Web Map   Land Use Problems 

  Web Map   Snow / Ice Problems 

  Web Mapping Application   Citizen Problem Reporter 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

 

Adopta widget settings 
The Adopt-A-Catch Basin app uses the Adopta widget with preconfigured settings and actions. 

Optionally, you can modify and expand the Adopta widget’s settings to meet your organization's 

needs. Use the tables below to understand the Adopta widget's configuration settings and 

capabilities. 

 

Layer and Authentication settings 
The Layer and Authentication settings allow you to configure behaviors as well as the look and 

feel of the user interface. 

Setting Description 

Asset nickname 

field 

Field that stores the catch basin's nickname. 

Login screen 

message 

Message that appears when signing into the application. 

Additional 

signup field 

Fields in the UserTable to be displayed in the sign up form in addition to 

email—for example, add first and last name, address, and phone number. 

Show asset 

address 

Display the reverse geocoded address of a catch basin in the details view. 

Asset highlight 

color 

Color of selection symbol displayed around the catch basin symbol when it 

is selected on the map. 
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Tolerance 

setting 

New catch basins are created if no asset is found within the tolerance. 

My asset 

symbol 

Choose a symbol and set the size of user-adopted catch basins. 

 

Actions 
The primary actions used for the Adopt-A-Catch Basin app are assign (Adopt) and unassign 

(Opt out). You can configure additional actions as needed. 

Setting Description 

Assign status 

settings 

Allows you to label the button (Adopt) in the asset detail view and specify 

additional actions that occur after clicking the assign status button. 

Unassigned 

status settings 

Allows you to configure the unassigned label (Abandoned) in the asset 

detail view and specify additional actions that occur after clicking the 

unassigned label. 

Additional status 

settings 

Allows you add additional actions you want adopters to report on—for 

example, a damaged catch basins. 

Primary Status Displays text and status buttons in the Adopta application—for example, 

Is the catch basin cleaned? 

Before action 

image 

Image that is displayed before performing an action. 

After action image Image that is displayed after performing an action. 

 

Messages 
The Adopt-A-Catch Basin app displays messages based on user interaction—for example, 

Thank you for adopting catch basin name. You can modify messages or create additional 

messages according to your organization’s needs. 

Setting Description 

Assign Message displayed when an asset is successfully assigned. Use 

'${assetTitle}', for example, to display the title of asset in message. 

Unassign Message displayed when an asset is successfully unassigned. 

Action Message displayed when action is successfully completed. Use 

'${actionName}', for example, to display the name of action in 

message. 

Asset not found Message displayed when asset is not found. 
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Asset already 

assigned 

Message displayed when asset is already assigned. Use 

'${assetTitle}', for example, to display the title of asset in message. 

Unable to perform 

action 

Message displayed when action is not successful. Use 

${actionName}, for example, to display the name of the action 

message. 

Asset creation Message displayed when creating a new asset. Use ${layerName}, for 

example, to display the name of the layer in message. 

Create asset failed Message displayed when asset creating fails. 

User token expired Message displayed when user token is expired and generated. 

Signup/Login 

success 

Message displayed after successful sign up or log in. 

Home screen (when 

logged in) 

Message displayed in widgets home screen after user logs in to the 

application. 

Cursor tooltip before 

login 

Message displayed when the user hovers over the map with their 

pointer before signing in to the application. 

Cursor tooltip after 

login 

Message displayed when the user hovers over the map with their 

pointer after signing in to the application. 

Nickname hint The text displayed in the nickname hint text box. 
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Use Adopt-A-Catch Basin 
The Adopt-A-Catch Basin solution delivers a set of capabilities that help you engage volunteers 

to keep catch basins clear of debris and functioning properly, manage participants, and monitor 

the adoption program. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note:  

Use your organization’s data or configured apps to follow these workflows. 

 

Adopt a catch basin 
You’ll assume the role of a resident in the community who wants to participate in your city’s 

adopt-a-catch basin program. You’ll use the Adopt-A-Catch Basin app to adopt a catch basin 

near your home and report its condition. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-Catch 
Basin solution. 

2. View the Adopt-A-Catch Basin site. 

3. Scroll to the Adopt a Catch Basin section, and click the Adopt Catch Basin button to 
open the Adopt-A-Catch Basin app. 

4. Enter your email in the Enter email address text box and click Login/Sign Up to sign up 
and begin the adoption process. Enter your contact details in the subsequent form and 
click Sign Up. 

  The Adopt-A-Catch Basin app sends an email with program details and a link you will use 
to log in to the app. 

5. In the email, click Login. 

  Returning users also receive an email with a link used to sign in to the app. 

  The Adopt-A-Catch Basin app opens in a browser with your newly created user 
authenticated. Notice the instructions to select a catch basin on map to adopt. 

6. Select an available catch basin to adopt (the green symbols on the map). Optionally, add a 
nickname to your catch basin in the text box. Click Adopt Catch Basin. 

  Adopt-A-Catch Basin displays a thank you message. The Adopt-A-Catch Basin pane 
displays your adopted catch basin and allows you to report the condition of the catch basin 
(for example, cleaned, clogged, or damaged), or abandon the catch basin. You can use the 
Adopt-A-Catch Basin app to regularly report cleanings and condition. 
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Manage adoptions and participants 
You are now a public works agency employee managing the catch basing adoption program. 

You will use Adopt-A-Catch Basin Manager to resolve reported issues and contact program 

participants. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-Catch 
Basin solution. 

2. View the Adopt-A-Catch Basin Manager app. 

3. In the app, click the Last Known Condition column filter.  

4. Click Last Known Condition drop-down arrow and choose Damaged to view all reported 
damaged catch basins. 

5. Click one of the catch basins to view its details. 

  Public Works has repaired the catch basin. You'll use the Adopt-A-Catch Basin Manager 
app to contact the adopter to let them know the catch basin has been repaired. 

6. Click the Email Adopter button in the lower left corner of the app. 

  Adopt-A-Catch Basin Manager opens your email client and presents a preformatted 
subject. 

7. In the app, click the Edit button . 

8.  Click the Last Known Condition drop-down arrow to No Issues. 

9. Click Save. 

10. Optionally, click the Manage User’s Catch Basin button to open the Adopt-A-Catch Basin 
app and manage the catch basins adopted by the selected user. 

  You can use this workflow to remove an adopter from a catch basin, making it available for 
adoption. 

 

Monitor the program 
You will continue your role as a public works employee, this time looking to monitor the Adopt-

A-Catch Basin program. You will use the Adopt-A-Catch Basin Dashboard to review key metrics 

and trends. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-Catch 
Basin solution. 

2. View the Adopt-A-Catch Basin Dashboard app. 

  The Adopt-A-Catch Basin Dashboard displays new adoptions and cleaning charts by 
month and provides management a quick view of program activity over time. 

3. On the Overview tab, review the high-level metrics. 

4. Click the Catch Basin tab at the bottom of the dashboard. 

5. Click the arrow on the left of the app to display additional filters. 
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6. Use the filters in the left panel to explore catch basin status, condition, visibility and last 
cleaned.  

  Tip: 

  Dashboard charts are linked. If you click on a month in either New Adoptions by Month or 
Cleanings by Month charts, related details are filtered and updated in other elements in 
the dashboard. 

7. Select a catch basin from the Catch Basins list or the map to view key details. Optionally, 
click the Manage Asset button in the pop-up to launch the Adopt-A-Catch Basin Manager 
app. 
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Adopt-A-Stop 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Adopt-A-Stop 
Adopt-A-Stop can be used to operate stop adoption programs that allow volunteers to adopt 

transit stops and clean them for the community. 

A transit ride begins and ends at a stop, and a rider’s overall experience includes not only the 

ride, but their time spent at transit stops. Adopt-A-Stop programs seek to improve this 

experience and reduce maintenance costs by leveraging individual volunteers and organizations 

to clean transit stops. Program volunteers are typically asked to inspect their stops, remove 

trash, and report graffiti or serious damage at regular intervals. This simple action has a big 

impact on rider satisfaction, safety around the stop and the quality of life in a neighborhood. 

Adopt-A-Stop is typically implemented by transit agencies that want to engage the community 

and maximize the capacity of operations staff. 

The Adopt-A-Stop solution delivers a set of capabilities that help you engage volunteers to keep 

transit stops clean, manage participants, and monitor the performance of the adoption program. 

 

Requirements 
Adopt-A-Stop requires the following: 

• ArcGIS Enterprise 10.7 - 10.8.1 

• ArcGIS Web AppBuilder (Developer Edition) 2.11 or later 

• ArcGIS Pro 2.5 or later (Basic, Standard, or Advanced) 

• SMTP Server 

 

Information products 

Adopt-A-Stop includes the following information products: 

Item Description Minimum user type 

Adopt-A-Stop An ArcGIS Hub site used by the general public 

to learn how to get involved in the Adopt-A-Stop 

program 

Not required 
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Adopt-A-Stop An ArcGIS Pro project package used by transit 

personnel to configure the Adopt-A-Stop app 

and publish supporting web tools to ArcGIS 

Enterprise 

GIS Professional 

Standard with Web tool 

publisher permission 

Adopt-A-Stop 

Manager 

A Crowdsource Manager app used by transit 

personnel to manage Adopt-A-Stop participants 

Editor 

Adopt-A-Stop 

Dashboard 

An ArcGIS Dashboards app used by transit 

personnel to monitor the Adopt-A-Stop program 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Adopt-A-Stop 
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Configure Adopt-A-Stop 
Learn how to configure the Adopt-A-Stop solution to meet specific needs in your organization. 

 

Publish the Adopt-A-Stop app 
The Adopt-A-Stop solution includes an ArcGIS Pro project used to publish the Adopt-A-Stop 

app. When you are ready to publish the app, a series of tasks are included to help you get 

started. 

 

Get started 
Use the ArcGIS Pro project to familiarize yourself with Adopt-A-Stop. 

1. Sign in to your ArcGIS organization and browse to the Adopt-A-Stop Project Package. 

2. Open the item page and click Download. 

3. Browse to and open the Adopt-A-Stop project. 

4. On the View tab, in the Windows group, click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Adopt-A-Stop task. 

6. In the Tasks pane, expand the Getting to Know Adopt-A-Stop task group. 

7. Double-click Understanding Adopt-A-Stop task to review it. 

 

Configure Adopt-A-Stop 
Use the ArcGIS Pro project to set up Adopt-A-Stop. 

1. In the Tasks pane, expand the Configure Adopt-A-Stop task group. 

2. Use the Configure Adopt-A-Stop task group to access several tasks that guide you 
through: 

– Load your transit stops into the AdoptAStops feature layer deployed with the 
solution. 

– Set up a user table in ArcGIS Enterprise to store program participants. 

– Publish the authentication geoprocessing webtool. 

– Configure the Adopt-A-Stop app. 

 

Contact participants 
Use the ArcGIS Pro project to configure tools necessary for contacting participants in the Adopt-

A-Stop program. 

1. In the Tasks pane, expand the Contact participants task group. 
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  The Contact participants task group contains tasks to help you contact program 
participants by sending bulk emails or contacting a selection of participants by local or 
attribute. 

2.  Follow the task instructions to configure the bulk email model with your SMTP server and 
contact participants. 

 

Configure the Adopt-A-Stop site 
The Adopt-A-Stop solution includes the Adopt-A-Stop ArcGIS Hub site that your organization 

can configure with your branding and can use to share information about participating in the 

adopt-a-stop program with the public. 

 

Update with organizational information 
After deploying the Adopt-A-Stop solution, the Adopt-A-Stop site layout only requires a few 

updates to fit your local context. Consider what information you already have and what you can 

most easily find. This information can include the following: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-Stop 
site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Statistics section listed under the title of the website.  

  The Stops Adopted and Cleaned This Month statistics cards are already linked to the 
Adopt-A-Stop solution’s AdoptAStops_public feature layer. These stats automatically 
update as participants adopt stops and report cleanings using the Adopt-A-Stop app. 

  The Volunteers stat is provided in a text card but styled to resemble the Summary 
Statistics card; this allows you the option to manually enter a statistic of your choice, 
independent of the solution data. Update the Volunteers stat card with the number of 
program participants, a metric of your choice, or replace the text card with a Summary 
Statistics card and connect it to the AdoptAStops_public feature layer in a similar fashion 
to the other dynamic stat cards. 

5. Update the Volunteers card, hover over the card, click the settings button , and then 
update the text. To add a Summary Statistics card onto the existing row, see Display key 
metrics section in the Insert charts, tables, and metrics topic. Once the card has been 

added to the row, hover over the existing Volunteers card and click the delete button 
. 

6. Scroll to the Adopt a Stop section, hover over the card and click the settings button. 

7. Click the Adopt Stop button and click Edit. 

8. Enter the Adopt-A-Stop app URL published using the Adopt-A-Stop ArcGIS Pro project into 
the Link Destination text box and click Add Link. 
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  Tip: 

  Browse to the Adopt-A-Stop app. Open the item page, click View Application, and copy 
the app URL. 

9. Scroll to the Frequently Asked Questions section, hover over the card and click the 
settings button, and update the questions and answers. 

10.  On the side panel, click Footer. 

  A custom footer is already provided, and in most cases, it needs to be updated with your 
organization's branding, contact information, and social media references. 

11. Click the HTML text box. 

  The HTML window appears. 

12. Make the necessary changes and click Apply. 

13. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Adopt-A-Stop solution must be shared with 

everyone so they can be accessed by the public on the Adopt-A-Stop site. To share your adopt-

a-stop items with everyone, use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-Stop 
folder. 

2. Check the check box next to each of the items below: 

  Item   Name 

  Feature Layer (hosted, view)   AdoptAStops_public 

  Web Map   Adopt-A-Stop 

  Web Mapping Application   Adopt-A-Stop 

  Site Application   Adopt-A-Stop 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 

 

Deploy related solutions 
This site references content from the Transit Outreach solution. To deploy the Transit Outreach 

solution, follow the steps in the Deploy an ArcGIS Solutions section. 
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Update solution references 
This site references a solution deployed in the previous section. To update your site, complete 

the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Adopt-A-Stop 
site. 

2. Open the item page and click Configure App. 

3. Click the edit button  to open the site editor. 

4. Scroll to the Report a Problem section, hover over the card, and click the settings button 

. 

5. Click the Submit Report button and click Edit. 

6.  Enter the Transit Rider Reporter app URL deployed in the Transit Outreach solution in the 
Link Destination text box and click Add Link. 

  Tip: 

  Browse to the Transit Rider Reporter app. Open the item page, click View Application, 
and copy the app URL. 

7. Edit the phone numbers in the Contact Call Center section or remove if not applicable. 

8. Click Save. 

 

Share items with the public 
Several layer views, maps and apps included in the Transit Outreach solution must be shared 

with everyone so they can be accessed by the public on the Adopt-A-Stop site. To share your 

transit outreach items with everyone, use the guide below and complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Transit 
Outreach folder. 

2. Check the check box next to each of the items below: 

  Item   Name 

  Feature Layer (hosted, view)   TransitRiderReports_public 

  Form   Transit Rider Reporter 

3. Click Share. 

4.  In the Share window, click Everyone (public) and click Save. 

  The Warning: Sharing editable layers publicly message appears notifying you that you 
are sharing editable layers publicly. 

5. Click Update. 
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Adopta widget settings 
The Adopt-A-Stop app uses the Adopta widget with preconfigured settings and actions. 

Optionally, you can modify and expand the Adopta widget’s settings to meet your organization's 

needs. Use the tables below to understand the Adopta widget's configuration settings and 

capabilities. 

 

Layer and Authentication settings 
The Layer and Authentication settings allow you to configure behaviors as well as the look and 

feel of the user interface. 

Setting Description 

Asset nickname 

field 

Field that stores the stop's nickname. 

Login screen 

message 

Message that appears when signing in to the application. 

Additional 

signup field 

Fields in the UserTable to be displayed in the sign up form in addition to 

email—for example, add first and last name, address, and phone number. 

Show asset 

address 

Display the reverse geocoded address of a stop in the details view. 

Asset highlight 

color 

Color of selection symbol displayed around the stop symbol when it is 

selected on the map. 

Tolerance 

setting 

New stops are created if no asset is found within the tolerance. 

My asset 

symbol 

Choose a symbol and set the size of user-adopted stops. 

 

Actions 
The primary actions used for the Adopt-A-Stop app are assign (Adopt) and unassign (Opt out). 

You can configure additional actions as needed. 

Setting Description 

Assign status 

settings 

Allows you to label the button (Adopt) in the asset detail view and specify 

additional actions that occur after clicking the assign status button. 

Unassigned 

status settings 

Allows you to configure the unassigned label (Abandoned) in the asset 

detail view and specify additional actions that occur after clicking the 

unassigned label. 
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Additional status 

settings 

Allows you add additional actions you want adopters to report on—for 

example, damaged stops. 

Primary Status Displays text and status buttons in the Adopta application—for example, 

Is the stop cleaned? 

Before action 

image 

Image that is displayed before performing an action. 

After action image Image that is displayed after performing an action. 

 

Messages 
The Adopt-A-Stop app displays messages based on user interaction—for example, Thank you 

for adopting stop name. You can modify the messages or create additional messages 

according to your organization’s needs. 

Setting Description 

Assign Message displayed when an asset is successfully assigned. Use 

'${assetTitle}', for example, to display the title of asset in message. 

Unassign Message displayed when an asset is successfully unassigned. 

Action Message displayed when action is successfully completed. Use 

'${actionName}', for example, to display the name of action in 

message. 

Asset not found Message displayed when asset is not found. 

Asset already 

assigned 

Message displayed when asset is already assigned. Use 

'${assetTitle}', for example, to display the title of asset in message. 

Unable to perform 

action 

Message displayed when action is not successful. Use 

${actionName}, for example, to display the name of the action 

message. 

Asset creation Message displayed when creating an asset. Use ${layerName}, for 

example, to display the name of the layer in message. 

Create asset failed Message displayed when asset creating fails. 

User token expired Message displayed when user token is expired and generated. 

Signup/Login 

success 

Message displayed after successful sign up or log in. 

Home screen (when 

logged in) 

Message displayed in widgets home screen after user logs into the 

application. 

Cursor tooltip before 

login 

Message displayed when the user hovers over the map with their 

pointer before logging in to the application. 
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Cursor tooltip after 

login 

Message displayed when the user hovers over the map with their 

pointer after logging in to the application. 

Nickname hint The text displayed in the nickname hint text box. 
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Use Adopt-A-Stop 
The Adopt-A-Stop solution delivers a set of capabilities that help you engage volunteers to keep 

transit stops clean, manage participants, and monitor the performance of the adoption program. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note:  

Use your organization's data or configured apps to follow these workflows. 

 

Adopt a stop 
First, you’ll assume the role of a transit rider who wants to participate in your local transit 

agency’s adopt-a-stop program. You’ll use the Adopt-A-Stop app to submit an adoption request 

and report the stop is clean. 

1. In a browser, from the Adopt-A-Stop solution, view the Adopt-A-Stop site. 

2. Scroll to the Adopt-A-Stop section, and then click Adopt Stop to open the Adopt-A-Stop 
app. 

3. In the panel on the right, type your email address, and then click Login/Sign Up to sign up 
and begin the adoption process. 

4. In the form, type your contact details, and then click Sign Up. 

  The Adopt-A-Stop app sends an email with program details and a link that you will use to 
log in to the app. 

5.  In the email, click Login. 

  Returning users also receive an email with a link used to sign in to the app. 

  The Adopt-A-Stop app opens in a browser with your newly created user authenticated. 
Notice the instructions to select a stop on map to adopt. 

6. Select an available stop to adopt (the gray symbols on the map). Optionally, add a 
nickname to your stop in the text box. Click Adopt. 

  Adopt-A-Stop displays a thank you message. The Adopt-A-Stop pane displays your stop as 
Adoption Pending and allows you to report if the stop is clean or to opt out of adopting the 
stop. You can use the Adopt-A-Stop app to regularly report cleanings. 

 

Manage adoptions and participants 
You are now a transit agency employee managing the stop adoption program. You will use the 

Adopt-A-Stop Manager app to approve adoption requests and contact program participants. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-Stop 
solution. 

2. View the Adopt-A-Stop Manager app. 
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  Pending and adopted stop requests are listed in the table at the top. The table can be 
sorted and filtered in various ways. 

3. In the table, click the Adoption Status column filter, and then for Status is, choose 
Pending. 

4. Click the Date Adopted column header and choose Sort in descending order. 

  The pending adoption requests are now listed with the most recent request at the top. 

5. Select a pending adoption request from the table. 

  The map selects the stop and zooms to the appropriate location, and the request details 
open at the bottom left. 

6. Review the details. 

7. In the details, click the participant’s email address to share information about your Adopt-A-
Stop program with the participant. 

  Adopt-A-Stop Manager opens your email client and presents a preformatted subject. 

  After contacting the participant, you are ready to approve the adoption request. 

8. In the Adopt-A-Stop Manager app, in the request details, click the Edit record button . 

9. For Adoption Status, choose Adopted.  

10. Optionally, modify the nickname to ensure it is appropriate to be displayed in Adopt-A-Stop 
app. 

11. Click Save. 

12. Optionally, click a record in the table, and then in its details, click Manage Adopter’s 
Stops to launch the Adopt-A-Stop app and manage the stops adopted by the selected 
user.  

  You can use this workflow to remove an adopter from a stop, making it available for 
adoption. 

 

Monitor the program 
You will continue your role as a transit agency employee, this time looking to monitor the Adopt-

A-Stop program. You will use the Adopt-A-Stop Dashboard to review key metrics and trends. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Adopt-A-Stop 
solution. 

2. View the Adopt-A-Stop Dashboard app. 

  The Adopt-A-Stop Dashboard displays new adoptions and cleaning charts by month and 
provides management a quick view of program activity over time. 

3. On the left, adjust filters to explore transit stop status, type, date adopted and last cleaned.  

  Note: 

  Dashboard charts are linked. If you click a month in either New Adoptions by Month or 
Cleanings by Month charts, related details are filtered and updated in other elements in 
the dashboard. 
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4. On the right, select a stop from the list to view key details. Alternatively, click a stop on the 
map.  

5. Optionally, in a pop-up, click Manage Stop in the pop-up to launch the Adopt-A-Stop 
Manager app.  
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Business Resilience 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Business Resilience 
Business Resilience can be used to better understand the current status of asset locations. 

Organizations focus on allowing key leaders to have constant awareness of threats to the 

organization. Security and risk teams must be able to have one location that visually 

communicates information to allow decision makers to take action when a threat occurs or a 

status changes at a location. Analysts must create assessment reports based on threats or 

changes to the facility and be able to share these assessments with key leadership at the facility 

level and up to the C-suite level for actionable decision making. Business Resilience is typically 

implemented by organizations that want to take a proactive, data-driven approach to plan, 

manage, and enhance current business operations. 

The Business Resilience solution delivers key leadership the ability to share the status of retail 

stores, manufacturing plants, and other facilities. The solution provides the ability to understand 

and update the current status and review and share operational assessments to key leaders. 

 

Requirements 
Business Resilience requires the following: 

• ArcGIS Enterprise 10.7.1 - 10.8.1 

• ArcGIS Survey123 Connect 

 

Information products 
Business Resilience includes the following information products: 

Item Description 

Minimum 

user type 

Business Resilience 

Web App 

An ArcGIS Web AppBuilder app used by analysts to 

understand, manage, and maintain the operational 

status of an organization 

Editor 
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Operational 

Assessment Survey 

An ArcGIS Survey123 form app used by facility 

managers to report the facility status 

Editor 

Facility Manager An ArcGIS Web AppBuilder app used by analysts to 

maintain an organization's facility information 

Editor 

FacilitySource An Excel document used to load and validate an 

authoritative list of facilities into ArcGIS 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • An update to the Operational Assessment Survey to support multiple images 
and automates contact data entry. 

• An update to the facility layer symbology. 

• An update to the facility and operational assessment layer schemas. 

1.0 • First release of Business Resilience 
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Configure Business Resilience 
In this topic, you will learn how to configure the Business Resilience solution to meet specific 

needs in your organization. 

 

Load data 
Organizations can use Business Resilience as a source of information to understand risk to their 

company’s critical infrastructure. 

Facility information must be loaded before using the app. Use the FacilitySource file to organize 

facility information before loading it into ArcGIS. Ensure that you populate the Facility ID column 

with unique values in the FacilitySource file. 

Note: 

Each row in the FacilitySource Excel document must have a unique facility ID; otherwise, 
your data will not load correctly. 

In some cases, you may already have an inventory of facilities in ArcGIS. If you do, review the 

layers provided with the solution and determine what, if any, source data you would like to load. 

Then, load your existing data into the layers provided with the ArcGIS Solution before sharing 

the maps or applications. 

Note: 

If you need to load data into the solution, you may want to develop a source-target matrix to 
track how your source data will be loaded into the target layer or layers used in the solution. 

To load your facilities from a spreadsheet, complete the steps below: 

1. If necessary, sign in to your ArcGIS organization and browse to the FacilitySource item. 

2.  Open the item details page. 

3. Click Download. 

4. Edit the Excel file and populate your facility information in the document. 

  Note: 

  At a minimum, you need to provide a unique facility ID and the latitude and longitude for 
each facility in the FacilitySource file. If you don't have a unique ID, you can edit the Excel 
file and copy this formula into the first row of the facilityid column: 
=CONCATENATE("Facility-", TEXT(ROW(A1),"00000")). You can then drag the right 
corner of the cell downward to fill the formula for all facilities, giving each a unique ID. 

5.  In your ArcGIS organization, at the top of the site, click Content. 

6. On the My Content tab, type facilities in the search box. 

7. On the left under Folders, click the folder Business Resilience was deployed to. 

8. Click the item title for Facilities to view its details. 
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9. Click Update Data and click Append Data to Layer. 

10. Under Filename, choose your spreadsheet. 

11. Click Upload and Continue. 

12. Under Choose the layer from FacilitySource.xlsx that contains the updated data, 
choose the spreadsheet Input Data.  

13. Uncheck Update existing features 

  Note: 

  If features exist in the layer that you would like to update, do not uncheck. 

14. Click Show field matching to map the fields. 

  Note: 

  While field matching is auto mapped ensure that the fields are properly mapped. 

15. Click Apply Updates. 

 

Configure the survey form 
To show your facility information in the survey form, you will use ArcGIS Survey123 Connect to 

make necessary updates. Adding your facility information to the form enables an extra level of 

data validation to ensure that facility information is correct and the respondent’s questions are 

associated with the correct facility. 

 

Open the form using ArcGIS Survey123 Connect 
If Survey123 Connect is not already downloaded, you can find the download link on the ArcGIS 

Survey123 Resources page. 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Operational Assessment Survey in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Operational Assessment Survey to view its details. 

6. Click Open in Survey123 and click Edit in Survey123 Connect. 

  ArcGIS Survey123 Connect opens. 

  Note: 

  If this is your first time opening ArcGIS Survey123 Connect, you may need to add your 
organization’s portal and sign in. To add the URL, click Settings. Then, in the Settings 
window, click Add Connection and paste the URL. Click OK. After adding the connection, 
click Sign in to sign in to your organization. Verify that the active connection is set to the 
correct URL. 

7. Click the Operational Assessment Survey form to download the survey. 
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8. Click the Operational Assessment Survey form again to open the survey. 

 

Add the facility list 
The survey form in ArcGIS Enterprise can be configured to restrict available answers to a list of 

valid values. This level of data validation mitigates errors due to misspellings. Furthermore, 

questions will be populated based on the facility selected using the built-in pulldata function. 

1. In the left pane, click Open XLSForm Spreadsheet. 

  An Excel window appears where you are presented with survey property settings. In the 
row with the label name survey_facility_id of the survey worksheet, the choice list named 
FacilityID is referenced to prefill a value associated with the facility identifier question. 

2. Go to the external_choices tab and add a row for each facility ID. 

  The tab comprises all the selectable options for the Facility Identifier question. 

  Note: 

  The name column specifies the value of a choice. The selected value is read by the other 
items in the Business Resilience solution, such as the Facilities layer and the web app. 
These values cannot include special characters. The list name column specifies which 
question the answer choices belong to. In this case, you will be referencing the Facility 
Identifier question using the FacilityID list name. The label column displays the answer 
choice exactly as it will appear on the form and does not have formatting or special 
character restrictions like the name column. The externalFilter attribute must be set to yes 
for all rows. 

3. Save the Microsoft Excel spreadsheet and close it. 

 

Add the contact data 
To prepopulate questions based on the selected facility ID in ArcGIS Enterprise, you can 

preload a CSV file with data with pertinent facility information. This enables setting the facility ID 

to automatically populate the manager name, contact information, and facility location. 

1. In the left pane of the application, click Open Survey Content Folder. 

  The file explorer window opens with access to the media subfolder. 

  Learn more about how the CSV file prepopulates answers in Survey123 

2. Browse to the media folder and open Facilities.csv. 

3. The first column represents the facility ID value that appears in the Facilities layer. 

  Note: 

  The facility ID in this column connects the facility ID that you added to the survey choices 
to the facility data. This is the information that appears when a user chooses a facility for 
the Facility Identifier question. 

4. Append the facility information into the corresponding columns. 

5. Save the CSV file and close it. 

6. In the left pane of the application, click Update Survey Form. 
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  The survey refreshes with the information added to the form. 

7. In the form preview in ArcGIS Survey123 Connect, expand the Facility Location Details 
group to reveal the Facility Identifier question. 

8. Click the drop-down menu to preview the information.  

  The available list of values in the drop-down menu is based on the concatenated values 
you previously calculated. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish the changes. 

 

Update the survey URL fields 
The Facilities feature layer is used in the Business Resilience Web App to map your facilities, 

display their data contained in the attribute table, and connect to the Operational Assessment 

Survey. Complete the steps below to add the survey URLs as attributes in the Facilities layer. 

 

Acquire the URL of the survey 
To get the URL of the survey, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Operational Assessment Survey in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Operational Assessment Survey to view its details. 

6. Click Open in Survey123 > Open in Survey123 app. 

  Note: 

  A new tab opens, prompting you to open into Survey123 app. Click Cancel and remove 
"&open=native" from the URL to open survey directly into the browser. 

7. In the address bar of the browser, copy the survey URL, including the question mark and 
portalURL= statement. 

  Note: 

  For example, if the URL is as follows: 

  https://survey123.arcgis.com/share/aee97bcef4d24c9187da9590ec86b67c?porta
lUrl=https://LearnGIS.maps.arcgis.com 

  This URL will be used to populate the survey URL attributes for the Facilities layer. 

8. Paste the URL into a plain text document to keep it available. 

 

Populate the Base Survey URL field 
To populate the Base Survey URL field, complete the following steps: 

1. If necessary, sign in to your ArcGIS organization. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 64 

2. At the top of the site, click Content. 

3. On the My Content tab, type Facilities in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Facilities to view its details. 

6. Click the Data tab. 

  A table view of the layer appears. 

7. Scroll to the right until you see the Base Survey URL field. Click Base Survey URL and 
click Calculate. 

8. In the Calculate Field pane, click Arcade. 

9. In the Arcade calculator, type the following: 

   var BaseURL = ”” 

10. Copy the URL of the survey from your text document and paste it between the quotation 
marks. 

11. Add a new line and type the following: 

   return BaseURL 

12. Click OK. 

  The string is added to each record in the Facilities layer’s Base Survey URL field. 

  Note: 

  This calculation must be manually run when new features added to the Facilities layer. 

 

Populate the Assessment Survey URL field 
To populate the Assessment Survey URL field, complete the following steps: 

1. Scroll to the right until you see Assessment Survey URL. Click Assessment Survey URL 
and click Calculate. 

2. In the Calculate Field pane, click Arcade. 

3. Copy and paste the Arcade expression into the expression box: 

  var BaseURL = $feature["base_survey_url"] 
var JoinedURL = BaseURL + "&field:survey_facility_id=" + 
UrlEncode($feature["facility_id"]) 
return JoinedURL 

4. Click OK. 

  The Assessment Survey URL field is populated with URLs that also have the field 
parameter set to the corresponding facility’s ID value. 

  Note: 

  This calculation must be manually run when new features added to the Facilities layer. 
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Enable live data fields 
The Business Resilience Web App utilizes live data feeds that provide information about major 

hazards, such as severe weather, earthquakes, or hurricanes, that would likely impact assets, 

and it provides real-time content about these natural disasters. To use these feeds in the app, 

you first need to enable them in the app. 

Note: 

Real-time data is hosted in ArcGIS Living Atlas, an authoritative data catalog maintained by 
Esri. You can read more about live feeds in ArcGIS Living Atlas in the Putting the “Live” in 
Living Atlas of the World blog post. 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Business Resilience Web App in the search box. 

4. On the left under Folders, click the folder Business Resilience was deployed to. 

5. Click the item title for Business Resilience Web App to view its details. 

6. Click Edit Application. 

  ArcGIS Web AppBuilder opens in edit mode. 

7. In the left pane, click the Attributes tab. 

8. In the Attribute pane, click Subscriber Content Access. 

  The map layers listed are all premium subscriber content that your organization has access 
to. Enabling this content consumes credits. Learn more about ArcGIS Online information 
on credits. 

9. Check each layer to enable the content. 

10. Click Save. 

  Now that the app is configured, you can view the live feeds. 

11. Click Launch to view the app. 
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Use Business Resilience 
In this topic, you will learn how to use the Business Resilience solution and the set of 

capabilities and features that it provides. 

Note:  

Use your organization's data or configured apps to follow these workflows. 

 

Visualize hazards 
There are a variety of hazards, such as severe weather, fires, earthquakes, and hurricanes, that 

have the potential to affect your facilities. Many organizations have large geographic footprints 

and may be impacted by a diverse array of natural hazards and threats. The Business 

Resilience solution allows an analyst in an operation center to monitor hazards that may 

threaten your facilities. 

To use the Business Resilience solution to visualize hazards, complete the following steps: 

1. In a browser, open the Business Resilience Web App. 

  On the right side of the app, the layers pane is divided into the following sections: 

– Organizational Assets 

– Weather Layers 

– Drought and Wildfires 

– Natural Disasters  

  In the Organizational Assets section of the Layers pane, the Operational Assessment 
Survey and Facilities layers are turned on by default. 

  Facilities are represented by point features that appear on the map and are symbolized to 
indicate their status. 

  The Operational Assessment Survey layer shows results of surveys that have been 
submitted by facility managers. 

2. In the upper right of the Weather Layers section, click the options menu and click Turn all 
layers on. 

  These layers contain real-time weather feeds, many of which are published by the National 
Weather Service. Use these layers to track potential severe weather threats to your 
facilities. 

  To see the symbology for these layers, you can expand them individually by clicking the 
arrows to the left of the layer visibility check boxes. 

3. To optionally view more details on each layer, click the options button and click Show item 
details. Otherwise, in the upper right of the Weather Layers section, click the options 
menu and click Turn all layers off. 

  Tip: 
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  You can also use keyboard shortcuts to turn groups of layers on or off and expand or 
collapse them. Press the Ctrl key and check the layer check box to turn layers on or off in 
the same level. Press the Ctrl key and click the arrow to expand or collapse a layer in the 
same level. 

4. In the upper right of the Wildfires and Active Fires section, click the options menu and 
click Turn all layers on. 

  These layers contain the latest up-to-date information on current and ongoing fire-related 
incidents. Areas suffering drought conditions may be at greater risk of wildfire, so these 
areas may pose an elevated risk to your facilities. Use these layers to track potential fire-
related threats to your facilities. 

  To see the symbology for these layers, you can expand them individually by clicking the 
arrows to the left of the layer visibility check boxes. 

5. To optionally view more details on each layer, click the options button and click Show item 
details. Otherwise, in the upper right of the Droughts and Wildfires section, click the 
options menu and click Turn all layers off. 

6. In the upper right of the Natural Disasters section, click the context menu to expand and 
click Turn all layers on. 

  These layers contain real-time feeds of the latest natural hazards, such as hurricanes and 
earthquakes. 

  To see the symbology for these layers, you can expand them individually by clicking the 
arrows to the left of the layer visibility check boxes. 

7. To optionally view more details on each layer, click the options button and click Show item 
details. Otherwise, in the upper right of the Natural Disasters section, click the options 
menu and click Turn all layers off. 

  Tip: 

  When you configure the Business Resilience Web App, you can include your own sections, 
groups, and layers. For example, if you are tracking threats to coastal facilities, you can 
create another section named Coastal Threats and include layers from the National 
Weather Service, such as High Surf Advisory, Areal Flood Warning, and Coastal Flood 
Watch. 

 

Send an assessment survey 
The role of an analyst in the operations center is to watch over the multitude of threats that may 

impact one or more assets within your organization. When a threat has been detected to 

potentially impact one or more facilities, it is imperative to alert the facility administrators of the 

possible impact and understand the potential effects of the even on the facility to minimize 

disruption. The Business Resilience Web App is configured to allow you to quickly send out an 

assessment to the facility manager. 
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Send an assessment to a single facility 
In this workflow, you will take on the role of an analyst who has be alerted to an event that is 

threatening a facility. You will be sending an assessment form to gather relevant information 

from the facility manager at the threatened facility. 

1. In a browser, open the Business Resilience Web App app if you do not have it open 
already. 

2. Select a facility of interest from the list on the left side of the application or zoom to the 
location of the facility and click the facility. 

  In the pop-up window, general details about the facility are provided. 

3. On the pop-up, in the Notes section, click the Click here to send Operational Assessment 
to Facility Administrator link. 

  An email opens in your email client. It is populated with the email address of the facility 
manager, the name of the manager, text requesting information about the event, and a 
hyperlink to a survey that the manager can use to reply with status information. 

4. Select the [INSERT EVENT DESCRIPTION AND DETAILS HERE] text in the email and 
add any other information that may be useful to the facility manager in evaluating the 
threat. 

5. Send the email to the manager. 

 

Send an assessment to multiple facilities 
In this workflow, you will take on the role of an analyst who has identified a hurricane event that 

is threatening multiple facilities. You will be sending assessments form to gather relevant 

information from the facility manager at the threatened facilities. 

1. In a browser, open the Business Resilience Web App if you do not have it open already. 

2. Select the Create Assessment Report widget in the upper right of the application, above 
the layers pane. 

3. With the Create Assessment Report widget open, define an area of interest by searching 
for a location in the Place Name tool or using the Draw tool. Click the Draw tool and click 
the Select by Rectangle button. 

4. Click Choose selectable layers to expand the layer list and select Hurricane Irma 
Example – Forecast Cone. Uncheck all other layers. 

  You can use the Choose selectable layer list to define the layers that are selectable on 
the map. 

5. On the map, drag a small box on the Hurricane Irma forecast cone feature. This selects the 
feature from the service, just as it would select a feature in a live Hurricane Forecast feed. 

6. Optionally, set a Buffer distance value to select facilities that are also within a distance 
from the selected feature, and click Report. 

  The report of facilities within the buffer around the forecast cone is generated. 

7. In the Create Assessment Report pane, click the Expand button next to Facilities to 
expand the list. 
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  The report contains information about each facility, including the facility ID, a survey link, 
the number of employees at the location, and the manager's name and email address. 

8. If you would like a CSV file of selected facilities, click the Download button. 

9. If you want a PDF report, click the Print button, choose a report layout size, and click the 
Print button to generate the report. 

10. In the header section of the report web page, click Print to save. 

  Tip: 

  You can get a list of all the email addresses from the downloaded CSV file of selected 
facilities. Find the email column and copy the facility manager email address to your 
clipboard, and paste it into your email client to send a report. 

 

Submit an assessment survey 
For an organization to assess impacts, facility managers can share relevant information about 

the operational status of their facility and the impact of a likely event. The Operational 

Assessment Survey allows facility managers to submit this information back to the operations 

center. The survey contains assessment questions about the exterior, interior, and employee 

vulnerability. This information allows decision makers to understand the threat, prioritize aid, 

and allocate supporting resources throughout the organization. 

In this workflow, you will take on the role of a facility manager at a threatened facility and use 

the survey link to send status information to the operations center. 

1. In a browser, open the Operational Assessment Survey. 

  This is a link to the survey for Facility #104. 

  Note: 

  The URL for the survey includes the facility ID. This ties the survey to a specific facility 
location and allows the survey to be populated with information about the facility, saving 
the manager time. 

  The survey opens in a browser tab. The Potential Impact Assessment section is open 
with a number of questions that you can answer to communicate your facility's status back 
to the operations center. 

2. Click the header for the top section, Facility Location Details. 

  The details for your facility are prepopulated in the survey. 

3. Complete the Potential Impact Assessment section. 

  Parameter   Value 

  External Vulnerablity   Select Low. 

  Interior Vulnerablity   Select Negligible. 

  Employee Vulnerablity   Select Moderate. 

  Employee Vulnerablity Extent   Select 25% to 50%. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 70 

   Do you foresee the need to possibly temporarily close 
this location due to this event? 

  Select Maybe/Not 
Sure. 

   Is there a potential need for local evacuation?   Select No. 

   Describe any relevant information, thoughts, strategies, 
or issues 

  Type relevant 
information. 

4. Optionally, upload pictures of the facility and of any vulnerability concerns in the Media 
group to provide further context. 

5. Once the survey is completed, click the Submit button. 

 

Review assessments 
Upon submission of assessment reports, they appear as points on the map. The feedback in the 

survey is key to assessing the potential impact to the health and safety of customers, 

employees, and assets while also understanding how to facilitate resources and minimize 

interruptions. 

In this workflow, you will take on the role of the analyst in the command center reviewing an 

open submission by a facility manager. 

1. In a browser, open the Business Resilience Web App app. 

2. In the Facilities pane on the left side of the Business Resilience web app, expand the 
Assessment Status section if it is not already expanded. 

  This group contains a list of assessments by status with the latest submission at the 
bottom. 

3. Click the latest submission in the list. 

  The assessment is selected, and the pop-up appears on the map. 

4. On the pop-up, in the lower right corner, click the Options button and click Smart Editor. 

  The Review Assessments pane appears. You can see the responses the facility manager 
sent, describing the probable impact of the event on the facility. 

5. Review the information provided by the facility manager. 

6. Optionally, change the status from Open to Under Review. 

7. Click Save and close the Review Assessments pane. 

  The assessment status changes to Under Review on the map and in the Assessment 
Status group. Once the review status is set to Closed, the assessment is removed from 
the list and the map. 

 

Modify operational status 
Upon review of an assessment, an analyst can modify the status of one or more facilities in the 

organization to reflect its current state for visual awareness. This is important when working with 

a team that needs to keep track of the overall operational impact to an organization and share 

the latest information with an executive audience. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 71 

In this workflow, you will take on the role of the analyst in the command center updating the 

operational status of facilities to reflect their current state. 

1. In a browser, open the Business Resilience Web App if you do not have it open already. 

2. Zoom in on the map to the facility you want to update. 

3. Select the Modify Facility Status widget from the upper right of the application, above the 
layers pane. 

4. In the Modify Facility Status pane, click the Select by Rectangle button. 

5. Drag a box around the facility you want to modify. 

  The Modify Facility Status window appears with multiple drop-down buttons. 

  Note: 

  You can also select and update multiple facilities at the same time. 

6. Enter the following values for the parameters: 

  Parameter   Value 

  Notes   Manager reports local flooding with the power and gas 
service out. 

  Operating Status   Select Impacted. 

   Electric Service 
Status 

  Select Impacted. 

   Fire System Status   Select Operating. 

   HVAC Status   Select Operating. 

   Gas Service Status   Select Impacted. 

   Water Service 
Status 

  Select Operating. 

7. Click Save. 

  The change in status updates the symbology of update facilities on the map as well as the 
Facilities list on the left side to reflect the current count of facilities by status. 
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Coronavirus Force Readiness 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Coronavirus Force Readiness 
Coronavirus Force Readiness can be used to understand force availability and share 

authoritative information with decision makers during the Coronavirus Disease 2019 (COVID-

19) pandemic. 

The solution provides units with information regarding which personnel can report for duty and 

an understanding of their capacity to respond to a request for assistance during the COVID-19 

pandemic. Units may be requested to assist in setting up alternate care facilities, detection 

testing sites, supporting food distribution, and so on. Having personnel perform a routine check-

in or having someone from the armory or unit provide the readiness status of a group of 

personnel gives units clarity into a unit’s readiness during the pandemic. Coronavirus Force 

Readiness is typically implemented by the National Guard, Air National Guard, and other 

service branches that want to take a data-driven approach to understanding force availability 

during COVID-19. 

The Coronavirus Force Readiness solution delivers a set of capabilities that help you to 

understand the operational capacity of a force, monitor the status of units, and communicate 

capabilities and disruptions to commanders and administrative staffs during the COVID-19 

pandemic. 

 

Requirements 
Coronavirus Force Readiness requires the following: 

• ArcGIS Enterprise 10.7.1 - 10.8.1 

• ArcGIS Survey123 
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Information products 
Coronavirus Force Readiness includes the following information products: 

Item Description 

Minimum 

user type 

Admin Dashboard An ArcGIS Dashboards app used by administrative 

NCOs to monitor personnel availability. 

Viewer 

Personnel Readiness 

Dashboard 

An ArcGIS Dashboards app used by any unit 

member to track and monitor personnel readiness 

and availability. 

Viewer 

Commander's 

Dashboard 

An ArcGIS Dashboards used by commanders to 

quickly assess the overall unit readiness. 

Viewer 

Personnel Readiness 

Report 

An ArcGIS Survey123 form used by a military unit 

member to report availability. 

Not required 

Personnel Readiness 

Batch Report 

An ArcGIS Survey123 form used by an NCO or 

armory clerk to report the availability of their 

personnel. 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Coronavirus Force Readiness 
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Configure Coronavirus Force Readiness 
In this topic, you will learn how to configure the Coronavirus Force Readiness solution to meet 

specific needs in your organization. 

 

Extend force readiness surveys 
The Coronavirus Force Readiness solution includes a series of surveys that can be used to 

understand the capacity of your workforce. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 

organizational policies and any applicable laws. Additionally, ensure that you secure the survey 

and underlying layers and only share the content with appropriate members of your 

organization. 

 

Update feature layer views 
The Coronavirus Force Readiness solution includes a series of views created from the 

Personnel Readiness feature layer. The feature layer is used in the surveys and the subsequent 

views are used in the dashboards. Organizations may modify the Personnel Readiness Report 

survey and ultimately add new fields to the feature layers. When doing so, the new fields must 

be exposed in the appropriate views. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Browse to the view in your contents. 

2. Click the Visualization tab. 

3. Click the Options button  on the appropriate layer or table, then click Set View 
Definition. 

4. Click Define Fields. 

5. Scroll to the newly created field and check the box. Click Apply. 

  The new field is added to the view's definition. 

6. Repeat steps 1 through 5 for the Personnel Readiness Dashboard. 

7. Update the Personnel Readiness Dashboard to account for the new fields you added to the 
layers. 

 

Modify readiness surveys 
To modify a Coronavirus Force Readiness survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization.  

3. Click Personnel Readiness Report to download the survey.  

4. Click the Personnel Readiness Report again to open the survey. 
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5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the Choices tab. This tab comprises all of the 
selectable options for survey questions. 

7. Revise the survey to reflect your personnel readiness needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes in ArcGIS Survey123 
Connect. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

 

Configure echelons 
The dashboards are preconfigured to display four battalions and four companies under each 

battalion. Follow the steps below to add or remove battalions or companies from your 

dashboard. 

 

Add a battalion 
To add battalions or companies to the dashboard, complete the following steps: 

1. Sign in to your Portal for ArcGIS organization. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the last battalion tab while in edit mode. 

5. Go to the editing tool within this element and select Duplicate. 

6. Drag the newly created copy and position it below the last battalion tab. 

7. Reference duplicated battalion settings, text, and configuration. 

8. Add a new name, for example, 5th BN, to the new component. 

9. Save your application. 

 

Remove a battalion tab 
To remove a battalion or companies from the dashboard, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the battalion tab you want to delete while in edit mode. 

5. Click the Delete button  to delete the selected battalion. 

6. Save your application. 
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Configure alternate reporting periods 
The dashboards are preconfigured to display individuals reporting within the last 24 hours. The 

dashboard owner can configure the dashboard to display alternate reporting periods. The 

Personnel List is the most commonly configured element in regard to its contents and time 

frame. 

To modify the reporting period, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Go to the editing tool within the Personnel List  element and select Configure. 

5. Below Battalion, select the And option and add Date Reported from the drop-down list. 
You can now select from any of the available options and time frames.  

6. Click Done and save your application displaying the new reporting period. 

 

Add readiness tabs for new battalions and companies 
The dashboards are preconfigured to display four battalions and four companies and their 

applicable total force/unit size. This tab also contains the availability based on survey 

submissions and percentage of readiness. 

To add percentages of readiness to the dashboard, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Personnel Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the 3rd Battalion tab while in edit mode 

5. Go to the editing tool within the Personnel List  element and select Duplicate. 

6. Drag the newly created copy and position it below the 3rd Battalion tab. Reference the 3rd 
Battalion settings, text, and configuration. 

7. Add a new name, such as 5th BN, to the new component and save your application. 

8. Go to the Reference section within the configuration tool and add the unit size below Fixed 
Value. 

  This number will provide the available value and percentage of readiness. 

9. Follow the previous step and enter your current Total Force for each unit level. 

10. If you need to remove a battalion tab, click the Delete button . 

11. Save your application. 
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Use Coronavirus Force Readiness 
The Coronavirus Force Readiness solution delivers a set of capabilities that help you to 

understand the operational capacity of a force, monitor the status of units, and communicate 

capabilities and disruptions to commanders and administrative staffs during the COVID-19 

pandemic. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Monitor force readiness 
The Coronavirus Force Readiness solution includes a Personnel Readiness Report survey that 

collects information from personnel, including their duty type, location, MOS (military 

occupational specialty), unit they belong to, and wellness information. Units deploying 

Coronavirus Force Readiness should review the preconfigured questions and adjust as 

necessary to remain in compliance with policies and applicable laws of your state or unit. In 

addition, ensure that you secure the survey and underlying layers and only share the content 

with appropriate members of your unit. 

Some organizations may find it more efficient to have an individual, such as someone from the 

armory, check their unit member in using the Personnel Readiness Batch Report survey. If a 

unit decides to use the batch survey, follow the same general steps below with the Personnel 

Readiness Batch Report survey and the Personnel Readiness Dashboard. 

 

Complete individual readiness report 
You will start by assuming the role of a military unit member. You are asked to use the 

Personnel Readiness Report survey to share your availability status each morning. 

1. In a browser, go to your Personnel Readiness Report survey. 

2. In the Personnel Readiness Report survey, fill in the following details: 

  Parameter   Value 

  State   Select California. 

  Battalion   Select 1st Battalion. 

  Company   Select A Company. 

  Rank   Select E-4/CPL. 

  MOS   Type 12W. 

  Select Duty Type   Select State Active Duty. 

  First Name   Type your first name. 

  Last Name   Type your last name. 

  Commander   Type your commander's name. 
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  Provide Location   Select your location on the map or provide your 
address. 

  Can you report for duty?   Select No. 

  Is it health related?   Select Yes. 

  Is it your health or someone 
else's? 

  Select Self. 

  Is it COVID-19 related?   Select Yes. 

  Select your status   Select Quarantined. 

  Select date quarantine started   Select a date within 14 days of today. 

  Check completed by:   Select Self. 

3. Click Submit. 

 

Monitor personnel readiness 
Now, you will assume the role of the Readiness NCO in the same unit. You are asked to 

monitor the readiness of your unit and are looking to see whether your unit is available to be 

assigned to a mission. You will view the overall readiness of your workforce. 

Note: 

The steps below are the same if you are an administrative NCO and will be using the Admin 
Dashboard to monitor the readiness of your team. The Admin Dashboard will contain 
personal information about the individual unit members. 

1. In a browser, go to the Personnel Readiness Dashboard app. 

2. The Personnel Readiness Dashboard opens with an overview of the overall readiness of 
the brigade and each battalion in the brigade. 

  The overview displays key metrics. This information gives leadership a quick overview of 
the number of unit members available. Statistics related to the availability of your unit are 
also shown. 

3. In the filter at the top of the dashboard, click Last 24 Hrs to see a complete list of the 
submissions from the last 24 hours. 

4. Filter by Time frame, MOS by Battalion, and MOS by Company. Review the list of 
personnel and their locations in the map. 

5. Click each of the Battalion tabs to see the availability for each company in that battalion. 

6. Adjust the slider in the Quarantined (Start Date) - Last 14 Days chart to adjust the time 
period you want to review. 

In the lower left corner of the dashboard, you can review the COVID-19 Status submitted by 

individual unit members. 
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Crime Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Crime Analysis 
Crime Analysis can be used to enhance public safety, identify emerging trends, organize law 

enforcement operations and plan crime-prevention strategies. 

It improves productivity of crime analysts with specialized tools and a tailored desktop GIS 

interface for mapping data and performing spatial analysis, making it easier to quickly generate 

high-quality crime analysis map products. Improved crime analyst productivity helps law 

enforcement decision-makers optimize resource allocation, solve cases, and implement more 

effective crime reduction strategies. Crime Analysis is typically implemented by law enforcement 

agencies that want to use data-driven strategies to reduce crime and improve police operations. 

The Crime Analysis solution delivers a set of capabilities to help you manage incident data, 

conduct tactical and strategic analysis, perform investigative analysis and share web-based or 

hardcopy information products with decision-makers. 

 

Requirements 
Crime Analysis requires the following: 

• ArcGIS Pro 2.7 - 2.9 (Basic, Standard, or Advanced) 

• ArcGIS Spatial Analyst (optional) 

 

Information products 
Crime Analysis includes the following information products: 

Item Description Minimum User Type 

CrimeAnalysis.esriAddInX An ArcGIS Pro add-in used to map, 

identify, and communicate geospatial 

patterns in law enforcement data. 

ArcGIS Desktop 

Basic or GIS 

Professional Basic 

CrimeAnalysisSolution An ArcGIS Pro project that leverages the 

capabilities included in the Crime Analysis 

ArcGIS Desktop 

Basic or GIS 

Professional Basic 
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add-in to generate a standard set of crime 

maps. 

 

Release notes 
The following are the release notes: 

Version Description 

2.0 • The latest release of the Crime Analysis Add-In (2020.12.17) includes a new 
ribbon design and analysis gallery. 

• The following capabilities have been added: Add Graphics Layer, Colocation 
Analysis tool, Density-based Clustering tool, Link Charts, and Reports. 

• Existing tools have been updated to simplify parameters, streamline licensing 
and increase performance. In some cases, tool names have also been 
changed. See Crime Analysis tool updates for more details. 

1.0 • Crime Analysis is now available in the ArcGIS Solutions app. 

• The Crime Analysis Add-In (2019.10.16). 
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Configure Crime Analysis 
The Crime Analysis solution can be downloaded. After downloading, install and configure it to 

meet the needs in your organization. 

 

Download and install Crime Analysis solution 
The Crime Analysis solution includes the Crime Analysis Add-In, ArcGIS Pro project, sample 

data and maps you can use to explore common crime analysis workflows. Before you begin, 

you will need to download the CrimeAnalysis.zip file containing the ArcGIS Pro project and 

Crime Analysis add-in. After this file is downloaded to your computer and extracted, you can 

install the add-in and open the ArcGIS Pro project. 

If you your upgrading from a previous version (2018.6.26 through 2019.10.16) of the Crime 

Analysis Add-In, then skip to the Upgrade Crime Analysis Add-In (optional) section. If you 

are using it for the first time, follow the steps below to download and install the Crime Analysis 

solution. 

1. Browse to a folder on your computer where the CrimeAnalysis.zip was downloaded to. 

2. Extract CrimeAnalysis.zip. 

3. Browse to the CrimeAnalysis folder where you extracted the CrimAnalysis.zip file. 

4. Double-click CrimeAnalysis.esriAddInX to run the installer. 

5. Click the Install Add-In button. 

 

Upgrade Crime Analysis add-In (optional) 
The current version of the Crime Analysis add-in includes significant updates from versions 

2018.6.26 through 2019.10.16. If you are migrating from one of these versions, you will need to 

get familiar with the Crime Analysis ArcGIS Pro project and the Crime Analysis Add-In. See the 

Migration workflows from previous version section below to understand these changes prior 

to installing the new version. 

Note: When you upgrade, the previous version of the add-in and tools will be removed. You will 

need to update any automated scripts or documented workflows. You can install the new 

version of the Crime Analysis Add-In on another computer to limit the impact to your daily work 

while you are updating any automated scripts or workflows. Learn more about how to remove 

your add-in here 

 

Confirm your current version 
Before you upgrade to Crime Analysis version 2020.12.17 or later you will need to confirm the 

version you have currently installed. 

To verify the version currently installed use the following steps: 
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1. Open any ArcGIS Pro project and click the Project tab on the ribbon. Alternatively, on the 
ArcGIS Pro start page, click Settings in the lower left corner. 

2. Click Add-In Manager then click on Crime Analysis. 

3. In the Add-Ins tab of the Add-In Manager. The Add-Ins tab will provide the version 
information. 

  If your version is 2018.6.26 through 2019.10.16 then you will also need to consider 
migrating your scripts and workflows using the Migrate workflows from previous version 
section. 

 

Install new Crime Analysis add-in 
To upgrade from a previous version of the Crime Analysis add-in that is installed on your 

computer, you will need to follow the steps below to overwrite the installed add-in with the new 

add-in. 

1. Close all ArcGIS Pro applications. 

2. Browse to the CrimeAnalysis folder 

3. Double-click CrimeAnalysis.esriAddInX to run the installer. 

4. Click the Install Add-In button. 

5. Open ArcGIS Pro. 

 

Migrate workflows from previous version 
Crime Analysis add-in (2020.12.17) has a significant number of updates. Specifically, several 

geoprocessing tools have been replaced, new tools have been added, and the solution user 

interface has changed. Review the changes below before migrating your workflows from a 

previous version. 

 

User interface updates 
The Crime Analysis ribbon now uses the analysis tool gallery interface design to organize all 

analytical geoprocessing tools in the solution. Within the gallery area, the tools retain their 

groupings (for example, tactical and strategic analysis) from previous version of the solution. 

The new ribbon design allows more space-efficient presentation of additional analytical tools on 

the Crime Analysis solution ribbon. 

 

Geoprocessing tool updates 
Many of the customized geoprocessing tools originally deployed with Crime Analysis solution 

have been updated to use system tools that are installed with ArcGIS Pro.  These tools can now 

be found in the Crime Analysis and Safety toolbox in the geoprocessing pane, and are available 

to all users of ArcGIS Pro. As part of that process, the names and functions of tools have 
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changed slightly to conform to ArcGIS Pro standards. In addition, several new system tools that 

are relevant to crime analysis workflows have been added to the solution. 

 

Crime Analysis tool updates 
The chart below outlines the names of the original tools available with the Crime Analysis add-in 

version 2018.6.26 through 2019.10.16, that have been migrated to new tools in version 

2020.12.17, and available in the updated Crime Analysis add-in. 

Old Tool New Tool  New Tool Changes 

80-20 Analysis 80-20 Analysis (Crime 

Analysis and Safety toolbox) 

Labeling is no longer applied by 

default. 

The parameter minimum cluster 

size is no longer configurable. 

The parameter attributes to 

preserve is replaced by output 

fields in the new tool. 

Extract Date Parts to 

Field 

Add Date Attributes (Crime 

Analysis and Safety toolbox) 

Updated and simplified parameters. 

Import Cell Records Cell Phone Records to 

Feature Class (Crime 

Analysis and Safety toolbox) 

Updated and simplified parameters. 

Import Cell Sites Cell Site Records to Feature 

Class (Crime Analysis and 

Safety toolbox) 

Updated and simplified parameters. 

Features To 3D By 

Time 

Feature to 3D By Time (Crime 

Analysis and Safety toolbox) 

The tool licensing requires ArcGIS 

Desktop Basic, Standard, or 

Advanced license. The 3D Analyst 

licensing has been removed. 

Space Time 

Comparison 

Find Space Time Matches 

(Crime Analysis and Safety 

toolbox) 

Labeling is no longer applied by 

default. 

Updated and simplified parameters. 

Repeat Call Patterns Generate Call Links (Crime 

Analysis and Safety toolbox) 

Labeling is no longer applied by 

default. 

Updated and simplified parameters. 

Incident Path Generate Origin Destination 

Link (Analysis toolbox) 

Updated and simplified parameters. 

Different default symbology. 
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Descriptive Statistics Charts are 

automatically created. 

Generate Sector Lines Generate Sector Links (Crime 

Analysis and Safety toolbox) 

Updated parameter names. 

Append Attributes 

From Polygon 

Join Attributes from a Polygon 

(Crime Analysis and Safety 

toolbox) 

Updated and simplified parameters. 

The overwrite matching fields in 

Target Point Features parameter is 

no longer available. 

Density Change Minus (Spatial Analyst 

Toolbox) 

The Minus tool is part of the Spatial 

Analyst toolbox requires a Spatial 

Analyst license and applies a 

different default symbology. 

Incident Sequence Points to Track 

Segments (Intelligence 

Toolbox) 

Updated and simplified parameters. 

Output features are time enabled by 

default. 

Sequence points are no longer 

created default. Output sequence 

points location is an optional 

parameter. 

The Grouping Field parameter has 

been renamed to Group Field. 

Select by Date and 

Time 

Select Layer by Date and 

Time (Crime Analysis and 

Safety toolbox) 

Updated and simplified parameters. 

Incident Count Summarize Incident Count 

(Crime Analysis and Safety 

toolbox) 

Added support for point in the Input 

Features parameter 

Labeling is no longer applied by 

default. 

The Category Field parameter has 

been renamed to Group Field and 

now requires an ArcGIS Desktop 

Basic license. 

The tool licensing requires ArcGIS 

Desktop Basic, Standard, or 

Advanced license. Parameter 

specific licensing has been 

removed. 
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Percent Change Summarize Percent Change 

(Crime Analysis and Safety 

toolbox) 

Added support for point features in 

the Input Features parameter. 

Labeling is no longer applied by 

default. 

The tool licensing requires ArcGIS 

Desktop Basic, Standard, or 

Advanced license. Parameter 

specific licensing has been 

removed. 

Configure Record 

Import (Addresses), 

Configure Record 

Import (XY), Import 

Records 

Update 

Features With Incident 

Records (Crime Analysis and 

Safety toolbox) 

The Update Features With Incident 

Records includes all of the 

functionality of the Configure 

Record Import (Addresses), 

Configure Record Import (XY), and 

Import Records tools. 

Note: The Export Near Repeat Calculator Table tool, Repeat and Near Repeat Classification 

tool, and Calculate Prediction Zones tool have not changed and are installed as part of the 

Crime Analysis add-in and have not been migrated into ArcGIS Pro. 

 

Automate Geoprocessing Tools (optional) 
All geoprocessing tools can be scheduled to run automatically on your computer using the 

scheduling capabilities in ArcGIS Pro or Windows Task Scheduler. Scheduling frequently run 

tools can improve productivity by reducing manual steps the analyst has to take during their 

daily work or in creating routine products. For example, by scheduling the Update Features With 

Incident Records tool to run nightly, their main datasets can get geocoded and updated into a 

web layer overnight, so the analyst has fresh data ready to use when they arrive in to work. 

Likewise, for analysts preparing monthly Compstat reports, Kernel Density or other hotspot tools 

can be automated to run on a monthly schedule to simplify the process of preparing the 

Compstat report. 

 

Disable the Crime Analysis ribbon 
The Crime Analysis ribbon is automatically added to your projects when you install the Crime 

Analysis add-in. To disable the Crime Analysis ribbon, follow these steps. 

1. From an open project, click the Project tab on the ribbon. Alternatively, on the ArcGIS Pro 
start page, click Settings in the lower left corner. 

2. Click Options then click on Crime Analysis. 

3. Disable the Show Crime Analysis tab, click OK and the back arrow. 

When the Crime Analysis ribbon is disabled it will no longer appear in ArcGIS Pro, but the tools 

will appear contextually in various locations throughout the ArcGIS Pro user interface. For 
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example, on the Analysis ribbon, users will see a Crime Analysis button listing all the solution 

tools. 

Note: 

Learn more about how to remove an add-in. 
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Use Crime Analysis 
The Crime Analysis solution delivers a set of capabilities to help you manage incident data, 

conduct tactical and strategic analysis, perform investigative analysis and share web-based or 

hardcopy information products with decision-makers. 

In this topic, you’ll learn how to use the Crime Analysis solution by exploring the Crime Analysis 

ArcGIS Pro project and key crime analysis workflows it supports. 

 

Review the Crime Analysis project 
Crime Analysis includes an ArcGIS Pro project with the Crime Analysis add-In. The project 

includes the Crime Analysis tab and ribbon that can be used to conduct a series of key 

analytical functions to support crime analysis. Before using the Crime Analysis tools with your 

data, familiarize yourself with the contents of the Crime Analysis project. 

1. Browse to the CrimeAnalysis folder and open the CrimeAnalysisSolution.aprx ArcGIS Pro 
project. 

2. On the ribbon, click the Crime Analysis tab. You will see the ribbon includes five groups of 
tools: Data Management, Selection, Analysis Tools and Information Products. 

3. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

4. In the Catalog pane, expand Maps and review the sample maps and notes provided. 

 

Manage incident data 
To perform analysis, crime analysts must first import data from disparate record systems and 

prepare it for use in GIS. Data import and management activities like geocoding, date field 

transformations, and appending of spatial data must be performed daily. These time consuming 

but necessary activities leave little time for actual analysis, limiting analyst productivity. Crime 

Analysis provides tools to help analysts automate data import and simplify common data 

management activities. 

To learn more about managing data using Crime Analysis, go to the CrimeAnalysisSolution 

ArcGIS Pro project and open the following maps: 

•  Enhance Attributes map 

• Import Incidents (Update Features With Incident Records) 

 

Focus on specific incidents 
Crime analysts ask a wide variety of analytical questions on behalf of the organizations they 

support, requiring them to query their data from a variety of date-based, spatial, and field 

attribute perspectives that can be challenging to perform without the use of GIS. Crime Analysis 

provides selection tools that can be used individually or in tandem to interrogate incident data 

and focus on specific problem subsets. 
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To learn more about performing selections using Crime Analysis, go to the 

CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

• Summarize Percent Change and Select Layer by Date and Time 

• Kernel Density and Minus 

 

Conduct tactical and strategic analysis 
Crime analysts support the data-driven crime reduction efforts of law enforcement agencies by 

using tactical analysis methods to identify short-term crime patterns, and strategic analysis 

methods to support the identification and evaluation of long-term crime problems and trends. 

Central to these methods are spatial analysis, specifically hotspot identification, but analysts can 

be challenged with understanding which techniques are available and are appropriate to the 

type of analysis they are trying to perform. Crime Analysis curates new and traditional spatial 

analysis tools appropriate for tactical and strategic crime analysis, making it easy for analysts to 

discover the right tool for the job. 

To learn more about conducting tactical and strategic analysis using Crime Analysis, go to the 

CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

• 80-20 Analysis 

• Colocation Analysis 

• Density-based Clustering 

• Kernel Density and Minus 

• Optimized Hotspot and Calendar Heat Chart 

• Summarize Incident Count 

• Summarize Percent Change and Select Layer by Date and Time 

•  RNR-Calculate Prediction Zones 

• RNR-Export Near Repeat Calculator Table 

• RNR-Repeat and Near Repeat Classification 2D 

• RNR-Repeat and Near Repeat Classification 3D 

 

Perform investigative analysis 
Crime analysts support investigations by using data to explore the relationships between 

people, events, and locations. Investigative analysis helps investigators uncover criminal 

networks and understand suspect activity patterns through analysis of cell phone records, 

financial transactions, and other investigative data sources. These forms of analysis have 

previously required specialized, expensive, single-purpose software programs. Crime Analysis 

provides a set of analytical tools to support common investigative workflows such as cell phone 

analysis, financial analysis, temporal sequencing of GPS or incident data, and visualizing spatial 

relationships such as between locations of motor vehicle thefts with where those vehicles are 

recovered. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 89 

To learn more about performing investigative analysis using Crime Analysis, go to the 

CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

• CPA-2D Cell Phone Points to Track Segments 

• CPA-3D Cell Phone Points to Track Segments 

• CPA-Cell Site Records to Feature Class 

• CPA-Cell Phone Records to Feature Class 

• CPA-Dissolve 

• CPA-Find Space Time Matches 

• CPA- Generate Call Links 

• CPA-Generate Sector Lines 

• Origin Destination Links (MV Theft to Recovery) 

• Origin Destination Links (Financial Crime) 

• Origin Destination Links and Link Chart (Gang Turf to Member Homes) 

• Points to Track Segments 

 

Share maps and reports 
To share their work with stakeholders and decision makers, crime analysts prepare information 

products summarizing their results. Analysts get requests to deliver these products in both 

hardcopy and interactive forms. To support the needs of their customers, analysts need flexible 

options to deliver the results of their analysis in a wide array of forms. Crime Analysis provides a 

set of information product options include hardcopy map layouts, a rich charting library, tabular 

reports, link analysis charts, and the ability to publish layers and maps into web mapping 

applications in ArcGIS Enterprise or ArcGIS Online. 

To learn more about sharing maps and reports using Crime Analysis, go to the 

CrimeAnalysisSolution ArcGIS Pro project and open the following maps: 

• Optimized Hotspot and Calendar Heat Chart 

• Origin Destination Links and Link Chart (Gang Turf to Member Homes) 
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Crime Analysis Tool Reference 
The Crime Analysis solution delivers a set of capabilities to help you manage and query incident 

data, conduct tactical, strategic, and investigative analysis, and share web-based and hardcopy 

information products with decision-makers. 

In this topic, you’ll learn how to use the Crime Analysis solution by exploring the Crime Analysis 

navigating the Crime Analysis Add-In, and reviewing the Repeat and Near Repeat tools. 

 

Crime Analysis tools 
The Crime Analysis Solution contains many tools to support key analytical functions to manage 

data, select crime incidents, conduct tactical and strategic analysis, investigate crime patterns 

and share information with other law enforcement personnel. These tools are accessed using 

the Crime Analysis tab and ribbon which is automatically added to your projects when you install 

the Crime Analysis add-in. The following sections contain a list of the tool groups in the ribbon 

with details for each tool in chronological order according to a typical crime analysis process. 

Note: You will need to ensure the Crime Analysis add-in is installed before you can review the 

Crime Analysis tools. See Configure Crime Analysis for more information. 

 

Data Management tools 
Crime Analysts can import data from disparate record systems in order to perform spatial 

analysis using ArcGIS Pro. In many cases, the data must also be geocoded and prepared for 

analysis by appending information about police operational boundaries, transforming date 

values, or other transformation functions. The Data Management group includes a series of 

tools that can be used for manual or automatic data import, geocoding, and enhancing of data 

for use in crime mapping and spatial analysis. 

The following tools and commands are included in the Data Management group of the Crime 

Analysis ribbon. 

Name  Description  

Add Data An ArcGIS Pro menu command that references data management tools 

that adds data to the map. 

Add Graphics 

Layer 

An ArcGIS Pro menu command that provides a way to include simple 

notations on a map or layout that highlight particular areas or label places. 

Import Records An ArcGIS Pro Crime Analysis and Safety toolbox that converts a 

nonspatial table to point features based on x,y-coordinates or street 

addresses and updates an existing dataset with the new or updated record 

information from the table. 

Convert Time 

Field 

An ArcGIS Pro Data Management tool that converts time values stored in a 

string or numeric field to a date field. 
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Feature To 3D 

By Time 

An ArcGIS Pro Crime Analysis and Safety toolbox that creates a 3D feature 

class using date values from input features. 

Convert 

Coordinate 

Notation 

An ArcGIS Pro Data Management tool that converts coordinate notations 

contained on one or two fields from one notation format to another. 

Add Date 

Attributes 

An ArcGIS Pro Crime Analysis and Safety toolbox that adds fields 

containing date or time properties from an input date field, for example, day 

full name, day of the month, month, and year. 

Join Attributes 

From Polygon 

An ArcGIS Pro Crime Analysis and Safety toolbox that joins attributes from 

input polygon features to input point features. 

Enrich An ArcGIS Pro Analysis tool that enriches data by adding demographic and 

landscape facts about the people and places that surround or are inside 

data locations. 

 

Selection 
Before applying spatial analysis methods, crime analysts use queries to select subsets of data 

related to their topic of analysis. The Selection group in the ribbon includes a series of tools to 

perform spatial, temporal, or location-based queries of your data. 

The following tools and commands are included in the Selection group of the Crime Analysis 

ribbon. 

Name  Description  

Explore An ArcGIS Pro command that allows you to explore maps and scenes, you 

can zoom in and out, move around, and in the case of scenes, move up, 

down, and look around. 

Select An ArcGIS Pro commands that provide interactive feature selection 

involves clicking a single feature in the view or digitizing a shape to select 

a set of features. 

Select By 

Attributes 

An ArcGIS Pro Data Management tool that adds, updates, or removes a 

selection on a layer or table view based on an attribute query. 

Select By 

Location 

An ArcGIS Pro Data Management tool that selects features in a layer 

based on a spatial relationship to features in another dataset. 

Select Layer By 

Date and Time 

An ArcGIS Pro Crime Analysis and Safety toolbox used to select records 

based on date and time ranges or date properties, for example, single 

date, time range, time period, days of the week, month, or year. 

Attributes An ArcGIS Pro command that displays the Attribute pane. 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/feature-to-3d-by-time.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/feature-to-3d-by-time.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/data-management/convert-coordinate-notation.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/data-management/convert-coordinate-notation.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/data-management/convert-coordinate-notation.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/add-date-attributes.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/add-date-attributes.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/join-attributes-from-polygon.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/join-attributes-from-polygon.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/analysis/enrich.htm
https://pro.arcgis.com/en/pro-app/2.7/help/mapping/navigation/navigation-in-arcgis-pro.htm#ESRI_SECTION1_C81B1D7778DB48779AA20D5802CB3A2D
https://pro.arcgis.com/en/pro-app/2.7/help/mapping/navigation/select-features-interactively.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/data-management/select-layer-by-attribute.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/data-management/select-layer-by-attribute.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/data-management/select-layer-by-location.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/data-management/select-layer-by-location.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/select-layer-by-date-and-time.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/select-layer-by-date-and-time.htm


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 92 

Clear An ArcGIS Pro command that clears the current selection in the active 

map. 

Layer From 

Selection 

An ArcGIS Pro command that creates on new layer based on a selected 

set of features in an existing layer. 

 

Analysis Tools 
Crime Analysts perform many types of analyses to support the needs of law enforcement 

decision-makers in their organization. The Analysis Tools group includes a gallery of tools that 

can be used to perform a variety of hotspot detection techniques and other spatial methods that 

can be applied as part of tactical or strategic crime analysis projects. The gallery also includes 

tools to apply spatial methods in support of investigations, like cell phone analysis, crime series 

sequencing, or motor vehicle theft to recovery linking. 

The following tools and commands are included in the Analysis Tools group of the Crime 

Analysis ribbon. 

Name  Description  

Summary 

Statistics 

An ArcGIS Pro Analysis tool that calculates summary statistics for field(s) 

in a table. 

Buffer An ArcGIS Pro Analysis tool that creates buffer polygons around input 

features to a specified distance. 

80-20 Analysis An ArcGIS Pro Crime Analysis and Safety toolbox used to conduct an 

80/20 analysis of features and determines cluster locations by creating a 

graduated symbol layer based on the number of incidents occurring at 

each location. 

Summarize 

Incident Count 

An ArcGIS Pro Crime Analysis and Safety toolbox used to create a 

feature class with coincident point counts. Coincident point counts for line 

and point features are determined by a specified maximum distance. 

Point counts for polygon features are determine by whether point 

features or portions of features overlap with the polygon feature. 

Summarize 

Percent Change 

An ArcGIS Pro Crime Analysis and Safety toolbox used to calculate the 

percent change for features that correspond with point features 

representing two equal comparison time periods. 

Optimized 

Hotspot 

An ArcGIS Pro Spatial Statistics tool that creates a map of statistically 

significant hot and cold spots using the Getis-Ord Gi* statistic. 

Kernel Density An ArcGIS Pro Spatial Analyst tool that calculates a magnitude-per-unit 

area from point or polyline features using a kernel function to fit a 

smoothly tapered surface to each point or polyline. This tool requires a 

Spatial Analyst license. 
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Minus An ArcGIS Pro Spatial Analyst tool that subtracts the value of the second 

input raster from the value of the first input raster on a cell-by-cell basis. 

Create Space 

Time Cube 

An ArcGIS Pro Space Time Pattern Mining tool that summarizes a set of 

points into a netCDF data structure by aggregating them into space-time 

bins. 

Emerging Hot 

Spot 

An ArcGIS Pro Space Time Pattern Mining tool that identifies trends in 

the clustering of point densities. 

Colocation 

Analysis 

An ArcGIS Pro Spatial Statistics tool that measures local patterns of 

spatial association, or colocation, between two categories of point 

features using the colocation quotient statistic. 

Density-based 

Clustering 

An ArcGIS Pro Spatial Statistics tool that finds clusters of point features 

within surrounding noise based on their spatial distribution. 

Points To Tracks 

Segments 

An ArcGIS Pro Spatial Statistics tool that converts a series of output 

paths from time-enabled sequences of input point data, such as GPS 

points. 

Generate Origin-

Destination Links 

An ArcGIS Pro Spatial Statistics tool that generates connecting lines 

from origin features to destination features. This is often referred to as a 

spider diagram. 

Cell Site Records 

to Feature Class 

An ArcGIS Pro Crime Analysis and safety tool used to creates cell site 

points and sector polygons based on input latitude, longitude, azimuth, 

beamwidth, and radius information from a cell site table. 

Cell Phone 

Records to 

Feature Class 

An ArcGIS Pro Crime Analysis and Safety toolbox used to imports cell 

phone records from wireless network providers and associates those 

records with a cell site and sector feature classes as generated by the 

Cell Site Records To Feature Class tool based on identifier fields. 

Generate Call 

Links 

An ArcGIS Pro Crime Analysis and Safety toolbox used to creates line 

features that represent the call links between phones, using cell site 

points or cell site antenna sectors, based on the start date and time of 

the call. 

Find Space Time 

Matches 

An ArcGIS Pro Crime Analysis and Safety toolbox that identifies matches 

between two feature classes based on proximity, time extent, or both. 

Generate Sector 

Lines 

An ArcGIS Pro Crime Analysis and Safety toolbox used to create line 

features that represent the extent of cell site antenna sectors. 

Dissolve An ArcGIS Pro Data Management tool aggregates features based on 

specified attributes. 

Export Near 

Repeat Calculator 

Table 

A Repeat and Near Repeat tool that creates a CSV file in the format 

required by the Near Repeat Calculator from an input feature class. The 

Near Repeat Calculator is a tool published by Temple University for 
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examining the statistical significance of repeat and near repeat patterns 

in a dataset. 

Repeat and Near 

Repeat 

Classification 

A Repeat and Near Repeat tool that identify areas at risk of repeat and 

near repeat incidents by specifying the spatial and temporal range of 

influence of past incidents. 

Calculate 

Prediction Zones 

A Repeat and Near Repeat tool that identify areas at risk of repeat and 

near repeat incidents by specifying the spatial and temporal range of 

influence of past incidents. 

 

Information Products  
After the analysis is complete, Crime Analysts often prepare hard copy maps and web-based 

information products to help their organizations make data-driven decisions. The Information 

Products group includes a series of tools to create information products for analysis consumers, 

including link charts, hard-copy maps, charts, and reports, and publishing of maps and layers to 

organizational web GIS portals. 

The following tools and commands are included in the Information Products group of the Crime 

Analysis ribbon. 

Name  Description  

Create 

Chart 

An ArcGIS Pro command that creates a chart to visualize categories, 

distribution, change and relationships in your data. 

New Link 

Chart  

An ArcGIS Pro command used to generate a link chart to visualize relationships 

between entities in your data and is a complementary view to the map. 

New 

Report  

An ArcGIS Pro command used to generate a report to share a well-formatted, 

multipage representation of your data. A report can contain a tabular list of 

attributes, summary information, or both. 

New 

Layout 

An ArcGIS Pro command that creates a new layout and add it to the project. 

Web Map An ArcGIS Pro command used to share the active map as a web map to your 

organization. 

Web 

Layer 

An ArcGIS Pro command used to share all data layers in the active map as a 

new web layer to your organization. 

 

Repeat and Near Repeat Analysis Tools 
Repeat Victimization is an empirically observed phenomenon where when a location becomes 

the victim of a specific type of crime, that location has an elevated risk of subsequent 

victimization, a risk which drops precipitously over time. A corollary phenomena is known as 

Near-Repeat Victimization, whereby locations immediately around a location that has been 
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victimized are at elevated risk, a level that drops both as time passes, and as the distance from 

the originating victim increases. Repeat and Near Repeat patterns have been observed across 

a wide variety of crime types, are believed to be spatial artifacts of serial offending behaviors, 

and thus have important implications for crime prevention and investigations. 

The Crime Analysis solution includes three custom geoprocessing tools to support analyses 

relative to Repeat and Near Repeat Victimization patterns. The Export Near Repeat Calculator 

Table tool can be used with Temple University’s Near Repeat Calculator to identify statistically 

significant patterns of Repeat and Near Repeat Victimization. The Near Repeat Classification 

tool can be used to identify historical patterns of repeat and near-repeat victimization, which can 

support investigative efforts to connect and clear cases that were not otherwise known to be 

part of a pattern. The Calculate Prediction Zones tool can be used to generate daily tactical 

crime risk predictions based on Repeat Victimization and Near-Repeat Victimization risk for 

recent crime locations. These risk predictions can be used to inform police operational 

strategies for crime reduction. 

The tools in the Crime Analysis solution related to Repeat and Near Repeat Victimization 

(Export Near Repeat Calculator Table, Repeat and Near Repeat Classification, and Calculate 

Prediction Zones) were developed in cooperation with Spencer Chainey, Ph.D., Associate 

Professor in Security and Crime Science at the Jill Dando Institute of Security and Crime 

Science, University College London. 

 

Export Near Repeat Calculator Table Tool 
The Near Repeat Calculator is a tool published by Temple University for examining the 

statistical significance of repeat and near repeat patterns in a dataset. When a statistically 

significant repeat or near repeat pattern is found, the spatial and temporal bandwidths of the 

pattern can then be used as parameters for analyses involving the Repeat and Near Repeat 

Classification Tool and the Calculate Prediction Zones tool. of This tool creates a comma-

separated values (CSV) file in the format required by the Near Repeat Calculator from an input 

feature class. 

 

Usage 

• Input features must have a date field. 

• The output comma-separated values (CSV) file does not contain any field headers as 
these are not supported by the Near Repeat Calculator. The output fields are, in order: X, 
Y, Date. 

 

Syntax 

ExportNearRepeatCalculatorTable_crime (Input_Feature_Class, Output_Table, Date_Field) 

Parameter  Explanation 

Data 

Type  
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Output 

Table 

Specify the path and file name of output comma-separated values 

(CSV) file. 

File 

Date Field The field in the input feature class containing the date on which each 

incident occurred. If the date of the incident spans a range (for 

example, date information is recorded in two fields representing the 

from and to dates), choose the date field you consider to be most 

appropriate. This will usually be the date at the beginning of the date 

range. 

Field 

 

Licensing information: 

• ArcGIS Desktop Basic: Yes 

• ArcGIS Desktop Standard: Yes 

• ArcGIS Advanced: Yes 

 

Repeat and Near Repeat Classification tool 
Use a series of distance and time values to classify incidents as originators, repeats, or near-

repeats, and to identify potential spatial and temporal relationships between incidents. 

 

Usage 

• The Input Features must be a point feature class or shape file with a date field, 
representing the locations of incidents. 

• The tool will use all points with date values. Incidents without valid dates will be excluded 
and a warning message will print to the screen listing the skipped incidents. 

• This tool will honor a selected set of features. When the Input Features contain a selection, 
only the selected features will be considered when classifying features and building 
connections. 

• Incidents are classified as O (Originator), NR (near-repeat), or R (repeat) according to their 
proximity to each other in space and time using each combination of the specified spatial 
and temporal band values, and the specified repeat distance. 

• Incidents are classified as originators if they are the originator of at least one other incident 
and have no preceding incidents within the current spatial and temporal ranges. 

• Incidents are classified as near-repeat incidents when they follow a previous repeat, near-
repeat, or originating incident within the current spatial and temporal ranges, and do not 
meet the criteria to be classified as a repeat incident. 

• Incidents are classified as repeat incidents when they occur within the specified repeat 
distance and the current temporal range. An incident that meets the requirements for both 
a repeat and a near-repeat incident is classified as a repeat. 

• Incidents that do not meet the criteria for any of the above are left unclassified. 

• This tool creates the following three outputs: 
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– A copy of the input incident features with classification fields added. These fields 
are populated with the classification values for each incident within each set to 
spatial and temporal ranges. For example, if a repeat distance of 1 map unit (Feet), 
spatial bands of 100 and 200 map units (Feet), and temporal bands of 7 and 14 
days are specified, the tool will append 6 fields with the following field names and 
aliases: 

• sb0tb1 (1 ft / 7 Days): Classification of incidents that are originators of 
repeat incidents occurring no more than 7 days later, and incidents that 
occurred within the repeat distance and 7 days of a previous incident. 

• sb0tb1 (1 ft / 14 Days): Classification of incidents that are originators of 
repeat incidents occurring no more than 14 days later, and incidents that 
occurred within the repeat distance and 14 days of a previous incident. 

• sb1tb1 (100 ft / 7 Days): Classification of incidents that are originators of 
repeat and near-repeat incidents occurring no more than 7 days later, and 
incidents that occurred within 100 map units and 7 days of a previous 
incident. 

• sb1tb2 (100 ft / 14 Days): Classification of incidents that are originators of 
repeat and near-repeat incidents occurring no more than 14 days later, and 
incidents that occurred within 100 map units and 14 days of a previous 
incident. 

• sb2tb1 (200 ft / 7 Days): Classification of incidents that are originators of 
repeat and near-repeat incidents occurring no more than 7 days later, and 
incidents that occurred within 200 map units and 7 days of a previous 
incident. 

• sb2tb2 (200 ft / 14 Days): Classification of incidents that are originators of 
repeat and near-repeat incidents occurring no more than 14 days later, and 
incidents that occurred within 200 map units and 14 days of a previous 
incident. 

• The tool also appends a field called ZVALUE with values representing the 
number of days between each incident and the smallest date value in the 
dataset. These values can be used to visualize the time sequence of 
incidents in ArcGIS Pro so that oldest incidents appear near the ground and 
more recent incidents appear further from the ground. 

– A line feature class that is populated with z-enabled line features representing the 
potential relationships between repeat and near-repeat incidents and their 
originators. The z values for each vertex correspond to the ZVALUE field value for 
the incident that occurs at that vertex. 

– A comma-separated values (CSV) file summary report with the number of incidents 
processed, the counts and proportions of incidents that fall within each spatial and 
temporal band combination, and the estimated half-life and half-distance values 
which can be used as inputs for the Calculate Prediction Zones tool. 

• All distances are calculated using geodesic measurements. 
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Syntax 

RepeatNearRepeatClassification_crime (Input_Feature_Class, Output_Incident_Points, 

Output_Incident_Connection_Lines, Output_Summary_Report_Location, Date_Field, 

Repeat_Incident_Distance, Spatial_Bands, Temporal_Bands) 

 

Parameter  Explanation Data Type  

Input Feature 

Class 

Feature class containing points representing the location of 

incidents to classify. The data contained in the features class 

will typically cover a long time period (e.g., one year). The 

feature class must have a date field (in date format) and all 

features must have date values. 

Feature 

Layer 

Output 

Incident 

Points 

Output feature class containing calculated classification 

values. 

Feature 

Layer or 

Feature 

Class 

Output 

Summary 

Report 

Location 

The results from the analysis of repeats and near repeats will 

be written into a Summary report (csv file format) for review. 

The report can be found in this folder after the tool has 

completed successfully. The results are also written to the 

Messages section of the Results window. 

Folder 

Date Field The field in the input feature class containing the date on which 

each incident occurred. If the date of the incident spans a 

range (e.g., date information is recorded in two fields 

representing the from and to dates), choose the date field you 

consider to be most appropriate. This will usually be the date 

at the beginning of the date range. Values in the date field are 

used to calculate the number of days between each incident. 

Field 

Repeat 

Incident 

Distance 

Maximum distance in the units of the input feature class where 

adjacent incidents are considered repeats rather than near 

repeats. A value of 0 is exact to the accuracy of the coordinate 

system. If the geocoding of the input feature class is likely to 

very slightly vary it is recommended this value is set to 1 (i.e., 

incidents will be classified as repeats if the distance between 

them is less than or equal to 1 map unit). 

Double 

Spatial Bands Distance in the units of the input feature class to classify near 

incidents. Multiple bands can be entered. For example, bands 

of 200m and 400m will classify features that are located up to 

and including 200m from a previous incident, and up to and 

including 400m of a previous incident. 

Multiple 

Value 

Temporal 

Bands 

Number of days to classify near incidents. Multiple bands can 

be entered. For example, bands of 7, 14 and 21 days will 

Multiple 

Value 
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classify features that took place up to and including 7 days, 14 

days, and 21 days of a previous incident. 

 

Licensing information: 

• ArcGIS Desktop Basic: No 

• ArcGIS Desktop Standard: No 

• ArcGIS Advanced: Yes 

 

Calculate Prediction Zones tool 
Identify areas at risk of repeat and near repeat incidents by specifying the spatial and temporal 

range of influence of past incidents. 

 

Usage 

• The Input Features must be a point feature class or shape file with a date field, 
representing the locations of incidents. 

• The tool will use all points with date values in the Temporal Range of Influence preceding 
the Initial Processing Date. Features with date values outside this range and features with 
null or invalid date values will not be processed. 

• This tool will honor a selected set of features. When the Input Features contain a selection, 
only the selected features will be considered when building the prediction zones. 

• Incidents that occur closer in time to the Initial Processing Date will have more influence 
over the prediction zones than older incidents. Areas nearer to incidents will be considered 
to have a greater risk of future incidents, up to the Spatial Range of Influence. Use the 
Spatial Half Distance and Temporal Half Life parameters to modify the rate of decay of 
influence. 

• The following fields are populated in the output feature class: 

– CREATEDATE: Text field populated with the date and time the features are 
created. 

– STARTDATE: The Initial Processing Date, or the calculated date if TODAY or 
YESTERDAY is the input value. 

– TIMEBAND: The Temporal Range of Influence used to generate the features. 

– SPACEBAND: The Spatial Range of Influence used to generate the features. 

– RISKRANGE: The classification of risk for the area defined by that polygon. Higher 
values have a higher level of risk ang lower values have a lower value of risk based 
on the location and dates of nearby incidents. 

• This tool creates up to two outputs: 

– A raster representation of the levels of risk over the area covered by the incidents. 

– Polygons generated by binning the raster values into a number of Risk Ranges are 
appended to the Output Prediction Zones Feature Class as described above. 
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• While storing the output raster in a geodatabase is supported, it is recommended to store 
the raster in a folder rather than a geodatabase, especially if this tool will be run as a 
scheduled task. 

• All distances are calculated using geodesic measurements. 

• This tool requires the Spatial Analyst extension. 

 

Syntax 

CalculatePredictionZones_crime (Input_Features, Output_Prediction_Zones_Raster, 

Output_Prediction_Zones_Feature_Class, Date_Field, Initial_Processing_Date, 

Spatial_Range_of_Influence, Spatial_Half_Distance, Temporal_Range_of_Influence, 

Temporal_Half_Life, Risk_Calculation_Method, Number_of_Risk_Ranges) 

Parameter  Explanation Data Type  

Input Features Feature class containing points representing the location of 

incidents and from which prediction zones will be calculated. 

The feature class must have a date field (in date format) and 

all features must have date values. 

Feature 

Layer 

Point Join 

Features 

Point features coincident with the input polygon or line 

features. 

Feature 

Layer 

Output 

Prediction 

Zones Raster 

Output prediction zone raster. Raster 

Layer 

Output 

Prediction 

Zones Feature 

Class 

Output feature class with polygons representing the prediction 

zones. 

Feature 

Class or 

Feature 

Layer 

Date Field The field in the input feature class containing the date on 

which each incident occurred. If the date of the incident spans 

a range (for example, date information is recorded in two 

fields representing the from and to dates), choose the date 

field you consider to be most appropriate. This will usually be 

the date at the beginning of the date range. Values in the date 

field are used to calculate the level of future risk based on a 

combination of when the incident occurred, the Initial 

Processing Date and the temporal decay in risk (determined 

from the Temporal Range of Influence and the Temporal Half 

Life). 

Field 

Initial 

Processing 

Date 

The date to use from the Input Feature Class for creating the 

prediction zones. 

Date 
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Spatial Range 

of Influence 

This value determines the size of the prediction zones around 

each incident (in the units of the coordinate system of the 

Input Feature Class). The value refers to the maximum 

distance from an incident that the incident is estimated to have 

on influencing the risk of future incidents taking place. 

Additionally, this value can be based on the area around an 

incident that is considered to be practical for resource 

targeting and deployment (for example, the area to which 

additional patrols are targeted). 

Double 

Spatial Half 

Distance 

The distance from an incident at which the risk is estimated to 

be half that of another incident taking place (a near-repeat). 

This value is used to calculate the exponential rate of decay in 

the spatial risk of a near-repeat incident and must be lower 

than the value for the Spatial Range of Influence. Distance 

units are the units of the coordinate system of the input 

feature class. A useful initial value to apply is half the value of 

the Spatial Range of Influence. 

Double 

Temporal 

Range of 

Influence 

This value refers to the number of days before the Initial 

Processing Date that incidents are estimated to have an 

influence on the risk of future incidents taking place. More 

recent incidents have the greatest level of influence on future 

risk. Incidents that took place between the Initial Processing 

Date and the value for the Temporal Range of Influence are 

used for creating prediction zones. For example, if this value 

was set to 3, only incidents for the Initial Processing Date and 

the two days prior would be used for creating prediction 

zones. Incidents that took place 3 days ago would have less 

of an influence on the risk of future incidents than those that 

took place on the Initial Processing Date. 

Double 

Temporal Half 

Life 

The number of days before the Initial Processing Date on 

which the risk is estimated to be half that of further incidents 

taking place immediately after the Initial Processing Date (for 

example, incidents that took place on the Initial Processing 

Date are considered to have the greatest influence on the risk 

of future incidents taking place. Incidents before the Initial 

Processing Date have less of an influence on future risk). This 

value is used to calculate the exponential rate of decay in the 

temporal risk of a repeat and near-repeat incident and must 

be lower than the value for the Temporal Range of Influence. 

A useful initial value to apply is half the value of the Temporal 

Range of Influence. 

Double 

Risk 

Calculation 

Method 

Choose the method for calculating the predictive risk. String 
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'CUMULATIVE' (default) creates prediction zones where the 

value of each cell is the sum of any prediction zone cells that 

overlap. 

'MAXIMUM' creates prediction zones where the value of each 

cell is the maximum value of any prediction zone cells that 

overlap 

Number of 

Risk Ranges 

Integer value representing the number of ranges that will be 

used in the polygon version of the output for representing the 

variation in predicted risk (for example, if this value was set to 

2, two Risk Ranges would determine areas of primary risk 

from areas of secondary risk). 

Long 

 

Licensing information: 

• ArcGIS Desktop Basic: Requires Spatial Analyst 

• ArcGIS Desktop Standard: Requires Spatial Analyst 

• ArcGIS Advanced: Requires Spatial Analyst 
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Daily Activity Dashboard 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Daily Activity Dashboard 
Daily Activity Dashboard can be used to visualize calls for service and incidents sourced from 

computer-aided dispatch or records management systems and monitor daily activity. 

The solution improves operational awareness for supervisors in law enforcement agencies and 

allows them to rapidly identify emerging incident patterns and diagnose response problems. The 

increased operational awareness helps command staff allocate law enforcement resources and 

monitor the performance of officers under their command. Daily Activity Dashboard is typically 

implemented by law enforcement agencies that want to take a data-driven approach to resource 

allocation and crime reduction strategies. 

The Daily Activity Dashboard solution allows you to source incident records from computer-

aided dispatch or records management systems, visualize law enforcement incidents, and 

monitor trends or patterns. 

 

Requirements 
Daily Activity Dashboard requires the following. 

• ArcGIS Enterprise 10.6.1 - 10.8.1 

• ArcGIS Pro 2.7 or later (Basic, Standard, or Advanced) (optional) 

 

Information products 
Daily Activity Dashboard includes the following information products: 

Item Description 

Minimum 

user type 

Daily Activity 

Dashboard 

An ArcGIS Dashboards app used by law enforcement 

command staff to monitor calls for service, crimes, and arrest 

data sourced from computer-aided dispatch or records 

management systems 

Viewer 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of the Daily Activity Dashboard 
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Configure Daily Activity Dashboard 
The Daily Activity Dashboard solution can be configured to meet the specific needs in your 

organization. In this topic, you will learn how to use the Update Features with Incident 

Records tool to automatically load data from records management systems (RMS) and 

computer-aided dispatch systems (CAD) into the layers in your Daily Activity Dashboard, and 

modify or remove dashboard elements unsupported by your data schema. 

 

Load data 
The layers can be loaded with data using ArcGIS Pro. Optionally, you can automated the 

current RMS or CAD incident data to run on a schedule to ensure you are reviewing the most 

up-to-date information while using the dashboard. 

 

Load data using ArcGIS Pro 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to load. 

Then, load your existing data into the layers provided with the solution before sharing the maps 

or apps. 

1. In ArcGIS Pro, and ensure you are signed into your ArcGIS organization where the Daily 
Activity Dashboard solution is deployed. 

2. Click View, and then click Catalog Pane. 

3. In the Catalog Pane, click Portal, click My Content and choose the folder containing the 
solution. 

4. Add the LawEnforcementDistricts layer, Crimes layer, CallsforService layer, and Arrests 
layer to the map. 

5.  Click Analysis, then navigate to the Append tool, open the tool, use the tool to load the 
districts layer of the LawEnforcementDistricts layer. 

6. Navigate to the Update Features With Incident Records tool, open the tool and use it to 
load data into the Crimes layer. Then use the tool to load data for the CallsforService layer, 
and Arrests layer. 

 

Automate incident data updates 
You can use the ArcGIS Pro and the Update Features With Incident Records tool to update 

incident layers on a regular interval. Scheduled updates ensure users have access to current 

information to support more dynamic decision making. 

To update crimes, calls for service, arrests data on a schedule, use the Update Features With 

Incident Records tool with the Update Existing Target Features parameter enabled. Once the 

tool is configured to use your dynamic incident data, follow the schedule geoprocessing tools 

documentation to learn how to run the tool on a schedule. 
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Configure dashboard elements 
When loading data from your RMS or CAD system into the layers of the Daily Activity 

Dashboard(Crimes, Calls for Service, Arrests), you may find that your source data does not 

contain specific fields (Day of Week, Hour of Day) used in the charts or filters. Since the Daily 

Activity Dashboard is a configuration of ArcGIS Dashboards, all elements can be reconfigured 

to point to different fields, or deleted entirely, as the schema of your data necessitates. 

See Configuring ArcGIS Dashboard elements for more information. 
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Use Daily Activity Dashboard 
The Daily Activity Dashboard solution allows you to source incident records from computer-

aided dispatch or records management systems, visualize law enforcement incidents, and 

monitor trends or patterns. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Understand recent patterns of activity 
Daily Activity Dashboard allows supervisors to use data about recent trends and patterns to 

make smarter resource deployment decisions within their scope of control. 

In this workflow, you will earn how to use the Daily Activity Dashboard solution to explore recent 

crime, call for service, and arrest data to discover patterns of interest for operational responses. 

 

Visualize recent activity 
Follow these steps to visualize recent activity by precinct: 

1. In a browser, go to the Daily Activity Dashboard app. 

2. In the panel on the left side, click the Date drop-down list, and select Last 28 days. 

  The map now displays all calls, crimes, and arrests from the previous day. Calls for service 
will appear as blue circles with a phone icon, arrests will appear as gray circles with a 
handcuff icon, and crimes will appear in multiple colors—navy for violent crime, gold for 
property crime, and light gray for lesser crimes. Each crime type has its own unique symbol 
type. 

3. Select a precinct from the Precinct drop-down list. 

  The indicator elements on the right side display totals for each layer based on the filter 
selected. 

  Note: 

  You may continue to apply as many filters as you want—the filters will continue to narrow 
down the incidents displayed on the map based on the parameters you specify in your 
filter. To cancel your filter, click any filter and select All. 

4. Click one of the incident points on the map. A pop-up in the upper left corner of the map 
will appear, displaying key facts about the incident, including the date, location, and 
incident type. 

  Note: 

  Crimes, calls for service, and arrests layers all have slightly different fields. So the specific 
fields you observe in the pop-up may differ depending on the type of incident layer that you 
clicked. 

5. Click Zoom in to zoom in to an incident on your map using the scroll wheel on your mouse 
forward. Reversing the scroll wheel zooms the map out. Alternatively, you may click the 
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zoom in and zoom out buttons located in the lower left corner of the map to control zoom 
level. 

6. Select the basemap icon in the upper right corner of the map that looks like four maps. 
Then select the Imagery Hybrid basemap to see the imagery near the incident. 

7. When finished, reset each filter to All. 

 

Explore calls for service activity 
In this workflow, you will be preparing for a meeting with a neighborhood association. The group 

is particularly concerned about Friday night quality of life issues such as vice, drugs, alcohol 

complaints, and loud parties. 

1. Click the Calls for Service tab in the lower middle of the dashboard. 

2. Select a precinct from the Precinct filter list. 

3. In the Day of Week filter, select a day of the week. 

  You can now see the number of calls for service in your selected precinct, as well as a 
breakdown of the day of week, hour of day, and call for service type. 

4. Browse the Call for Service list to find any report of Vice/Alcohol/Narcotics or Loud Party Or 
Noise. Click the first record you find. 

  As you click, the map will zoom to the location of the call and flash a pink halo around the 
location. 

5. Click the point to open a map pop-up to get the specific location of the call, the officer who 
responded, date of call, call type, and call ID. 

6. When finished, reset all filters to the All. 

 

Explore crime activity 
You have just received grant funding to implement addition patrols in problem areas for 

burglary. To identify where and when to run these patrols, you would like to review all Burglaries 

year to date. 

1. Click the Crimes tab in the lower middle of the dashboard. 

2. Select Year to date in the Date filter. 

3. Select Burglary in the Activity Type filter. 

  The results on the dashboard will show all Burglaries year to date. In the Days of Week 
chart at the bottom of the dashboard, we can see that Burglaries peak slightly on certain 
days of the week. Additionally, you can see the Hour of Day when burglaries appear to be 
most active. 

4. Click any bar in the bar charts to filter the map for just the burglaries occurring in that 
period. 

  This filtering capability helps you to search for unique time-specific spatial patterns that 
may indicate the work of a serial offender. 

5. When finished, reset all filters to All. 
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Note: 

To deactivate a filter from a chart, click the chart bar again. 

 

Explore arrest activity 
Your first shift sergeant has recommended a commendation for an officer who has made 

several recent high-profile arrests. To consider the commendation, you need to review the 

recent arrests made by the officer. 

1. Click the Arrests tab in the lower middle of the dashboard 

2. Select the officer's id number from the Officer filter 

  You can now see all arrests made by the officer. Zoom in to the extent of the arrests. 

  Note: 

  The number in the Officer filter refers to each officer’s badge number. 

3. Click one of the arrest records in the list. 

  As you click, the map will zoom to the location of the arrest and flash a pink halo around 
the location. 

4. Click the arrest point to open a map pop-up to get the specific location of the arrest, the 
officer who responded, date of arrest, arrest type, and arrest ID. 

5. When you are done, close the Daily Activity Dashboard. 
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Damage Assessment 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Damage Assessment 
Damage Assessment can be used to collect initial property damage and other impacts 

immediately after a natural disaster or catastrophic incident. 

The solution provides a rapid damage assessment that helps government agencies prioritize 

activities undertaken by emergency management agencies to stabilize critical infrastructure, 

minimize health and safety threats, and restore services in a community. The initial damage 

assessment precedes the Joint Preliminary Damage Assessment (PDA) conducted with federal, 

state, and local officials after a disaster declaration is made. Damage Assessment is typically 

implemented by emergency management agencies that want to quickly understand the impact 

of a natural disaster or catastrophic incident and immediately assign resources to appropriate 

response and recovery activities. 

The Damage Assessment solution allows you to conduct an initial damage assessment and 

monitor the impact on residential buildings, commercial structures, and public facilities. 

 

Requirements 
The Damage Assessment solution requires the following: 

• ArcGIS Enterprise 10.7 - 10.8.1 

• ArcGIS Survey123 

 

Information products 
Damage Assessment includes the following information products: 

Item Description 

Minimum 

user type 

Damage Assessment 

Dashboard 

An ArcGIS Dashboards app used to monitor field 

assessments and determine whether damage costs 

exceed state or federal declaration thresholds 

Viewer 
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Damage 

Assessment: 

Commercial Buildings 

An ArcGIS Survey123 form used by field inspectors to 

conduct initial damage assessments for commercial 

buildings in a connected or disconnected environment 

Field 

Worker 

Damage 

Assessment: Public 

Facilities 

An ArcGIS Survey123 form used by field inspectors to 

conduct initial damage assessments for public facilities 

in a connected or disconnected environment 

Field 

Worker 

Damage 

Assessment: 

Residential Buildings 

An ArcGIS Survey123 form used by field inspectors to 

conduct initial damage assessments for residential 

buildings in a connected or disconnected environment 

Field 

Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Damage Assessment 
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Use Damage Assessment 
The Damage Assessment solution delivers a set of capabilities to collect and monitor damage to 

local structures including residential, commercial buildings, and public facilities. 

Note: 

In the United States, the Federal Emergency Management Agency (FEMA) manages two 
programs to assist recovery and restoration, the Public Assistance and Individual 
Assistance programs. If the results of the initial damage assessment are significant, a Joint 
Preliminary Damage Assessment (PDA) may be conducted. For more information on the 
FEMA Preliminary Damage Assessment (PDA) process, see Damage Assessment 
Operations Manual. Esri has created surveys using ArcGIS Survey123 to support both the 
FEMA Individual Assistance and Public Assistance programs. For more information on 
these surveys, see Esri Community blog post. 

 

Conduct field surveys 
Immediately after the emergency response and rescue operations are completed, initial damage 

assessments can be conducted by emergency management field personnel to determine the 

impact of the incident. Using field apps with location-based information helps emergency 

management personnel prioritize recovery efforts. 

Initial damage assessment can be conducted for commercial, residential and public 

infrastructure using ArcGIS Survey123 field app on a mobile device in a connected or 

disconnected environment. 

Note: 

The Survey123 field app is available from Google Play, the App Store, and the Microsoft 
Store. You can install Survey123 directly onto your device from these stores. 

 

Submit damage assessments for commercial buildings 
In some cases, local emergency managers may assign field inspectors who are experienced in 

assessing damages for commercial properties such as hotels, office parks, or shopping centers. 

The Damage Assessment: Commercial Buildings solution is a configuration of ArcGIS 

Survey123 that can be used by field inspectors to collect initial damage assessments on a 

mobile device in a connected or disconnected environment. 

In this workflow, you’ll assume the role of a field inspector who has been assigned to collect 

local damage assessments; you will assume you are at the field location collecting the 

necessary information. 

1. Sign in to the ArcGIS Survey123 app, and choose Damage Assessment: Commercial 
Buildings. 

2. Enter an Incident Number, Incident Name, Inspection Date, and Time. 
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3. Click the Set Location button. In the map search box, enter 22 W. Chicago Ave. 
Naperville, IL. 

4. Scroll down the list and enter site information for the commercial property. 

5. Select Yes for the Is the Business Open option, enter values for the Estimated $ Loss 
Structure and Estimated $ Loss Contents parameters. 

6. For the Extent of Damage, select Minor and for the Primary Cause of Damage, select 
Flood. 

7. Continue scrolling down the list to enter a Description of Damage, Impact to 
Jurisdiction, and Additional Comments. 

8. Under Photos, attach a picture or diagram to make it easy to see the extent of damage. 

9. Scroll down and enter the Inspectors Information to make it easy to follow up with any 
questions. 

10. Click Yes for Is the Owner or Occupant Present to open a cascading list of 
Owner/Occupant Information. 

  Note: 

  If the owner is present, the field inspector can capture contact and insurance information, 
which will help expedite the damage assessment process. 

11. Enter all the necessary Owner/OccupantInformation, then scroll down. 

12. Enter all the necessary Insurance Information. 

13. Click Submit to complete the damage assessment survey for the commercial property. 

 

Submit damage assessments for public facilities 
In this workflow, you’ll assume the role of a field inspector who has been assigned to public 

facilities such as schools, water and sewer, or transportation infrastructure. 

1. Sign in to the ArcGIS Survey123 app, and choose Damage Assessment: Public Facilities 
survey. 

2. Enter an Incident Number, Incident Name, Inspection Date, and Time. 

3. Click the Set Location button. In the map search box, enter Naperville Central High 
School, 440 Aurora Ave, Naperville, IL. 

4. Scroll down the list and enter Site, Facility, and Address information for the facility. 

5. For the Damage Category option, select CAT E – Public Buildings. 

6. Enter a Description of Damage, Impact to Jurisdiction, and Impacted Department. 

7. Enter values for the CostEstimate and County’s CostEstimate, Percent Complete and 
any Additional Comments. 

8. Under Photos, attach a picture or diagram to make it easy to see the extent of damage. 

9. Scroll down and enter the Inspectors Information to make it easy to follow up with any 
questions. 

10. Click Submit to complete the damage assessment survey for the Public Facility. 
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Submit damage assessments for residential buildings 
In this workflow, you’ll assume the role of a field inspector who has been assigned to assess 

damage to residential structures. 

1. Sign in to the ArcGIS Survey123 app, and choose Damage Assessment: Residential 
Buildings survey. 

2. Enter an Incident Number, Incident Name, Inspection Date, and Time. 

3. Click the Set Location button. In the map search box, enter 23 E Hillside Rd, 
Naperville, IL. 

4. Scroll down the list and enter Site and Parcel information for the residence. 

5. Under Type of Home, select Detached Home. 

6. Enter the Address information. 

7. For the Extent of Damage, select Minor, and for the Primary Cause of Damage, select 
Flood. 

8. Enter a Description of Damage, enter values for the Estimated $ Loss Structure and 
Estimated $ Loss Contents parameters. 

9. Enter an Impact to Jurisdiction and any Additional Comments such as the number of 
floors damaged, basement, or garage. 

10. Under Photos, attach a picture or diagram to make it easy to see the extent of damage. 

11. Scroll down and enter the Inspectors Information to make it easy to follow up with any 
questions. 

12. Select No for the Is the Owner or Occupant Present option. 

  Note: 

  In many cases, the owner or occupant may have left to seek shelter in another location. 

13. Click Submit to complete the damage assessment survey for the residential building. 

 

Monitor damage assessment reports 
Initial damage assessment reports can be used by local officials to determine the severity and 

magnitude of a natural disaster or catastrophic incident. The information from the reports is then 

analyzed to determine whether the disaster-related costs and damages could qualify for any 

state and/or federal assistance. 

The Damage Assessment Dashboard can be used to monitor damage assessments as they are 

submitted by field inspectors and determine whether damage costs exceed state or federal 

declaration thresholds. 

1. In a browser, sign in to your ArcGIS Enterprise organization, navigate to your the Damage 
Assessment Dashboard item, then choose view dashboard. 

2. Click the Residential Buildings tab in the lower left corner of the dashboard. 

3. Review the number of residential buildings in each extent of damage category. 

  Note: 
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  The damage assessment categories are Destroyed, Major, Minor, Affected, and 
Inaccessible. 

4. Review the total sum of damage assessments in the upper right corner of the dashboard. 

5. Click one of the residential damage estimates in the list. 

  The map zooms in to the selected residential damage estimate location and a pop-up 
window appears in the upper left corner of the dashboard with information and options to 
flash the selected feature. 

6. Click the Commercial Buildings tab in the lower left corner of the dashboard. 

7. Review the number of commercial buildings in each damage category. 

8. Review the total sum of damage assessments in the upper right corner of the dashboard. 

9. Click one of the commercial damage estimates in the list. 

  The map zooms in to the selected residential damage estimate location and a pop-up 
window appears in the upper left corner of the dashboard with information and options to 
flash the selected feature. 

10. Click the Public Facilities tab in the lower left corner of the dashboard. 

  Note: 

  The public facilities don’t have the same damage categories as residential or commercial 
buildings but instead have symbols indicating the damage category. 

11. Review the total sum of damage assessments in the upper right corner of the dashboard. 

12. Click one of the damaged public facility estimates in the list. 

  The map zooms in to the selected residential damage estimate location and a pop-up 
window appears in the upper left corner of the dashboard with information and options to 
flash the selected feature. 

13. Close the Damage Assessment Dashboard. 

 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 116 

Emergency Management Operations 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Emergency Management 

Operations 
Emergency Management Operations can be used to manage incident operations and maintain 

situational awareness during emergency response and recovery phases. 

The solution provides an integrated suite of role-based apps that helps emergency response 

personnel (for example, duty officers, field operations, incident commanders, and public 

information officers) share information as they perform the unique tasks required to accomplish 

incident objectives. Emergency Management Operations is typically implemented by emergency 

management agencies that want to use shared information during emergency response and 

recovery operations. 

The Emergency Management Operations solution delivers a set of capabilities that help you to 

identify an emergency incident, define the impact, allocate resources, and communicate status 

to internal and external stakeholders. 

 

Requirements 
The Emergency Management Operations solution requires the following: 

• ArcGIS Enterprise 10.7 - 10.8.1 

• ArcGIS Pro 2.7 - 2.9 (Basic, Standard, or Advanced) 

 

Information products 
Emergency Management Operations includes the following information products: 

Item Description 

Minimum user 

type 

Situational 

Awareness 

Viewer 

An ArcGIS Web AppBuilder app that can be used by 

emergency management personnel to understand the 

impact of an incident on public infrastructure and 

human populations 

Editor 
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Operations 

Response 

An ArcGIS Web AppBuilder app used by emergency 

management personnel to understand the status of 

emergency facilities and response teams 

Editor 

Incident Status 

Dashboard 

An ArcGIS Dashboards app used by emergency 

management personnel to monitor response activities 

and measure progress on incident objectives 

Viewer 

Incident Briefing An ArcGIS StoryMaps app used by emergency 

management personnel to brief key stakeholders 

during an incident or event 

Viewer 

Public Information A Nearby app used by the public to review authoritative 

information and understand the status of an incident or 

event 

Not required 

Emergency 

Management 

Maps 

An ArcGIS Pro project used by mapping technicians to 

create a standard set of briefing and response maps 

GIS 

Professional 

Basic 

Damage 

Assessment 

Dashboard 

An ArcGIS Dashboards app used to monitor field 

assessments and determine whether damage costs 

exceed state or federal declaration thresholds 

Viewer 

 

Release notes  
The following are the release notes: 

Version Description 

1.0 • First release of Emergency Management Operations 
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Configure Emergency Management Operations 
The Emergency Management Operations solution includes several data layers that use facility 

information to support emergency response activities. Below is a list of facility types that are 

used in those data layers. 

• Emergency Facilities—Police and fire 

• Industrial Facilities—Factories, utilities 

• Commercial Facilities—Shopping centers and businesses 

• Medical Facilities—Hospitals and clinics 

• Educational Facilities—Schools 

If you do not have an inventory of facility information in ArcGIS Enterprise, you may have them 

in a spreadsheet or another system you can export to a spreadsheet. Once you have created a 

spreadsheet for each facility type, you can load the data into the facility layers provided with the 

solution. 

 

Load emergency management facilities 
To load your facilities information from a spreadsheet, complete the following steps: 

1. If necessary, sign in to your ArcGIS Enterprise organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Emergency Management Operations in the search box. 

4. Under Item Type, click Layers, then click Feature Layers. 

  Note: 

  Some of the feature layers have a suffix added such as public. These are layer views of 
the of the original source feature layer. These layer views are used to share information 
with the public without showing all the details or allowing the public to edit the layers. The 
original source layers do not have a suffix. 

5. Click the title of the original source layer into which you want to load data to view the item 
details. 

6. Click Update Data, then click Append Data to Layer. 

7. Under Filename, choose your spreadsheet. 

8. Click Upload, then click Continue. 

9. Click Show field matching to match the fields from the spreadsheet to the fields in the 
selected feature layer. 

10. After you have matched the fields, click Apply Updates. 

11. Click the Data tab on the banner of the item page to confirm your data has loaded 
successfully. 
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Configure the incident briefing app 
Incident Briefing is a configuration of the Story Maps Series application. The application 

references Esri's sample application: Situational Awareness Viewer, Operations Response, and 

Incident Status Dashboard and Damage Assessment Dashboard. To configure the Incident 

Briefing story map, complete the following steps: 

1. Sign in to your ArcGIS Online organization and browse to the application. 

2. On the application item page, click Configure App. 

3. Click the Introduction tab, then click the Edit button. 

4. On the Edit tab, click the back button. 

5. Click the Upload button, then click the browse for an image button and browse to the 
image you want to display, and click Save. 

6. Update the introduction text as necessary for your incident briefing application. 

7. In the upper right corner of the application, click the Fix button. 

8. Click the Confirm button to authorize the subscriber content for public viewers. For more 
information, see What is subscriber content. 

9. Click the Close button. 

10. Click the Situational Awareness tab, then click the Edit button. 

11. On the Edit tab, click the back button and paste the URL for your Situational Awareness 
Viewer application in the Web Page link, then click Configure > Save. 

12. Repeat step 6 through 7 for the Operations Response, and Incident Status Dashboard 
tabs to reference the applications in your organization. 

13.  For ArcGIS Enterprise deployments, repeat step 6 through 7 for the Damage 
Assessment Dashboard tab to reference the applications in your organization. 

14. Make additional changes that are necessary to the Incident Briefing story map, then click 
Save in the upper right corner to save all your configuration changes. 

15. Edit the item details. 

 

Configure the Public Information app 
The Public Information app requires access to display the National Weather Service watches, 

warnings, and advisories layer publicly. Follow the steps below to allow access to the layer and, 

optionally, configure directions to be used in the app. 

 

Configure the National Weather Service watches, warnings, and 

advisories 
To configure the ArcGIS Living Atlas layers from the National Weather Service, which are 

included in the deployed map, and to share this app publicly, you will need to allow access to 

these layers through your subscription. Follow the steps below to enable the layers in the app. 
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1. Sign in to your ArcGIS Enterprise organization and browse to the Public Information app. 

2. View the app and identify changes you may want to make to it to support specific business 
needs in your organization. 

3. On the app item page, click Edit Application. 

4. On the Attribute tab, click Subscriber content access. 

5. Select the ArcGIS Living Atlas layers to allow public users to access them through your 
subscription. 

6. Click Save to save the app and edit the item details. 

 

Configure directions 
Optionally, the Public Information app can be configured to provide directions to the nearest 

facilities. 

This configuration draws routes and provides directions using the ArcGIS Online World Route 

Service. This service requires authorization to consume premium content as it consumes 

credits. Learn more about credit usage when creating simple routes. 

Follow the steps below to connect to a routing service and configure the app to enable 

directions. 

1. If necessary, sign in to your ArcGIS Online organization. 

2. Browse to the web app item page and click Configure App. 

3. In the left panel, click Interactivity. 

4. Click the slider to enable Show directions. 

5. Click Publish. 

6. Click Confirm. 

  The Authorize premium content dialog box appears, indicating this functionality will 
consume credits. 

7. Click Authorize. 

8. Click Launch and explore the capabilities of enabling directions. 

 

Configure Situational Awareness Viewer for ArcGIS 

Enterprise 
For ArcGIS Enterprise deployments, Situational Awareness Viewer requires the USA Block 

Groups in the ArcGIS Living Atlas. Follow the steps below to add the USA Block Groups layer to 

your map, and configure the widget to use in the application. 

Note: 

This is a required workflow for ArcGIS Enterprise 10.7, 10.8, and 10.8.1 deployments. 
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Add USA Block Groups layer 
To add the USA Block Groups layer to the Situational Awareness Viewer map, complete the 

following steps: 

1. Sign in to your ArcGIS Enterprise organization and browse to the map. 

2. Click the Open in Map Viewer button and click Web Map Settings. 

3. Click the Add button and choose Browse Living Atlas Layers. 

4. Type USA Block Groups, press the Enter key, and choose USA Block Groups. 

5. To close the search pane when you are finished, click the back button. 

6. Click the Add to Map button. 

7. In the contents pane, next to the USA Block Groups layer, click the more options button, 
and choose Remove Pop-up. 

8. Change the style of the layer by choosing no color. 

9. Save the map. 

 

Configure the Potential Impact widget 
To configure the Situational Awareness Viewer application to use USA Block Groups, complete 

the following steps: 

1. Sign in to your ArcGIS Enterprise organization. 

2. Browse to the ArcGIS Web AppBuilder application item page and click Edit Application. 

3. Click the Widgets tab, then click Set the widget in this controller. 

4. Hover over the Potential Impact widget, and click Configure this widget. 

5. In your Potential Impact widget, add a potential impact tab to display summarized 
information from the USA Block Groups layer in the map by clicking Add Tab. 

6. Choose the USA Block Groups layer in the Layer column, choose Summary in the 
Analysis Type column, and type Potential Impact in the Label text box. 

7. Under the Action column, click the Edit tool to open the Select Fields window, then add 
the following fields, labels, and types: 

  Field   Label   Type 

  POP2012   Total Population   SUM 

  AGE_UNDER5   Children Under 5   SUM 

  AGE_85_UP   Adult Over 85   SUM 

8. Click OK. 

9. Save the application and share it with everyone. 

10. Start your application. 
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Use Emergency Management Operations 
The Emergency Management Operations solution delivers a set of capabilities that help allows 

you to identify the potential threat, define the area affected, and quickly determine the impact to 

population, facilities, and infrastructure. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Assess the impact of an incident 
Situational Awareness Viewer can be used by emergency management personnel to 

understand the impact of an incident on public infrastructure and human populations. Situational 

Awareness Viewer includes incident information used in a suite of related emergency operations 

solutions essential to maintaining situation awareness. 

In this workflow, you will assume the role of a duty watch officer responsible for assessing the 

incident impact and sharing that information with other users in the EOC. 

 

Define the incident area 
The incident area can be defined by selecting an existing incident, weather warning area, or 

storm report from Active Incidents and Warnings. An incident can also be created by creating a 

buffer around a point, line, or polygon. 

To define the incident area using the sample data, complete the following steps: 

1. In a browser, from the Emergency Management Operations solution, view the Situational 
Awareness Viewer. 

2. From the Active Incidents and Warnings list, click an incident perimeter. 

  Note: 

  You can also define an incident area by clicking any existing polygon. 

3. Click the more options button in the lower right corner of the pop-up window and 
choose Set Location to define the incident area. 

  The Situation Awareness widget will open at the bottom of the screen with the impact of a 
one-mile buffer around the incident. 

  Note: 

  The point, line, and polygon icons can be used to create another incident area by 
specifying a buffer distance around another location. This can be useful for accidents, 
chemical spills, tornado paths, wildfires, or any other type of incident. 

4. Click the Save button in the Situation Awareness panel at the bottom of the screen to save 
the incident location in the Incident layer. 

  A pop-up will appear allowing you to enter parameters for this incident. 

5. Enter an incident number, name, type, then click Done. 
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Assess the potential impact 
After the incident area has been defined, the impact to population, facilities, and infrastructure 

can be determined. Using the incident area defined in the previous workflow, follow the steps 

below to determine the potential impact of an incident. 

1. To determine the potential impact to the population, select the Potential impact tab in the 
Situation Awareness panel at the bottom of the screen. 

  The estimated potential impact to vulnerable populations in the incident area is displayed 
by age group. 

2. To further understand the impact to population, select the Special Needs tab. 

  This tab displays a list of residents, if any, who have registered for assistance during an 
emergency. 

3. To determine the impact to facilities, select the Schools, Shelter, and Hospitals tabs. 
Each tab displays the number of facilities in the incident area. 

4. To determine the impact to road infrastructure, select the Road Closures tab. This tab 
displays the number of Road Closures in the incident area. 

5. Click the Incident tab, then click the Download button to download all the incident 
information into a CSV file. 

  Note: 

  This CSV file can be given to the emergency management staff or volunteer coordinators. 

6. Click the Print button to create a report of the potential impacted facilities, infrastructure, 
and human populations. In the properties window, enter a title, orientation, page size, and 
any comments, then click OK. 

  Note: 

  This report can be printed or saved electronically to share with emergency management 
staff. 

7. The Snapshot button can be used to create a time-stamped folder in your ArcGIS 
organization containing a map and feature layers. The map and feature layers can be used 
for after-action reports or other analysis. 

  Note: 

  The Snapshot button is enabled when deployed in your organization and is enabled. 

8. Close the Situation Awareness Viewer app. 

 

Understand operational needs 
After the incident area has been defined and the impact has been determined, the operations 

personnel can plan and assign response activities. The Operations Response app can be used 

by emergency management personnel to understand the status of emergency facilities and 

response teams. 

In this workflow, you will assume the role of the operations section personnel responsible for 

locating and assigning emergency response resources. 
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Find resources near an incident 
Operations response begins by identifying the incident area and finding nearby resources to 

support tactical operations. You can search for an address or place to find a given location to 

help plan response activities near that location. 

1. In a browser, from the Emergency Management Operations solution, view the Operations 
Response app. 

2. In the search box, type an address. 

3. Click the more options button in the lower right corner of the search result pop-up window. 

4. Choose Set Location to define the incident area and specify a buffer distance of 1 mile. 

5. Click the MRP Deployments tab to display a list of mission-ready packages within the 
specified buffer. 

6. Click the Response Facilities, Road Closures, and Closest Hospitals, Schools, 
Shelters tabs to find other resources. 

7. Click the Incident tab, then click the Download button on the left side and open the CSV 
file to see the list of resources. 

  Note: 

  This information can be shared with other agencies or saved for an after-action report. 

8. Explore other methods of defining incident boundaries by using the line tool to locate a 
linear incident, such as a train derailment along the train tracks, and use a buffer distance 
of 1 mile to see the impact area. 

9. Click the Start Over button to remove the selected incident area, if necessary. 

 

Locate teams assigned to response activities 
Mission teams that have been assigned to response activities can be located on the map with 

attributes and symbology for each type of response team. These locations and attributes can 

then be updated from the field as teams change or complete assignments. 

1. Click the Add Resources widget in the upper right corner to view the resource that can be 
assigned to this incident. 

2. In the Search Templates box, type Emergency to see a list of resources with that name. 

3. Select Emergency Medical Services to add a point on the map near the point of the 
incident address. 

4. In the Add Resources list, for Mission Ready Packages, add the following attributes: 

  Parameter   Value 

  Name   EMS 1 

  MRP Type   medical 

  MRP Status   Acceptance of Mission 

  MRP Description   public requested assistance 
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  NIMS Resource   Medical/Public Health System Assessment Team 

  NIMS Discipline   Emergency Medical Services 

  NIMS Resource Kind   Team/Equipment 

  NIMS Type   III 

  Leave the remaining attributes blank for now and close the Add Resources widget. 

5. Use the Directions widget to get directions from the incident location to the nearest 
hospital. 

6. Click the Print button in the Directions widget to print a map of the route with directions. 

  Note: 

  Operations Response can be used on a mobile device or printed directions can be sent to 
a mobile device if necessary. 

7. Click Clear to clear the directions from the map. 

 

Archive incidents 
After the incident or event is over and operational features in the map are ready to be archived, 

the Archive Incidents widget updates the active incident flag to archive data quickly and 

efficiently. The features are no longer visible in the app but will continue to be stored in the 

associated feature layers. This system design allows you to manage multiple incidents from a 

single app and allows you to access your archived data from the associated feature layers for 

after-action analysis or reporting. 

1. Click the Archive Incidents widget to view the operational layers available to be archived. 

2. Check the check boxes next to the layers to be archived. 

3. Click one of the Drawing tools, and select the features on the map. 

4. Choose the Active Incident drop-down list, then choose No, and click Save. 

5. Close the Operations Response app. 

 

Visualize incident status 
As the incident unfolds, it is important for incident commanders to monitor response activities as 

they occur in real time. Typically, the county or state Emergency Operations Center displays the 

incident status on a big screen so all command staff can monitor events and make informed 

decisions. 

 

Monitor incident status 
The Incident Status Dashboard can be used by emergency management staff to monitor 

response activities in the Emergency Operations Center and measure progress toward the 

incident objectives. 
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In this workflow, you will assume the role of the incident command personnel responsible for 

monitoring the status of the incident and emergency response activities. 

1. In a browser, from the Emergency Management Operations solution, view the Incident 
Status Dashboard app. 

  Note: 

  The Incident Status Dashboard is designed to be a passive dashboard, meaning no 
interaction is necessary since it typically will be viewed on a big screen in the Emergency 
Operations Center. 

2. Review the number of Active Incidents and Weather Warnings on the left side of the 
dashboard. As the active incidents increase, so does the demand on resources. 

3. Review the number of Open Shelters and Shelter Occupancy on the right side of the 
dashboard. Each green symbol on the map indicates both the location and status of 
shelters. Closed shelters will appear in red. As the shelter occupancy increases past 75 
percent, the gauge will turn red, indicating additional shelters will need to be opened to 
meet the demand. 

4. Review the indicators at the bottom of the screen. 

– MRPs Deployed indicates the number of Mission Ready Packages that have been 
assigned or deployed. An MRP type describes a specific capability that has been 
developed, trained, and equipped to respond to a unique incident or situation. 

– Road Closures indicates the number of road closures within the current map extent. 

– PODs indicate the number of Points of Distribution where public safety agencies 
can distribute critical supplies to the public. 

5. After you are done reviewing the information, close the Incident Status Dashboard. 

 

Brief key stakeholders 
During an incident, emergency management personnel must provide key decision makers with 

accurate and current information that communicates the scope of the emergency incident, the 

status of operational response, and resource availability. Using digital maps to brief key 

stakeholders ensures clear communication across all command levels and enables effective 

executive-level decision-making. 

 

Report current situation 
In this workflow, you will play the role of the incident command staff who is responsible for 

conducting the incident briefing. The briefing is conducted using a series of interactive apps in 

the Incident Briefing app. 

1. In a browser, from the Emergency Management Operations solution, view the Incident 
Briefing app. 

2. Review information in the Introduction tab to see how the briefing app can be used. 

3. Click the Situational Awareness tab to see active incidents and warnings. 
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  Note: 

  The Situational Awareness app is embedded in the Incident Briefing app to provide an 
interactive map showing the status of the incident. You can select an active incident to 
show the current situation and impact to the community. 

4. Click the Operations Response tab to see current emergency response activities. 

  Note: 

  Questions often arise during an incident briefing such as how many teams are currently 
deployed or how many roads are closed. Because the Operations Response is embedded 
in the Incident Briefing app, questions such as this can be quickly answered with current 
information. 

5. Click the Incident Status tab to see the overall picture of the current situation. 

6. Close the Incident Briefing app when done reviewing. 

 

Inform the public 
Citizens need access to information before, during, and after an incident to assess their 

personal risk and determine when to act. The Public Information app can be used by the public 

to review authoritative information and understand the status of an incident or event. 

 

Locate incident information 
Follow the steps below to get incident information using the sample data. 

1. In a browser, from the Emergency Management Operations solution, view the Public 
Information app. 

2. In the Public Information pane, drag and use the buffer distance slider to set a distance of 
3 miles. 

  The slider allows a user to define a distance once an address is entered or a location is 
identified on the map. 

3. In the Public Information pane under Search for an address or locate on map, type an 
address. 

4. Click the Expand All button to review all the incident information near the specified 
address. 

5. Scroll down the list of incident information to review the local incidents, open shelters, 
evacuation notices, and weather warnings. 

6. Click Open Shelter to review additional information about the selected shelter. 

7. Close the Public Information app when you are done reviewing the incident information. 

 

Produce emergency maps 
Often, field support personnel don’t have access to the internet or real-time maps on devices 

during an emergency incident. Therefore, it may be necessary to produce paper maps of the 
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current situation quickly. Emergency Management Maps can be used by emergency 

management mapping technicians to update the data sources with local incident data, share 

maps and data, and create standard hard copy briefing and response maps. 

In this workflow, you will assume the role of a mapping technician supporting an emergency 

incident. 

Use your data 
Emergency Management Maps is a desktop application template that includes a series of tasks 

that have been designed to support planning and response activities. It can be used to update 

source data for the current incident which can be used in the other apps that are part of the 

Emergency Management Operations solution. 

1. In a browser, go to your ArcGIS Online organization and click My Contents. 

2. Locate the Emergency Management Operations folder. 

3. Download the Emergency Management Maps desktop application template. 

4. Start the ArcGIS Pro application and open the project package from the active portal. 

5. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

6. In the Catalog pane, expand the Using your data task group. 

7. Click the Update data sources task and follow the instructions to update the ArcGIS Pro 
project to reference hosted feature layers. 

8. Click the Append your data task and follow the instructions to add your data to the 
existing data schemas provided with the project. 

9. Click the Use existing geodatabase task and follow the instructions to source layers with 
your data or published web layers. 

10. Click the Use Esri Demographic data task and follow the instructions to use data included 
in ArcGIS Living Atlas of the World. 

 

Share with your organization 
Some situations require sharing data and maps with other people within the organization. After 

you resource the data in the previous workflow, you can share layers and maps with your data. 

You can also share the desktop application template with other mapping technicians. 

1. In the tasks panel, expand the Share with your organization task group. 

2. Click Share Layers and follow the task instructions to publish your data as a web layer. 

3. Click Remap layer to use published layers to replace layers in the project with the new 
published layers. 

4. Click Share maps to share the maps as web maps with your organization after referencing 
web layers in the project maps. 

5. Click Create Shared Map Package to create a map package that can be shared with other 
people in your organization to edit data and create map books. 
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Create map books 
One way to deliver standard hard copy briefing and response maps to field personnel is in the 

form of a map book. The map book can be either a series of the same map with individual 

pages covering the geographic extent of the incident or a collection of different maps with the 

same extent. 

1. In the tasks panel, expand the Create map books task group. 

2. Click Create a field reference map series and follow the task instructions to create a map 
series with pages of different extents of the same map. 

3. Click Create an incident map book and follow the task instructions to create an incident 
map book with different maps of the same extent. 
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Fire Hydrant Inspection 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
July 2022 - June 2024 

Retired phase 
July, 2024 

 

Introduction to Fire Hydrant Inspection 
Fire Hydrant Inspection can be used to perform fire hydrant inspections and ensure that every 

hydrant in a district performs reliably when an emergency occurs. 

The solution provides a comprehensive inventory of fire hydrants, and their status that can be 

accessed in a station or the field. The hydrant inventory can be used by fire service agencies to 

prioritize inspection activities and quickly locate operational hydrants when an emergency 

occurs. This approach reduces staff time necessary to perform routine inspections, and 

ultimately increases the effectiveness of fire suppression efforts. Fire Hydrant Inspection is 

typically implemented by fire service agencies that want to take a data-driven approach to 

preparedness and response activities. 

The Fire Hydrant Inspection solution delivers a set of capabilities that help you inventory fire 

hydrants, collect operational status on a regular schedule, and monitor the progress of 

firefighters performing routine hydrant inspections. 

 

Requirements 
Fire Hydrant Inspection requires the following: 

• ArcGIS Enterprise 10.6.1 - 10.8.1 (Standard or Advanced) 

• ArcGIS Collector 
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Information products 
Fire Hydrant Inspection includes the following information products: 

Item Description 

Minimum 

user type 

Fire Hydrant 

Inspection 

Dashboard 

An ArcGIS Dashboards app used by fire personnel to 

monitor fire hydrant inspections occurring in a community 

Viewer 

Fire Hydrant 

Inspection 

An ArcGIS Collector web map used by fire personnel to 

inspect fire hydrants and ensure that every hydrant in a 

district performs properly and reliably when an emergency 

occurs 

Field 

Worker 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Fire Hydrant Inspection 
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Configure Fire Hydrant Inspection 
The Fire Hydrant Inspection solution can be used by fire personnel to perform inspections and 

ensure that every hydrant in a district performs properly and reliably when an emergency 

occurs. In some cases, you may already have fire hydrant location and attribute data in ArcGIS 

or a spreadsheet. To load your fire hydrant data into the solution, follow the instructions 

appropriate for the form of your data. 

 

Load fire hydrant data from a spreadsheet 
To load fire hydrant data from a spreadsheet, complete the following steps: 

1. If necessary, sign in to your ArcGIS Online organization 

2. At the top of the site, click Content. 

3. On the My Content tab, type fire hydrant in the search box. 

4. Click the Feature Layer item named FireHydrants. 

5. Click the Data tab. 

6. Click the Fields toggle button to display a view of all fields in the FireHydrants layer. 

7. Right-click the Overview tab, and open a new window. 

8. Click the Update Data button, then click Append Data to Layer. 

9. Click the Choose File button and select your spreadsheet. 

10. Click Upload and Continue. The spreadsheet may take several seconds to upload. 

11. Click the Show field matching link. 

12. Match the fields in your data to the appropriate corresponding field in the FireHydrants 
layer. 

Tip:  

Your spreadsheet must have fields containing the latitude and longitude coordinates of 
the fire hydrant location, and these fields must be matched to the Latitude and Longitude 
fields in the FireHydrants layer. 

13. Click Apply Updates. 

 

Load fire hydrant data 
If you have fire hydrant data you can load it into the fire hydrant layer to conduct the inspections. 

To load features from a shapefile into the hydrants layer, complete the steps below 

1. If necessary, sign in to your ArcGIS organization 

2. At the top of the site, click Content. 

3. On the My Content tab, type fire hydrant in the search box. 
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4. Click the Feature Layer item named FireHydrants. 

5. Click the Data tab. 

6. Click the Fields toggle button to display a view of all fields in the FireHydrants layer. 

7. Review the display names of all fields in the layer and consider how the fields in your data 
relate. In a later step, you will need to match the fields in your dataset to the associated 
field in the FireHydrants layer, so it is helpful to leave this page open for reference. 

8. Right-click the Overview tab, and open a new window. 

9. Click Choose File and browse to a .zip containing the shapefile with your fire hydrants 

and then click Open. 

10. Click Upload and Continue. The file may take several seconds to upload. 

11. Click the Show field matching link. 

12. Match the fields in your data to the appropriate corresponding field in the FireHydrants 
layer. 

13. Click Apply Updates. 
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Use Fire Hydrant Inspection 
The Fire Hydrant Inspection solution delivers a set of capabilities that helps firefighters perform 

hydrant field inspections and helps supervisors monitor the progress of inspections from the 

office. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Collect fire hydrant data 
Fire Hydrant Inspection allows firefighters in the field to collect data about fire hydrants from a 

smartphone or tablet. 

In this workflow, you’ll learn how to use the Fire Hydrant Inspection web map in ArcGIS 

Collector to document the inspection of a fire hydrant and to capture information about a new 

hydrant. 

 

Perform a fire hydrant inspection in the field 
You will assume the role of a firefighter. You are asked to use the ArcGIS Collector mobile app 

to access your Fire Hydrant Inspection map and document fire hydrant inspections you were 

assigned to perform in the field. 

1. Download ArcGIS Collector onto your mobile device. 

2. Open the app on your mobile device, and sign in to your ArcGIS organization. 

3. Choose the Hydrant Inspection Map. 

4. Search for Naperville, IL, then click Naperville when it appears in the list of Places to 
zoom to that location on the map. 

5. Click a Fire hydrant. 

6. Scroll up to see the attributes for this hydrant. 

7. Click the edit button to edit the record. 

8. Set the question Will Not Flow or Pump to Yes. 

9. Set the question Operable to No. 

10. Click Submit. 

11. In the map, the color of the hydrant now turns from red to black. 

 

Capture information about a new fire hydrant 
You will stay in the role of a firefighter in the field and will now use the Fire Hydrant Inspection 

map in ArcGIS Collector to capture information about a new fire hydrant that needs to be added 

to the map. 

1. Download ArcGIS Collector onto your mobile device. 
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2. Open the app on your mobile device, and sign in to your ArcGIS organization. 

3. Choose the Fire Hydrant Inspection map. 

4. To add a new hydrant, click the add button. 

5. Use the map to select the exact placement of the hydrant. By default, the app will use the 
GPS location of your device. 

6. Select Yes to indicate the hydrant is operable. 

  Note: 

  This step sets the default symbol for the hydrant based on the operable condition. 

7. Click the Add Point button. 

8. Scroll up to view all hydrant attribute fields. 

9. Set the question Flow Rate (GPM) to 600. 

10. Set the question Pressure (PSI) to 15. 

11. Click Submit. 

12. In the map, the new hydrant can be seen in red to indicate that it is operable. 

 

Monitor progress of fire hydrant inspections 
You will now assume the role of fire command staff and will use the Fire Hydrant Dashboard 

from your office to monitor the progress of those inspections. 

1. In a browser, go to the Fire Hydrant Dashboard. 

2. Click Fire Station #9 on the left side of the dashboard, under the Fire Stations header.  

  You can now see all fire hydrants in your district on the map. On the right side of the 
dashboard, you can see the total number of hydrants, the number of inoperable hydrants, 
and the number of hydrants inspected in the last 365 days. Your inspection process will be 
completed when the number of hydrants inspected in the last 365 days is the same as the 
total number of hydrants. 

3. Click Last 30 Days from the Inspection Date drop-down list on the left side of the 
dashboard. 

  You can now see how many hydrants have been inspected in the last 30 days. 

4.  Click All from the Inspection Date drop-down list to clear the Last 30 Days filter. 

5. Select Between the dates from the Inspection Date drop-down list, then enter a start date 
and end date to filter by a specific date range. 

6. Click All from the Inspection Date drop-down list to clear the Between the dates filter. 

7. Click the Inoperable button under Hydrant Status on the left side of the dashboard to see 
only the inoperable fire hydrants.  

8. Click the Inoperable button again to view all hydrants. 

9. Close the app. 
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Fire Incident Dashboard 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Fire Incident Dashboard 
Fire Incident Dashboard can be used to visualize fire and emergency medical service (EMS) 

incidents sourced from computer-aided dispatch or records management systems and monitor 

associated response times. 

It improves operational visibility for supervisors in a fire service agency and allows them to 

rapidly identify emerging incident patterns and diagnose response problems. This increased 

operational awareness ensures accreditation standards are being met and community safety 

standards are satisfied. Fire Incident Dashboard is typically implemented by fire service 

agencies that want to proactively monitor response times and detect incident patterns quickly. 

The Fire Incident Dashboard solution delivers a set of capabilities that help you source incident 

records from computer-aided dispatch or records management systems, visualize fire and EMS 

incidents, and monitor trends or patterns. 

 

Requirements 
Fire Incident Dashboard requires the following: 

• ArcGIS Enterprise 10.7 - 10.8.1 

• ArcGIS Pro 2.7 - 2.9 (Basic, Standard, or Advanced) (Optional) 

 

Information products 
Fire Incident Dashboard includes the following information products: 

Name Description 

Minimum 

user type 

Fire Incident 

Dashboard 

An ArcGIS Dashboards application used by fire command 

staff to monitor fire and EMS incidents sourced from 

computer aided dispatch or records management data 

Viewer 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Fire Incident Dashboard 
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Configure Fire Incident Dashboard 
The Fire Incident Dashboard solution can be configured to meet the specific needs in your 

organization. In this topic, you will learn how to use the Update Features with Incident 

Records tool to automatically load data from records management systems (RMS) and 

computer-aided dispatch systems (CAD) into the layers in your Fire Incident Dashboard, and 

modify or remove dashboard elements unsupported by your data schema. 

 

Load data 
The layers can be loaded with data using ArcGIS Pro. Optionally, you can automated the 

current RMS or CAD incident data to run on a schedule to ensure you are reviewing the most 

up-to-date information while using the dashboard. 

 

Load data using ArcGIS Pro 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to load. 

Then, load your existing data into the layers provided with the solution before sharing the maps 

or apps. 

1. In ArcGIS Pro, and ensure you are signed into your ArcGIS organization where the Fire 
Incident Dashboard solution is deployed. 

2. Click View, and then click Catalog Pane. 

3. In the Catalog Pane, click Portal, click My Content and choose the folder containing the 
solution. 

4. Add the FireServiceDistricts layer and FireIncidents layer to the map. 

5.  Click Analysis, then navigate to the Append tool, open the tool, use the tool to load the 
districts layer of the FireServiceDistricts layer. 

6. Navigate to the Update Features With Incident Records tool, open the tool and use it to 
load data into the FireIncidents layer. 

 

Automate incident data updates 
You can use the ArcGIS Pro and the Update Features With Incident Records tool to update 

incident layers on a regular interval. Scheduled updates ensure users have access to current 

information to support more dynamic decision making. 

To update crimes, calls for service, arrests data on a schedule, use the Update Features With 

Incident Records tool with the Update Existing Target Features parameter enabled. Once the 

tool is configured to use your dynamic incident data, follow the schedule geoprocessing tools 

documentation to learn how to run the tool on a schedule. 

 

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/update-features-with-incident-records.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/update-features-with-incident-records.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/update-features-with-incident-records.htm
https://pro.arcgis.com/en/pro-app/2.7/tool-reference/crime-analysis/update-features-with-incident-records.htm
https://pro.arcgis.com/en/pro-app/2.7/help/analysis/geoprocessing/basics/schedule-geoprocessing-tools.htm


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 139 

Configure dashboard elements 
When loading data from your RMS or CAD system into the layers of the Fire Incident 

Dashboard, you may find that your source data does not contain specific fields used in the 

charts or filters. Since the Fire Incident Dashboard is a configuration of ArcGIS Dashboards, all 

elements can be reconfigured to point to different fields, or deleted entirely, as the schema of 

your data necessitates. 

See Configuring ArcGIS Dashboard elements for more information. 
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Use Fire Incident Dashboard 
The Fire Incident Dashboard solution delivers a set of capabilities that help you source incident 

records from computer-aided dispatch or records management systems, visualize fire and EMS 

incidents, and monitor trends or patterns. 

Note:  

Use your organization's data or configured apps to follow these workflows. 

 

Understand recent trends 
In this topic, you’ll assume the role of a fire chief who will use the Fire Incident Dashboard to 

explore response times to citywide fire incidents in the last 30 days, examine response-time 

performance on EMS calls year-to-date, and compare fire response times by station. 

 

Explore response times to incidents 
Follow these steps to examine the fire department’s overall response-time performance. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Fire Incident 
Dashboard solution.  

2. View the Fire Incident Dashboard app. 

3. On the left, in the filter panel, click the Call Date drop-down list and choose Last 30 days. 

  The map filters to display all citywide fire incidents from the past 30 days. 

4. On the right, review each gauge element for average turnout time, average travel time, and 
average total response time. 

  Note: 

  Values in the green range are within or below the acceptable range for that metric. Values 
in the red range are outside of the acceptable range for that metric. The National Fire 
Protection Association (NFPA) standard is shown below each corresponding gauge. For 
example the, NFPA standard average turnout time is 80 seconds. If the gauge shows that 
the citywide average turnout time is 1.1 minutes, or 70 seconds, citywide average turnout is 
barely acceptable because the standard average turnout time for incidents must be 80 
seconds or fewer. 

5. On the map, click any incident. 

  In the top-left corner of the map, a pop-up appears. It displays key facts about the incident, 
including which unit and shift responded, the incident type, the unit's response times, and 
the incident location. 

6. Below the map, review the chart. 

  The chart displays the number of incident responses by each fire station and unit. You 
have already filtered for the last 30 days, so the chart shows which fire stations had the 
most responses in that time period. 
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7. In the chart, click the blue bar for one of the fire stations. 

  The map and gauges update to show only that fire station's incident responses and 
response times. 

8. In the chart, click the blue bar again to deselect the fire station. 

9. On the left, in the filter panel, click the Call Date drop-down list and choose All to clear the 
date filter. 

  Note: 

  You can apply as many filters as you want. The filters continue to narrow the number of 
incidents displayed on the map based on the parameters that you specify. To cancel a 
filter, click any filter and select All. 

 

Examine response-time performance by call type 
Response-time performance varies depending on the type of unit responding to the call. You 

can filter the calls by type to get a more accurate assessment of response-time performance. 

Follow these steps to examine response-time performance by call type. 

1. On the left, in the filter panel, click the Call Type drop-down list and choose EMS and 
Rescue. 

2. Click the Call Date drop-down list and choose Year to date. 

  The map updates to show only citywide EMS calls year to date. 

3. On the right, review the gauges to determine if the average response times are within 
appropriate ranges. 

4. In the Responses by Station and Unit chart, click the bar for one of the fire stations, and 
then review that station's EMS-incident response time. 

5. Click the bar again to deselect that fire station. 

6. Follow these steps to review each station's EMS-incident response time. 

7. Reset all filters to All. 

 

Compare fire response times by fire station 
Response-time performance may vary depending on the station or unit responding. You can 

compare response time using the station and call-type filters. 

Follow these steps to examine the response-time performance for each station. 

1. On the left, in the filter panel, select a fire station. 

  The map and gauge elements filter to reflect only the incidents that the selected fire station 
responded to. Filtering for a single fire station allows you to review the incident types that 
the fire station responded to so that you can determine if future calls can be covered by 
another station. 

2. Click the Call Type drop-down list and choose each call type one at a time, noticing the 
differences in response-type performance for each call type. 
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3. After you finish, reset all filters to All. 

4. Repeat this process with the incidents in other fire stations to make help you make a data-
driven decision on each station’s performance. 
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Fire Service Maps 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Fire Service Maps 
Fire Service Maps can be used to produce wall maps and run books that are placed in a fire 

station or apparatus to assist with response activities. 

Fire personnel must understand their communities and quickly respond to calls for service. 

Delayed response times could result in the loss of life and property. While maps have made 

their way on to public safety mobile data computers (MDC), two primary hardcopy maps are still 

produced for reference in the fire service. Station wall maps are generally small scale maps 

hung on the wall of each fire station to help new personnel become more familiar with the 

service area. Run Books, on the other hand, are large scale maps that include a series of map 

pages along with a street index. They are combined in to a single map book and are placed in 

each apparatus to supplement maps provided on the MDC. Having an efficient way to produce 

station wall maps or run books ensure each hardcopy map product reflects changes that may 

occur in a community. Fire Service Maps is typically implemented by fire departments that want 

to quickly produce a standard set of hardcopy maps for their community. 

The Fire Service Maps solution delivers a set of capabilities that help you produce station wall 

maps and run books for each fire response district and combine them in single map book when 

necessary. 

 

Requirements 
Fire Service Maps requires the following: 

• ArcGIS Enterprise 10.7 - 10.8.1 

• ArcGIS Pro 2.7 or later 

• ReportLab 3.4.0 or later 
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Information products 
Fire Service Maps includes the following information products: 

Fire 

Service 

Maps Description 

Minimum user 

type 

Fire 

Service 

Maps 

An ArcGIS Pro project used by fire fighters to produce wall 

maps and run books that are placed in a fire station or 

apparatus to assist with response activities. 

GIS 

Professional 

Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Fire Service Maps 
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Configure Fire Service Maps 
In this workflow, you will learn how to configure the Fire Service Maps solution to meet specific 

needs in your organization. 

 

Configure Fire Service Maps project 
The Fire Service Maps solution includes an ArcGIS Pro project and sample data you can use to 

explore the sample data schema and a set of tools. When you are ready to configure the 

project, a series of tasks are included to help you review the data, make modifications to the 

maps and layers, load your data, and set the data sources to your data. 

1. Start ArcGIS Pro and open the Fire Service Maps project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service Maps task 
item. 

4. In the Task Pane, click the Configure Fire Service Maps task group to expand the 
collection of tasks. 

 

Review schema 
The Fire Service Maps project contains two geodatabases. 

• Fire Service Maps Sample.gdb contains sample data for learning how to use the tools. 

• Fire Service Maps.gdb contains empty layers fields that can be used to create Fire Run 
Books and Fire Station Wall Maps with your data. 

Use this task to review the geodatabase schema, layers, and fields to determine what changes 

you will need to make to use your data. See Fields, domains, and subtypes to learn more about 

how to edit the feature layer schema. 

 

Define spatial reference 
The Fire Service Maps.gdb is an empty geodatabase with the same schema and a spatial 

reference set to Web Mercator. This geodatabase can be used to define your spatial reference 

and load your data. 

Use this task to define the spatial reference for your data. See Specify a coordinate system to 

learn more about coordinate systems for your data. 

 

Load data 
After you have completed any necessary schema modifications, you can add your data layers to 

the map and load them into the empty Fire Service Maps geodatabase by following the steps in 

the Load data task. This task contains steps to load your data into the following layers: 
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Layer name Description 

Site Addresses Used to label building addresses in the fire service maps 

Roads Used to label road names and address ranges along a road. It is also 

used to create the street index report. 

Fire Response 

Restrictions 

Used to display the location of access restrictions such as gates, narrow 

roads, and blocked roads that would delay or preclude a fire truck in 

response to an incident 

Fire Map Index Used to create individual pages in Fire Run Books 

Response Areas Used to display administrative and response districts 

As you load your data into each layer, you will be given the option to use the field map 

capabilities to map your data fields to the predefined fields in the empty feature layers. 

 

Set data sources 
Use this task to replace the sample data with your data for each layer in the Fire Service Maps 

project. 
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Use Fire Service Maps 
The Fire Service Maps solution delivers a set of capabilities that help you produce station wall 

maps and run books for each fire response district and combine them in single map book when 

necessary. Fire Station Wall Maps can be produced for individual fire stations or combined into 

a single station wall map. Run books can also be produced for individual fire stations or 

combined into a single run book for the entire fire department. 

In this topic, you’ll learn how to use the Fire Service Maps solution by assuming the role of the 

user and performing these workflows. 

 

Understand Fire Service Maps 
While maps have made their way on to public safety mobile data computers (MDC), two primary 

hardcopy maps are still produced for reference in the fire service. Station wall maps are 

generally small scale maps hung on the wall of each fire station to help new personnel become 

more familiar with the service area. Run Books, on the other hand, are large scale maps that 

include a series of map pages along with a street index. They are combined in to a single map 

book and are placed in each apparatus to supplement maps provided on the MDC. 

To learn more about the elements contained in each fire service map, follow these steps: 

1. Sign in to your ArcGIS organization and browse to the Fire Service Maps Desktop 
Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Fire Service Maps ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service Maps task 
item. 

6. In the Task Pane, click the Getting to know Fire Service Maps task group to expand the 
collection of tasks. 

7. Click on the Understand Fire Service Maps task and follow the steps provided. 

 

Install ReportLab 
ReportLab is a third-party Python library that can be used to create a street index in PDF format. 

The street index makes it easy to look up an address or street name and find the correct map 

page in a Fire Run Book. To install ReportLab, follow these steps: 

1.  Open the Fire Service Maps ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service Maps task 
item. 

4. In the Task Pane, click the Getting to know Fire Service Maps task group to expand the 
collection of tasks. 
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5. Click on the Install Report Lab task and follow the steps provided. 

 

Create fire run book 
Fire Run Books include a cover page, several map pages, and a street index for each fire 

response district. They can be printed, placed in each apparatus, and used en-route to a call. 

You will assume the role of a fire fighter responsible for producing a fire run book for your 

response district or fire department. The Fire Service Maps ArcGIS Pro project includes a series 

of tasks to help guide you through this workflow. 

1.  Open the Fire Service Maps ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service Maps task 
item. 

4. In the Task Pane, click the Create fire run book task group to expand the collection of 
tasks. 

5. Click on the Create cover page task. Follow the steps provided in this task and all 
subsequent ones. 

 

Create station wall map 
Station Wall Map are large-format wall maps that can be printed for each fire response area and 

hung near an engine or apparatus. The printed wall maps are used by fire personnel for route 

navigation before leaving the station. 

You will assume the role of a fire fighter responsible for producing a station wall map for your 

response district. The Fire Service Maps ArcGIS Pro project includes a series of tasks to help 

guide you through this workflow. 

1. Open the Fire Service Maps ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Fire Service Maps task 
item. 

4. In the Task Pane, click the Create station wall map task group to expand the collection of 
tasks. 

5. Click on the Create station wall map task. Follow the steps provided in this task and all 
subsequent ones. 
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Flood Impact Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Flood Impact Analysis 
Flood Impact Analysis can be used to develop localized flooding scenarios and visualize the 

impact of flooding on public infrastructure, critical facilities, and vulnerable populations. 

The solution allows you to understand and visualize the impact of flooding on the community by 

using flood depth and elevation data to analyze the impact of river flooding, storm surge, tidal 

surge, and sea level rise scenarios. The results of the analysis can be used to plan road 

closures, prioritize evacuation areas, and develop mitigation strategies. Flood Impact Analysis is 

typically implemented by emergency management, public works, and planning organizations 

that want to prepare for future flooding to protect their communities. 

The Flood Impact Analysis solution allows you to prepare flood depth and elevation data, define 

flood impact areas, visualize the flood in 3D, and share the information with the public or other 

organizations. 

 

Requirements 
The Flood Impact Analysis solution requires the following: 

• ArcGIS Enterprise 10.7 - 10.8.1 

• ArcGIS Pro 2.5 - 2.9 (Advanced) 

• The ArcGIS Spatial Analyst extension 

• The ArcGIS 3D Analyst extension 

 

Information products 
Flood Impact Analysis includes the following information products: 

Item Description 

Minimum User 

Type 

FloodImpactAnalysis.ppkx An ArcGIS Pro project package used by 

mapping technicians to create flood impact 

maps 

GIS Professional 

Advanced 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Flood Impact Analysis 
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Use Flood Impact Analysis 
The Flood Impact Analysis solution delivers a set of capabilities that help you to prepare flood 

depth and elevation data, define flood impact areas, visualize the flood in 3D, and share the 

information with the public or other organizations. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Get to know Flood Impact Analysis 
You will assume the role of a mapping technician responsible for analyzing the potential flood 

impact for your community. The Flood Impact Analysis ArcGIS Pro project includes a series of 

tasks to help guide you through these workflows. The first set of tasks will help you get to know 

Flood Impact Analysis. 

Get to know Flood Impact Analysis by completing the following steps: 

1. Start ArcGIS Pro and open the Flood Impact Analysis project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Getting to know 
Flood Impact Analysis task and go through each subtask. 

 

Understand the Flood Impact Analysis solution 
Flood Impact Analysis supports a series of workflows that streamline the process of developing 

flooding scenarios to help plan for a flood event. These workflows include preparing the data for 

analysis, defining the flood impact area and the impact on infrastructure, facilities and buildings, 

sharing the flood impact information, visualizing the flood impact in 3D, and sharing the impact 

in 3D. 

This task will introduce you to the capabilities, data requirements to analyze flood impact, and 

visualization in 3D. 

 

Download sample data 
Sample data is provided to help you learn how to use the Flood Impact Analysis solution. A link 

is provided to download sample data for Baltimore. Using the sample data the first time will help 

you learn how to use the tasks and how to organize your data. 

 

Start using Flood Impact Analysis 
The Flood Impact Analysis project includes a task workflow that provides a structured sequence 

using tasks and steps. Follow the steps in this task to learn how to use the Flood Impact 

Analysis solution. 
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How to use Flood Impact Analysis 
You will assume the role of a mapping technician responsible for creating the flood impact 

analysis and sharing the results with emergency management, public works, and planning 

agencies. The Flood Impact Analysis ArcGIS Pro project includes a series of tasks to help guide 

you through the workflows below. 

To conduct the flood impact analysis, complete the following steps: 

1. Start ArcGIS Pro and open the Flood Impact Analysis project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the How to use Flood 
Impact Analysis task. 

4. In the Task Pane, click the How to use Flood Impact Analysis task group to expand the 
collection of tasks. 

5. Follow the steps in each task. 

 

Prepare flood depth and elevation data 
Accurate analysis and visualization of the flood impact analysis will depend on several factors 

such as: availability of flood depth data in the form of raster, ground elevation data such as 

Digital Terrain Model (DTM) or lidar, and features describing the assets to be analyzed such as 

roads, bridges, and buildings. The data preparation workflow includes a series of tasks to help 

prepare the data for analysis. A description for each task in this group is listed below. 

 

Prepare flood depth rasters 
Flood depth data is necessary to determine flood impact to the community at each flood stage. 

Flood depth grids or raster files contain a flood depth value within each cell in the raster. Flood 

depth at a given point can help determine the impact to buildings, roads, or bridges. 

The risk value for each raster is read from the riskTypeTable for the chosen risk type. You can 

find the riskTypeTable in the FloodImpactAnalysis.gdb. You can use the existing risk types, 

modify them, or you can add another entry. 

To remove negative values, extract flooded areas, and create the flood depth geodatabase, 

follow the steps in the Prepare flood depth rasters task. 

 

Prepare a water surface elevation raster 
Water surface elevation (WSE) includes a value within each raster grid cell. However, the value 

describes the elevation of the water surface within each grid cell and is a measurement from a 

fixed zero elevation such as provided in the NAVD88 vertical datum. Water surface elevation 

data can be used to calculate bridge heights above flood stages and to visualize the flood 

stages as 3D surfaces. 
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To create a water surface elevation raster, extract flooded areas, and crate the water surface 

elevation input geodatabase, follow the steps in the Prepare water surface elevation raster 

task. 

 

Define flood impact 
Effective flood response planning begins with a better understanding of the potential flood 

impact. This task is designed to step through a standardized process to create and analyze the 

impact of each flood scenario on your community. A flood scenario can be defined in the risk 

type table as a percent chance of flooding, historical average such as 100 year, or number of 

feet above normal. A description for each task in this group is listed below. 

 

Create flood impact areas 
The flood impact area defines the geographic extent for each flood depth scenario. The flood 

depth data prepared in the Prepare flood depth and elevation data task group will be used to 

create the flood impact area. These flood impact areas will be the foundation for analyzing 

impact to buildings, roads, or bridges in each of the subsequent tasks. 

To create flood impact areas and add them to the map, follow the steps in the Create flood 

impact areas task. 

 

Analyze roads 
This task allows you to analyze impacted roads by calculating depth of flooding for each road 

segment for any number of flood levels. The flooded roads can be an impediment to successful 

evacuations for first responders and community members when it is unknown which roads will 

be impacted. You can also symbolize the impacted roads for each flood impact area. The result 

will be a new feature class representing road segments with a depth attribute for each flood 

scenario. 

To analyze impacted roads and symbolize the impact, follow the steps in the Analyze roads 

task. 

 

Analyze low water crossings 
This task allows you to calculate depth of flooding for each low-level crossing for each flood 

scenario. The result can be used to identify watch points for observers to report flood depth 

during the flooding event. The parameters for this step are similar to the road flood depth except 

for the buffer distance. If this distance is specified to be greater than zero, the analysis will run 

against the buffered input features. This parameter helps you find points within the buffer 

distance that have been misplaced. You can then symbolize the low-level crossings by flood 

depth. 

To identify low water crossings and symbolize the impact, follow the steps in the Analyze low 

water crossings task. 
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Analyze bridges 
Use this task to calculate the bridge height above flood water surface for each flood scenario. 

Some bridges may have one side that is lower than the other. The bridge geometry is needed to 

calculate the height above the water surface instead of a single point along the bridge. 

Therefore, the bridge needs to be a 3D polygon feature instead of a 2D feature. This task will 

extract bridge surfaces from a lidar point cloud as 3D polygons, so they can be used in the next 

task to determine the height above flood level. 

Note: 

This task requires lidar point data stored in a LAS dataset . The bridge surfaces must have 
a separate class code in the LAS dataset. 

Note: 

This task requires that you have a water surface elevation (WSE) geodatabase as 
described in the Prepare flood depth and elevation data task. 

Tip: 

The result of this task is a new point feature with the minimum height above water surface 
for each water level in the WSE geodatabase. You can label the point with the minimum 
height attribute value to show how much clearance there will be below the bridge or how 
deep the water will be over the bridge if the height above water has a negative value. 

To analyze impacted bridges and symbolize the impact, follow the steps in the Analyze bridges 

task. 

 

Analyze buildings 
Understanding building exposure to flooding can help response personnel prioritize evacuations 

and stage equipment where it can be used effectively. It can also help mitigation planners 

understand buildings that are good candidates for purchase and removal. Use this task to 

calculate flood exposure on building polygons or 3D building multipatch feature layers. The tool 

will use your water depth geodatabase and the specified risk type to calculate the flood depth 

exposure to each building within the flood impact area. You can then symbolize the features 

according to the calculated flood exposure attribute such as the flood depth. Using a graduated 

color ramp will allow you to illustrate the severity of the building exposure. 

To analyze impacted buildings and symbolize the impact, follow the steps in the Analyze 

buildings task. 

 

Share flood impact information (optional) 
Once the analysis is completed, share the results with community stakeholders who can use the 

information to begin flood response or mitigation planning. Use this task to choose which flood 
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impact layers to share, such as the flood impact area, impacted roads, bridges, and buildings for 

each flood scenario. Share the results for each flood scenario. 

Note: 

These tasks require ArcGIS Online or ArcGIS Enterprise 10.5 or later. 

To allow others to see the results of the analysis, follow the steps in the Share flood impact 

information task. 

 

Visualize flood scenarios in 3D (optional) 
The best way to communicate the impact of a flood scenario is to show how it will impact 

homes, streets, bridges, and neighborhoods. Visualizing the flood scenario in a 3D scene is a 

compelling way to communicate the potential flood impact in your community. 

Note: 

These tasks require ArcGIS Online or ArcGIS Enterprise 10.5 or later. 

 

Show flood impact map in 3D 
This task allows you to convert the map containing the results of the flood impact analysis to a 

3D scene using 3D symbology and scene elevation. A digital terrain model (DTM) raster can be 

added to the 3D scene to provide a realistic scene for illustrating the impact of the flood. 

 

Create 3D flood levels from raster 
This task allows you to create 3D flood levels from raster input data. The result is a 3D version 

of the 2D raster data. For example, you may want to show a flood impact area at 5 feet against 

a building to illustrate the depth of flood on the building. 

 

Source 3D basemap data (optional) 
Visualization of 3D flood levels is more powerful when shown together with other 3D layers such 

as 3D buildings, 3D trees, and detailed elevation. Use your organization's 3D basemap to 

complement your flood impact map. If your organization does not have a 3D basemap, use 3D 

Basemaps to create your own 3D buildings, trees, and elevation surface. 

 

Create a depth elevation raster 
A depth elevation raster can improve the visualization of flood impact in 3D scenes, particularly 

in flood scenarios with very shallow flooding. Use the Create depth elevation raster task to 

create the depth elevation raster. You can repeat this task for every water surface elevation 

(WSE) raster. 
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To convert the map to a 3D scene and add the depth elevation raster, follow the tasks in the 

Visualize flood scenarios in 3D task group. 

 

Publish a 3D flood impact scene (optional) 
Once the task to visualize 3D flood scenarios is completed, you can publish a 3D web scene for 

your flood impact scenarios. The 3D web scene can be shared with stakeholders who are 

responsible for flood response planning and flood mitigation planning. 

Note: 

These tasks require ArcGIS Online or ArcGIS Enterprise 10.5 or later. 

 

Publish a 3D flood impact scene 
Use this task to set the coordinate system and publish the new 3D scene to ArcGIS Online or 

your organization. 

 

Share the depth elevation raster 
Use this task to share the depth elevation raster that was created previously to help improve the 

visualization of the 3D scene. 

To share the flood impact in 3D, follow the tasks in the Share 3D flood impact scene task 

group. 

After you have shared the 3D scene and depth elevation raster, you can view the results of the 

Flood Impact Analysis in a Scene Viewer in ArcGIS Online or ArcGIS Enterprise. Share the 

scene with your colleagues to help them understand the impact of local flooding on your 

community. 
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Multi Source Data Feeds 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2021 - Oct 2023 

Retired phase 
Nov, 2023 

 

Introduction to Multi Source Data Feeds 
Multi Source Data Feeds solution can be used to visualize global incidents in ArcGIS. 

Businesses need access to critical information with confidence, to enable organizational 

response to incidents at different levels and across different business units. This is needed to 

allow organizations to see beyond the horizon and react to real-time incidents across the globe. 

Round-the-clock access to incident data is at the cornerstone of this need. Multi Source Data 

Feeds is typically implemented by organizations that rely on event feeds to understand incidents 

across the globe. 

The Multi Source Data Feeds solution delivers a set of capabilities that provides awareness in 

near real time to incidents around the globe. This access is enabled by Esri business partners 

that curate event information into one location and allow consumption through the business 

partner APIs. 

 

Requirements 
Multi Source Data Feeds requires the following: 

• ArcGIS Enterprise 10.7.1 - 10.8.1 

• ArcGIS Pro 2.6 - 2.8 (Basic) 

 

Information products 
Multi Source Data Feeds includes the following information products: 

Item Description 

Minimum user 

type 

Dataminr Alerts 

Dashboard 

An ArcGIS Dashboards app used to visualize and 

interact with incidents from Dataminr 

Viewer 

Factal Incidents 

Dashboard 

An ArcGIS Dashboards app used to visualize and 

interact with incidents from Factal 

Viewer 
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Multi Source Data 

Feeds Desktop 

An ArcGIS Pro project package used to connect 

and ingest data feeds from a variety of data 

providers 

GIS Professional 

Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.1 • Shortened the field length for all fields to cut down on storage. 

• Added support to store credentials in Credential Manager. 

1.0 • First release of Multi Source Data Feeds 
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Configure Multi Source Data Feeds 
In this topic, you will learn how to configure the Multi Source Data Feeds solution to meet 

specific needs in your organization. 

 

Review the Multi Source Data Feeds project 
The Multi Source Data Feeds solution includes an ArcGIS Pro project. Before configuring the 

solution and using the workflows with your data, familiarize yourself with the contents of the 

Multi Source Data Feeds Desktop project. 

To review, complete the following steps: 

1. Start ArcGIS Pro. 

Note: 

Ensure that you are signed in to the user name with which Multi Source Data Feeds was 
deployed. 

2. In the lower right corner, click Open another project. 

3. In the left pane under Portal, click My Content and browse to the folder where Multi 
Source Data Feeds was deployed. Select Multi Source Data Feeds Desktop and click OK 
to open. 

4. Click the View tab along the top of the ribbon. 

5. Click Tasks in the Windows group to open the Multi Source Data Feeds Tasks to 
configure, manage, and automate the data feeds. 
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Use Multi Source Data Feeds 
The Multi Source Data Feeds solution delivers a set of capabilities that provides awareness in 

near real time to incidents around the globe. This access is enabled by Esri business partners 

that curate event information into one location and allow consumption through the business 

partner APIs. 

Note: 

To view content from premium providers, API keys must be acquired from the data 
provider. 

In this topic, you will learn how to use the Multi Source Data Feeds solution and the set of 

capabilities and features that it provides. 

 

Explore the Dataminr dashboard 
1. In a browser, sign in to your ArcGIS organization and click the Content tab. 

2. On the left side, under Folders, click Multi Source Data Feeds. 

3. Click the Dataminr Alerts Dashboard to open into the item description page, then click 
View Dashboard. 

4. Zoom in to an area of interest in the United States. 

  Note: 

  Holding the Shift key on your keyboard enables the area selection tool in the map. This will 
zoom in to the extent of the selected area. 

  Notice as you zoom in or pan around, the set of metrics along the bottom of the application 
and the alerts in the list on the left side dynamically update. This map-driven capability 
provides context into what is within your view. 

5. Along the bottom of the map are a set of tabs; click Data Overview. 

  This tab contains a set of metrics to provide context into the magnitude of alerts over time 
and by category. The metrics are based on alerts within your view. 

6. Switch to the Map Overview tab and in the Publisher Category drop-down list, select a 
value. 

  Notice that with this filter enabled, the set of metrics along the bottom of the application, the 
alerts in the list on the left side, and the map automatically update. 

7. Click an incident in the list. This will zoom to the selected feature and open the pop-up with 
additional alert details. 

8. Scroll to the bottom of the pop-up and click the link to view more details on this alert in 
Dataminr by signing in to your Dataminr account. 
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Explore the Factal dashboard 
1. In a browser, sign in to your ArcGIS organization and click the Content tab. 

2. On the left side, under Folders, click Multi Source Data Feeds. 

3. Click the Factal Incidents Dashboard to open into the item description page, then click 
View Dashboard. 

4. In Filter Incidents by, click This Week. 

  Notice that with this filter enabled, the inset map and the set of metrics along the right side 
of the application, the locations in the list on the left side, and the map automatically 
update. 

5. Zoom in to an area of interest in the United States. 

  Note: 

  Holding the Shift key on your keyboard enables the area selection tool in the map. This will 
zoom in to the extent of the selected area. 

  Notice as you zoom in or pan around, the set of metrics along the right side of the 
application and the locations in the list on the left side dynamically update. This map-driven 
capability provides context into what is within your view. 

6. Along the bottom of the map are a set of tabs; click Data Overview. 

  This tab contains a set of metrics to provide context into the magnitude of incidents over 
time. The metrics are based on incidents within your view. 

7. Switch to the Map Overview tab and click on an incident in the list. This will zoom to the 
selected feature and open the pop-up with additional incident details. 

  Notice the inset map on the right side of the application zooms in and centers on the 
incident. This map provides regional context and awareness of where other incidents have 
appeared. 

8. Scroll to the bottom of the pop-up and click the link to view more details on this incident in 
Factal by signing in to your Factal account. 
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My Trash Services 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to My Trash Services 
My Trash Services can be used to share waste pickup schedules and recycling information with 

the general public. 

It provides 24/7 access to an organization, and the location-enabled search helps residents 

quickly find waste pickup schedules and recycling centers and learn what materials are 

accepted. This transparent approach improves communication with the public and addresses 

one of the most frequently asked questions in a community. My Trash Services is typically 

implemented by public works agencies and other local government organizations that want to 

educate the public and promote waste and recycling services available in their community. 

The My Trash Services solution delivers a set of capabilities that help you share typical waste 

pickup schedules with the public, highlight schedule changes, and promote nearby recycling 

centers and the materials accepted. 

 

Requirements 
My Trash Services requires the following: 

• ArcGIS Enterprise 10.6.1 - 10.8.1 

 

Information products 
My Trash Services includes the following information products: 

Item Description 

Minimum 

user type 

My Trash 

Services 

An ArcGIS Web AppBuilder app used by the general public to 

locate recycling centers and obtain information about curbside 

trash services 

Not required 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of My Trash Services 
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Configure My Trash Services 
In this topic, you'll learn how to configure the My Trash Services solution to meet specific needs 

in your organization. 

 

Load data 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to load. 

Then, load your existing data into the layers provided with the solution before sharing the maps 

or apps. 

Once you have determined what source data must be loaded, complete one or more of the data 

loading workflows below. 

 

Load data from a shapefile 
Load data into the PublicWorksDistrict and TrashRecyclingFacilities layers from a shapefile by 

completing the following steps: 

1. Create a .zip file of your shapefile. 

2. Sign in to your ArcGIS organization and browse to the feature layer you want to populate. 

3. Open the item page and click Update Data > Append Data to Layer. 

4.  Click Choose File and browse to your .zip file, and click Open. 

5. Click Upload and Continue. 

6. Click Choose the layer that you wish to append data into drop-down arrow and choose 
the layer that contains the updated data. 

7. Uncheck Update existing features. 

8. Click Show field matching and map the fields between the two layers. 

9. Click Apply Updates. 

 

Configure directions 
Follow the steps below to connect to a routing service and configure the widget to enable 

directions in the app. 

 

Configure widget 
To configure an app to use routes and provide directions, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the ArcGIS Web AppBuilder app. 

2. Open the item page and click Edit Application. 
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3. Click the Widget tab and click Set the widget in this controler to open the page for an in-
panel widget.  

4. Hover over the Near Me widget and click the Configure this widget button to open the 
widget configuration window. 

5. Check the Enable Directions check box if it is not checked. 

6. Click the Direction Settings tab, click Set, and choose a routing service. 

7. Click Next and choose one or more route layers, click OK, and click OK again. 

8. Save the app and share it with everyone. 

9. Open the app. 

 

Esri premium content 
The app draws routes and provides directions using the ArcGIS Online World Route Service. 

This service requires subscriber access because it consumes credits. See Configure Living 

Atlas content to enable access to premium content. 

Learn more about credit usage when creating simple routes 
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Use My Trash Services 
The My Trash Services solution delivers a set of capabilities that help you share typical waste 

pickup schedules with the public, highlight schedule changes, and promote nearby recycling 

centers and the materials accepted. 

Note:  

Use your organization's data or configured apps to follow these workflows. 

 

Find recycling centers and curbside service 

information 
You will assume the role of a resident in the community, and you want to know when your next 

trash pickup day is and find nearby recycling centers. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the My Trash 
Services solution. 

2. View the My Trash Services app. 

3. In the Locate Services widget, under Search for an address or locate on map, type an 
address in the community and press Enter. 

4. Optionally, click and slide the search buffer by distance. 

  Note: 

  The list updates to display recycling centers and trash, recycling, and yard waste pickup 
details. 

5. Click Recycling Facilities and click one of the facilities. 

  The Information tab displays details about the recycling facility, including materials 
accepted, location, hours of operation, and contact details. 

6. Click the Directions tab. The tab displays turn-by-turn directions from the searched 
address to the closest recycling facility. 

7. Click the Recycling Facilities button once to return to the list of recycling facilities, and 
click it again to return to the full list of trash and recycling services. 

8. Click Trash Pickup and review information and directions about trash pickup. 

9. Click the Back button to return to the full list of trash and recycling services. Repeat step 6 
to view recycling and yard pickup details. 
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Operations Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Operations Management 
Operations Management can be used to respond to an event and manage resulting missions. 

The solution allows military organizations to capture real-time data related to the event and 

mission development. Command leadership can collect and review reports submitted by 

operations personnel from any connected device. The solution enables immediate interaction 

between the technology and military personnel, allowing for rapid information dissemination and 

intelligent decision-making. Operations Management is typically implemented by organizations, 

such as the Army National Guard, that want to take a data-driven approach to plan, manage, 

and understand current missions associated with events. 

The Operations Management solution delivers a set of capabilities that help you to capture and 

update event and mission details, allocate resources, and gain situational awareness of 

resources and tasks against designated missions. 

Learn more about the Operations Management solution. 

 

Requirements 
Operations Management requires the following: 

• ArcGIS Enterprise 10.7.1 - 10.8.1 

• ArcGIS Survey123 

 

Information products 
Operations Management includes the following information products: 

Item Description 

Minimum 

user type 

Operations 

Dashboard 

An ArcGIS Dashboards app with embedded ArcGIS 

Survey123 forms that provides a dynamic method for 

input of events, missions, status reports, and field 

reports. 

Viewer 
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Operations 

Management 

Dashboard 

An ArcGIS Dashboards app used by command 

personnel to monitor events, missions, status reports, 

and field reports. 

Viewer 

Operations 

Manager 

An ArcGIS Dashboards app used by operations 

personnel to manage events and missions. 

Editor 

Event Entry An ArcGIS Survey123 form that can be used by a liaison 

or LNO to enter events. 

Not 

required 

Mission Entry An ArcGIS Survey123 form used by a liaison or LNO to 

enter missions. 

Not 

required 

Field Report An ArcGIS Survey123 form used by an LNO or military 

unit member to report on events in the field. 

Not 

required 

Status Report An ArcGIS Survey123 form used by a liaison or LNO to 

provide updates regarding the status of a mission. 

Not 

required 

Operations Events An ArcGIS Survey123 form that can be referenced as a 

master schema for all included surveys in Operations 

Dashboard. 

Not 

required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Operations Management 
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Configure Operations Management 
In this topic, you will learn how to configure the Operations Management solution to meet 

specific needs in your organization. The apps included with the Operations Management 

solution come with Survey123 reports. When launched using Portal for ArcGIS, the forms will 

have ItemIDs already assigned. Your solution deployment will include additional Survey123 

forms that need to be synced with newly deployed dashboards and web apps. Follow the steps 

below to configure the solution. 

 

Configure solution 
Once Operations Management has been deployed, the Survey123 ItemIDs must be updated for 

your data to be displayed in the applications. Follow the steps below to configure the Operations 

Dashboard and the Operations Manager applications. 

 

Configure Operations Dashboard 
To use the Operations Dashboard to enter events, missions, status reports, and field reports, 

complete the following steps to update the itemIDs: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Event Entry survey and open the Item Details page. 

3. Copy the Application ID  into a text editor. An 
example application ID is highlighted in the preceding image. 

4. Do the same for the Mission Entry, Status Report, andField Report surveys. 

5. Browse to the Operations Dashboard and select Edit Dashboard.  

6. Click the Events tab. 

7. Click Configure  for the Event Entry survey. 

8. In the URL section, replace the existing replaceitemid text with the one retrieved in step 

3. 

9. Add portalUrl=https://<yourportal>.esri.com/arcgis to the end of the URL.  

  This value will need to be replaced with your specific portal URL. The complete structure 
for the Event Entry survey URL will look similar to 
https://survey123.arcgis.com/share/a37dc89e02334ce3aa6656e58df6e334?porta
lUrl=https://<yourportal>.esri.com/arcgis. 

10. Click Done. 

11. Repeat steps 6 through 8 for the Mission Entry, Status Report, and Field Report surveys. 

12. For these surveys, add the following value to the end of the URL: 
&portalUrl=https://<yourportal>.esri.com/arcgis.  

  The complete structure for the Mission Entry survey will look similar to 
https://survey123.arcgis.com/share/a37dc89e02334ce3aa6656e58df6e334?field
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:parentglobalid={globalid}&field:event_id={event_id}&portalUrl=https://ex
ampleportal.esri.com/arcgis. 

13. Click Done. 

14. Click Save. 

 

Configure Operations Manager 
To use the Operations Manager to manage events and missions, complete the following steps 

to update the itemIDs for the Operations Manager map pop-ups: 

1. Browse to the Mission Entry survey and open the Item Details page. 

2. Copy the Application ID into a text editor. 

3. Do the same for the Status Report and Field Report surveys.  

4. Browse to the Operations Manager Map and click Open in Map Viewer. 

5. Click the Content tab to show the map contents.  

6. Click Events. 

7. Click the More Options button  and select Configure Pop-up. 

8. Click the Configure button to open the Custom Attribute Display window. 

9. Highlight the Submit a Mission hyperlink to activate the Create Link button. 

10. Click the Create Link button and replace the replaceitemid text with the itemID copied in 

step 2.  

11. Add &portalUrl=https://<yourportal>.esri.com/arcgis to the end of the URL. 

Make sure to replace the portal URL portion with your portal.  

12. Click Update and click OK. 

13. Save your application. 

14. Click Missions.  

15. Click the More Options button  and select Configure Pop-up. 

16. Click the Configure button to open the Custom Attribute Display window. 

17. Repeat steps 9 through 13 to replace the itemIDs within the hyperlinks for the Status 
Report and Field Report itemIDs copied in step 3. 

18. Save your application. 

 

Configure the Search widget 
To use the Search widget within Operations Manager, complete the following steps: 

1. Open the Operations Manager web app in editing mode. 

2. Click to open the Widget tab and select the Search widget.  

3. In the Layer Source section, select Set and browse to the current Events and Missions 
layer in the Portal for ArcGIS option. 
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– Alternatively, copy the updated Events and Missions map service URL and paste it 
in the Service URL option. 

4. Browse to Add Search Source. 

5. Click Feature Layer and select Events and Missions. 

6. Configure the rest of the widget and save your application. 

 

Add data sources 
The Operations Management solution allows operations management personnel to enter details 

about events and missions supporting events. It can be helpful to add additional data to provide 

context for feature entry and management. 

The layers listed below can be added to the map to provide further context when entering new 

events, missions, status reports, and field reports. 

Learn more about how to add layers to a map. 

• State and county layers 

– States map service 

– Counties map service 

– COVID-19 cases data feed 

• ArcGIS Living Atlas layers 

– National Weather Service Severe Events 

– National Weather Service Extreme Events 

• NOAA Web Services 

– NOAA Base Reflectivity Radar 

 

Extend the Operations Management Dashboard 
The Operations Management Dashboard is preconfigured to display all units under the 

Assigned To section within the Survey123 form. It also displays default mission statuses. You 

may need to configure the dashboard to align with your organization. 

 

Add a battalion 
To add additional battalions or companies to the dashboard, complete the following steps: 

1. Browse to the Operations Management Dashboard and click Edit Dashboard. 

2. In the Mission Assignment/Status element, click the Configure button . 

3. Go to the Data tab, select the Filter window, and under the Assigned To window, select 
Include. At this point, you will add only the units of interest and nothing else will be 
included. 
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4. Save your application. 

 

Modify mission status 
The dashboards are preconfigured to display various statuses. The statuses can be modified or 

removed. If your organization uses a status that is not included, ensure a new category is added 

to the Survey123 form before adding it to the Operations Management Dashboard. To modify 

the mission statuses, complete the following steps: 

1. Select any Mission Status element and go to Editing Features. 

2. Click the Duplicate button  to copy the setting of the existing indicator elements to add a 
new category. Make sure that the new category has been added to the Survey123 form 
first. 

3. Remove the status element by clicking the delete button . 

4. Save your application. 

 

Modify lists 
The dashboards included in this solution come with preselected and basic fields within their 

appropriate lists. Additional fields can be turned on when configuring your solution to better 

address your organization's needs. To modify lists, complete the following steps: 

1. Click the Configure button  for any of the list components within the dashboard. 

2. Select the List tab and click Insert  to see the field options available. 

3. Select one or multiple fields to be added to the display. 

4. Add a label in front of your field item. 

5. Click Done. 

6. Save your application. 

 

Extend Operations Manager 
The Operations Manager web application includes a Summary widget that provides a clustering 

feature that can be enabled. This feature will perform groupings of the features on the map 

indicating potential hot spots. The Operations personnel can use this clustering information to 

begin deploying assets and resources to areas that show high concentrations. 

 

Enable clustering 
To enable clustering in the Summary widget, complete the following steps: 

1. Access the Operations Manager web app while in editing mode.  

2. Go to the Widget tab and select the Configure this Widget option for the Summary 
widget. 
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3. Check Display as Summary Clusters. 

4. Click OK and save the application. 
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Use Operations Management 
The Operations Management solution delivers a set of capabilities that help you to capture and 

update event and mission details, allocate resources, and gain situational awareness of 

resources and tasks against designated missions. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Manage missions 
The Operations Dashboard provides the LNO or mission manager a single interface to submit 

events, missions, status updates for missions, and field reports. Operations Manager allows the 

operations personnel the freedom to filter data, modify or move events, and find specific 

information within a few seconds. Finally, command leadership can remain aware of current and 

historical missions in the Operations Management Dashboard. New events and missions can be 

added as frequently as needed. 

 

Enter a new event 
You will start by assuming the role of the event or mission manager. You have just received a 

request for assistance from Miami-Dade County in response to a hurricane. You will use the 

Event Entry survey to capture a new event. 

To capture a new event using the Event Entry survey, complete the following steps: 

1. In a browser, go to your Operations Dashboard.  

2. Select the Events tab in the lower right and fill in the following details:  

  Parameter   Value 

  Event ID   Type EVENT001. 

  Begin Date   Select the date 09/08/2020. 

  End Date   Select the date 09/15/2020. 

  Location   Draw a polygon along the Miami-Dade County area. 

  Event Type   Select Weather. 

  Event Sub 
Category ID 

  Select Hurricane. 

  Event 
Description 

  Type Hurricane Olga is moving at 15 mph with high 
winds of 175 mph. Hurricane Olga is approaching the 
Miami-Dade County geographical area and is located 
approximately 300 miles from the Florida coastline. 

3. Click Submit. 
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Enter a new mission 
You have now been asked to start capturing the missions related to Hurricane Olga. You will 

use the Mission Entry survey to capture mission information. 

To capture information about a new mission, complete the following steps: 

1. In a browser, go to your Operations Dashboard or refresh your current browser if you have 
just entered the event. 

2. Select the Hurricane Olga event from the events list widget. 

3. Select the Missions tab in the lower right. Notice that the EVENT001 event ID is 

automatically showing as part of the new Mission Entry.  

4. In the Mission Entry survey, fill in the following details: 

  Parameter   Value 

  Mission ID   Type MISSION001. 

  Location   Type LAT: 25.79496 LON: -80.12594. 

  Start Date   Select the date 09/08/2020. 

  End Date   Select the date 09/12/2020. 

  Mission Type   Select Personnel Support. 

  Mission Description   Type 150 personnel are needed to fill sandbags 
and place them in designated areas. 

  COVID related   Select No. 

  Mission Status   Select Pending Approval. 

  Mission Priority   Select Medium. 

  Assigned to ID   Select 1st Battalion. 

  Personnel Information 
ID 

  Select Yes. 

  Personnel Details   Select Other. 

  Enter # of Other 
Personnel 

  Type 150. Total Personnel will automatically fill. 

  Vehicle Information   Select Yes. 

  Vehicle and Aircraft 
Details 

  Select Yes. 

  Land Vehicle Type   Select Utility Truck and type 5 for the Quantity. 

  Estimate Cost   Select Yes. 

  Estimate Mission 
Cost/Day 

  Type 5000. 

  Submitter POC Details   Enter your name and contact information. 
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  Ground Commander 
POC Details 

  Enter commander point of contact details. 

5. Click Submit. 

 

Monitor missions 
Now, you will assume the role of the Operations Manager. You are asked to monitor the 

missions of your unit. You will review the missions of your workforce. 

To monitor a specific mission, complete the following steps: 

1. In a browser, go to the Operations Manager application. You will see an overview of the 
events and missions that have been entered. 

2. Click the Item details button . After reviewing the content, close the window. 

3. Type % in the Search widget. 

4. Select MISSION001 from the results. 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 177 

Plans and Drawings 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Plans and Drawings 
Plans and Drawings can be used to index the geographic extent of record plans and drawings 

and provide access to a catalog of source documents in the office or the field. 

Design drawings, construction plans, as-builts, and other source documents contain vital 

information that is used daily by engineers and field staff to make infrastructure improvements. 

Many times, these drawings have been automated and are cataloged in a document 

management system, but some drawings may only exist in hardcopy format and be stored in an 

office file cabinet. And while each of these record drawings may represent a given geography, 

understanding the extent of the record drawing and whether it contains the information you are 

looking for can be quite time consuming. Plans and Drawings is typically implemented by public 

works agencies and utilities that want to simplify access to record drawings and ensure that 

engineers and field staff understand what drawings exist at a given location. 

The Plans and Drawings solution delivers a set of capabilities that help you index record 

drawings, associate a geographic extent with each drawing, and provide access to a catalog of 

plans and drawings in the office or the field. 

 

Requirements 
Plans and Drawings requires the following: 

• ArcGIS Enterprise 10.7.1 - 10.8.1 

 

Information products 
Plans and Drawings includes the following information products: 

Item Description 

Minimum 

user type 

Plan 

Catalog 

An ArcGIS Web AppBuilder app used by public works staff to 

access a catalog of record drawings, as-builts, and other source 

documents 

Viewer 
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Plan 

Index 

An ArcGIS Web AppBuilder app used by public works staff to 

index the geographic extent of record plans and drawings 

Editor 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Plans and Drawings 

 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 179 

Use Plans and Drawings 
The Plans and Drawings solution delivers a set of capabilities that help you index record 

drawings, associate a geographic extent with each drawing, and provide access to a catalog of 

plans and drawings in the office or the field. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note:  

Use your organization’s data or configured apps to follow these workflows. 

 

 

Index plans and drawings 
First, you will assume the role of a public works engineer. You need to index a record drawing 

submitted for a recent project. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Plans and 
Drawings solution. 

2. View the Plan Index app. 

  The Index Plan widget allows you to create a geographic extent for your project. 

3. To create a new plan, click the Plans and Drawings template. 

4. Click the map to draw the geographic extent around the project location, and then double-
click to finish drawing the polygon. 

  Note: 

  You can use the Search widget to quickly update the map extent to desired addresses, 
place-names, or locations of existing projects. 

5. After you draw the geographic extent, you are prompted with a Plans Index form. 

6. Complete the form with as much information as possible. 

  Tip: 

  In the Document Path text box, type a URL or other resolvable file path to your 
organization's existing document repository solution. 

  In the Document Location Description text box, describe the physical location if 
documents are not stored in a digital format with a resolvable document path, link, or URL. 
For example, type Public Works Building, 2nd Floor in the 2022 Projects 
cabinet. 

7. Scroll to the Attachments option. 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 180 

Note:  

The Attachments option is useful for uploading before-and-after photos related to the 
project and other relevant project media. 

8. Optionally, add attachments. 

9. Click Save to complete the indexing workflow. 

 

View plans and drawings 
After they are indexed, record drawings can be accessed from the office or the field. Now, you 

will assume the role of an engineer at a local utility who needs to access pertinent plans and 

drawings while in the field on a site visit to a new infrastructure project. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Plans and 
Drawings solution. 

2. View the Plan Catalog app. 

  The app opens with the Filter Plans widget open on the right. Filters are active by default; 
filtering by project type or date automatically updates the results in the map. 

3. In the Filter Plans widget, adjust the filters to refine the results. 

4. On the map, click a project extent. 

  A pop-up with more information about the project appears. In addition to providing project 
information, the pop-up includes a Document ID link, if available. 

5. If available, click the Document ID link to open the referenced plan or drawing associated 
with this project.  

  The link opens in a new browser tab. 

 

Share a record drawing link 
A colleague has requested information about the record drawing for a bridge project that you 

recently indexed. You will use the Plan Catalog to create a direct link to the project details and 

share with your colleague. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Plans and 
Drawings solution. 

2. View the Plan Catalog app. 

3. At the upper right, click the Share button to open the widget. 

  In the Share widget, under Share a link to this app, there is a pregenerated link. By 
default, this short link uses your app's current map extent. In the following steps, you will 
construct a query within the share link so that it opens a specific project detail when 
opened. 

4. Click Link Options. 

5. Click Query a feature and zoom to it.  
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  The drop-down lists that appear must be completed to generate a project-specific app link. 

6. Click the first drop-down arrow and choose Plans and Drawings. 

7. Click the second drop-down arrow and choose projname. 

8. Click the third drop-down arrow and search for or choose the project that you want to 
share.  

9. At the top of the widget, click the Back arrow. 

  The sharing short link is now updated using your project query information. 

10. Below the short link, click the Email button to launch a pregenerated email with your 
custom app link.  

  A draft email opens in your device’s default email handler. Alternatively, you can copy the 
short link from the Share a link to this app text box. If you have accessed the Plan 
Catalog app from a mobile device, you can use this link to share a record by text message 
or other messaging app. 
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Readiness Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Readiness Management 
Readiness Management can be used to understand and communicate comprehensive unit and 

force readiness. 

It provides leaders and decision makers an understanding of available personnel resources and 

allows them to share authoritative data of assigned and attached forces. Units may be 

requested to assist in setting up traffic control points, helping with debris removal, preparing 

alternate care facilities, supporting food distribution, and so on. Having personnel perform a 

routine check-in or having someone from the armory or unit provide the readiness status of a 

group of personnel gives units clarity about force readiness. Readiness Management is typically 

implemented by the National Guard, Air National Guard, and other service branches that want 

to take a data-driven approach to understanding force availability. 

The Readiness Management solution delivers a set of capabilities that help you understand the 

operational capacity of a force, monitor the status of units, and communicate capabilities and 

disruptions to commanders and administrative staff. 

Learn more about the Readiness Management solution. 

 

Requirements 
Readiness Management requires the following: 

• ArcGIS Enterprise 10.7.1 - 10.8.1 

• ArcGIS Survey123 

 

Information products 
Readiness Management includes the following information products: 

Item Description 

Minimum 

user type 

Admin Dashboard An ArcGIS Dashboards app used by administrative 

NCOs to monitor personnel availability 

Viewer 
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Readiness 

Dashboard 

An ArcGIS Dashboards app used by any unit member 

to track and monitor personnel readiness and 

availability. 

Viewer 

Personnel 

Readiness Report 

An ArcGIS Survey123 form used by a military unit 

member to report availability. 

Not required 

Personnel 

Readiness Batch 

Report 

An ArcGIS Survey123 form used by an NCO or 

armory clerk to report the availability of their 

personnel. 

Not required 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Readiness Management 
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Configure Readiness Management 
In this topic, you will learn how to configure the Readiness Management solution to meet 

specific needs in your organization. 

 

Extend readiness surveys 
Included with Readiness Management are a series of surveys that can be used to understand 

the capacity of your workforce. 

Review the preconfigured questions and adjust as necessary to remain in compliance with your 

organizational policies and any applicable laws. Additionally, ensure that you secure the survey 

and underlying layers and only share the content with appropriate members of your 

organization. 

 

Update feature layer views 
The Readiness Management solution includes a series of views created from the Personnel 

Readiness feature layer. The feature layer is used in the surveys, and the subsequent views are 

used in the dashboards. Organizations can modify the Personnel Readiness Report surveys 

and ultimately add new fields to the feature layers. When doing so, the new fields must be 

exposed in the appropriate views. 

To add one or more fields to a layer and re-create the views, complete the following steps: 

1. Browse to the view in your contents. 

2. Click the Visualization tab. 

3. Click the Options button  on the appropriate layer or table and click Set View 
Definition. 

4. Click Define Fields. 

5. Scroll to the newly created field and check the box. Click Apply. 

  The new field is added to the view's definition. 

6. Repeat steps 1 through 5 for the Readiness Dashboard. 

7. Update the Readiness Dashboard to account for the new fields you added to the layers. 

 

Modify readiness surveys 
To modify a Readiness Management survey, complete the following steps: 

1. Install ArcGIS Survey123 Connect. 

2. Start ArcGIS Survey123 Connect and sign in to your ArcGIS organization.  

3. Click Personnel Readiness Report to download the survey.  

4. Click the Personnel Readiness Report again to open the survey. 
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5. In the left pane, click Open XLSForm Spreadsheet. 

6. In the Microsoft Excel spreadsheet, click the Choices tab. This tab contains the selectable 
options for survey questions. 

7. Revise the survey to reflect your personnel readiness needs. 

8. Save the Microsoft Excel spreadsheet and preview your changes using the ArcGIS 
Survey123 Connect form preview. 

9. In ArcGIS Survey123 Connect, click Publish in the left pane to publish your changes. 

To modify the Battalion or Company names in the Personnel Readiness Report or Personnel 

Readiness Batch Report, you will need to also account for the modification of the calculation in 

the choice_filter column of the Survey123 Connect XLSForm. The choice_filter column 

controls the cascading select functionality associated with each of the battalions and companies 

that fall within it. 

For example, in the Personnel Readiness Report, if you select 1st Battalion, the next 

question asking for Company will be limited to only those companies in the 1st Battalion (A–D). 

Likewise, if you select 2nd Battalion, you see companies in the 2nd Battalion (E–H). 

Learn more about how to work with cascading selects. 

 

Configure echelons 
The dashboards are preconfigured to display four battalions and four companies under each 

battalion. Follow the steps below to add or remove battalions or companies from your 

dashboard. 

 

Add a battalion 
To add additional battalions or companies to the dashboard, complete the following steps: 

1. Sign in to your ArcGIS Online organization. 

2. Browse to the Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the last battalion tab while in edit mode. 

5. Go to the editing tool in this element and select Duplicate. 

6. Drag the newly created copy below the last battalion tab. 

7. Reference duplicated battalion settings, text, and configuration. 

8. Add a new name, for example, 5th BN, to the new component. 

9. Save your application. 

 

Remove a battalion tab 
To remove battalions or companies from the dashboard, complete the following steps: 
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1. Sign in to your Portal for ArcGIS. 

2. Browse to the Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the battalion tab you want to delete while in edit mode. 

5. Click the Delete button  to delete the selected battalion. 

6. Save your application. 

 

Configure alternate reporting periods 
The dashboards are preconfigured to display individuals reporting within the last 24 hours. The 

dashboard owner can configure the dashboard to display alternate reporting periods. The 

Personnel List parameter is the most commonly configured element related to its contents and 

time frame. 

To modify the reporting period, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Go to the editing tool in the Personnel List element and select Configure. 

5. Below Battalion, select the And option and add Date Reported from the drop-down list.  

  You can now select from any of the available options and time frames. 

6. Select Done and save your application to display the new reporting period. 

 

Add readiness tabs for new battalions and companies 
The dashboards are preconfigured to display four battalions and four companies and their 

applicable total force or unit size. This tab also contains their availability of personnel based on 

survey submissions and percentage of readiness. 

To add additional percentages of readiness to the dashboard, complete the following steps: 

1. Sign in to your Portal for ArcGIS. 

2. Browse to the Readiness Dashboard and open the item details page. 

3. Click Edit Dashboard. 

4. Select the 3rd Battalion tab while in edit mode. 

5. Go to the editing tool in the Personnel List element and select Duplicate. 

6. Drag the newly created copy below the 3rd Battalion tab. Reference the 3rd Battalion 
settings, text, and configuration. 

7. Add a new name, such as 5th BN, to the new component and save your application. 

8. Go to the Reference section in the configuration tool and add the unit size below Fixed 
Value. 
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  This number provides the available value and percentage of readiness. 

9. Follow the previous step and enter the current Total Force value for each unit level. 

10. If you need to remove a battalion tab, click the Delete button .  

11. Save your application. 
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Use Readiness Management 
The Readiness Management solution delivers a set of capabilities that help you understand the 

operational capacity of a force, monitor the status of units, and communicate capabilities and 

disruptions to commanders and administrative staff. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Monitor force readiness 
Some organizations may find it more efficient to have an individual, such as someone from the 

armory, check in their unit member using the Personnel Readiness Batch Report survey. If a 

unit decides to use the batch survey, follow the same general steps below with the Personnel 

Readiness Batch Report survey and the Readiness Dashboard. 

 

Complete an individual readiness report 
You will start by assuming the role of a military unit member. You are asked to use the 

Personnel Readiness Report survey to share your availability status each morning. 

1. In a browser, go to your Personnel Readiness Report survey. 

2. In the Personnel Readiness Report survey, fill in the following details: 

  Parameter   Value 

  Battalion   Select 1st Battalion. 

  Company   Select A Company. 

  Select which Guard you are a 
member of  

  Select ARNG. 

  ARNG Rank   Select E-4/CPL. 

  MOS   Type 12W. 

  Select Duty Type   State Active Duty 

  First Name   Type your first name. 

  Last Name   Type your last name. 

  Commander   Type your commander's name. 

  Provide Location   Select your location on the map or provide 
your address. 

  Can you report for duty   Select Yes. 

  Check Completed By   Select Self. 

3. Click Submit.  
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Complete a readiness batch report 
Alternatively, you will start by assuming the role of a readiness NCO. You are asked to use the 

Personnel Readiness Batch Report survey to submit availability of troops. 

1. In a browser, go to your Personnel Readiness Batch Report survey. 

2. In the Personnel Readiness Batch Report survey, fill in the following details: 

  Parameter   Value 

  Enter Location   Select your location on the map or provide your 
address. 

  Battalion   Select 1st Battalion. 

  Company   Select A Company. 

  Select which Guard you 
are a member of 

  Select ARNG. 

  ARNG Rank   Select E-7/SFC. 

  MOS   Type 25W. 

  Select Duty Type   Select State Active Duty. 

  First Name   Type your first name. 

  Last Name   Type your last name. 

  Commander   Type your commander's name. 

  Select which Guard(s) you 
would like to submit 
entries for 

  Select ARNG (Army National Guard). 

  ARNG Available Troops   Enter the number of troops available to report for 
duty. 

  ARNG Unavailable Troops   Enter the number of troops not available to report for 
duty. 

  Would you like to input 
details for each ARNG 
duty type? 

   Yes 

  ARNG Duty Type Details   Enter the number of troops under each duty type, the 
number of troops entered must equal the number of 
troops available to report for duty. 

  Total Available Troops   Updated automatically. 

  Total Unavailable Troops   Updated automatically. 

3. Click Submit.  
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Monitor personnel readiness 
Now you will assume the role of the Readiness NCO in the same unit. You are asked to monitor 

the readiness of your unit and are looking to see if your unit is available to be assigned to a 

mission. You will view the overall readiness of your workforce. 

Note: 

The steps below are the same if you are an administrative NCO and will be using the Admin 
Dashboard to monitor the readiness of your team. The Admin Dashboard will contain 
personal information about the individual unit members. 

1. In a browser, go to the Readiness Dashboard application. 

  The Readiness Dashboard opens with an overview of the overall readiness of the brigade 
and each battalion within the brigade. 

2. In the filter at the top of the dashboard, the Last 24 Hrs tab is automatically selected to 
view a list of submissions within the last 24 hours. The Last 48 Hrs and Last 72 Hrs 
options can also be selected. 

3. Activate the Date Range filter by first selecting All in the Time frame filter and then 
providing a Start and End date. Review the list of personnel and their locations in the map. 

4. Click each of the battalion tabs to see the availability for each company in that battalion. 
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Road Closures 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Road Closures 
Road Closures can be used to maintain an inventory of road closures and communicate 

closures and detours to travelers. 

Public works and public safety departments close roads for construction activities, special 

events, and public safety incidents, often creating detours for drivers. Proactively managing and 

communicating closure and detour information helps residents and drivers navigate an altered 

road landscape and avoid unnecessary congestion. Road Closures is typically implemented by 

public works and public safety agencies that want to have a single catalog of roads impacted by 

construction activities, events, and incidents and share this information with the public. 

The Road Closures solution delivers a set of capabilities that help you inventory road closures 

and related detours, communicate closures and detours with the public, and share authoritative 

closure information with consumer applications, such as Waze. 

 

Requirements 
Road Closures requires the following: 

• ArcGIS Enterprise 10.7.1 - 10.8.1 

 

Information products 
Road Closures includes the following information products: 

Item Description 

Minimum 

user type 

Road 

Closures 

An ArcGIS Web AppBuilder app used by public works and public 

safety staff to maintain an inventory of road closures and 

communicate closures, blocks, and detours to travelers 

Editor 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Road Closures 
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Configure Road Closures 
Learn how to configure the Road Closures solution to meet specific needs in your organization. 

 

Create a public road closure map 
Focused road closure maps and information can be embedded in your website so they can be 

accessed by the general public. Maps can be focused on public safety incidents or specific 

events occurring in a community, or they can be more general road closure maps used during 

road construction season. 

To create a public road closure map, complete the following steps: 

1. Sign in to your ArcGIS organization. 

2. Create a map that can be used by the general public to view road closures by doing the 
following: 

a. Choose a basemap. 

b. Add the RoadClosures_public layer to the map and remove RoadClosures_public 
from the layer names. 

c. Save the map as Public Road Closures. 

3. Share the map with your organization and everyone. 

4. Embed the Public Road Closures map in your public works website. 

 

Share with Waze 
Sharing your road closure information allows consumer navigation and traffic companies, such 

as Waze, to leverage the information in apps used daily by the general public. Sharing up-to-

date information with these apps helps minimize the impact of road closures, ease congestion, 

and enhance driver safety in your community. The road closures layer complies with the 

Common Internet File Structure (CIFS) for road closures but must be configured, as shown 

below, to capture required information. 

 

Share road closure information 
To share your road closure information with Waze, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization. 

2. When assigning a Creative Commons License to your RoadClosures layer, choose the 
following options: 

– For Allow adaptations of your work to be shared, choose Yes. 

– For Allow commercial uses of your work, choose Yes. 

3. In the Have a web page area, copy the HTML that is generated by the Creative Commons 
site. 
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4. In your ArcGIS organization, browse to your RoadClosures_public layer. 

5. Open the item details page. 

6. Click Edit to edit the item details. 

7. Scroll to the Terms of Use section and click Edit. 

8. Click View HTML Source. 

9. Paste the HTML copied from the Creative Commons site into the Terms of Use text box. 

10. Click Save. 

  Note: 

  You must use a license that allows international commercial use and allows shared 
adaptations or a license placing your data in the public domain. 

11. Enroll in the Waze for Cities program. 

  When you share your road closure information with Waze for Cities, new road closures 
added by your community in ArcGIS will be added to Waze every minute. 

 

Add your organization reference 
To share your road closures with Waze, you must store your organization reference with every 

road closure. This field is used by Waze to identify which organization the road closure data is 

coming from. The reference name must be a maximum of either 10 capital letters or 12 

lowercase letters. The reference is your Waze for Cities program ID. 

To add your organization reference, complete the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Road Closures 
map. 

2. Open the item page and click Open in Map Viewer. 

3. Click Edit. 

4. Click Manage. 

5. Click the Layer drop-down arrow and choose the Road Closures layer. 

6. Click the drop-down arrow next to the Both Directions feature template and choose 
Properties. 

7. In the Properties window, scroll to Organization and enter your organization reference. 

8. Click Done. 

9. Repeat steps 6 through 7 for the One Direction feature template layer properties. 

10. Click Save Changes. 

 

Set required fields 
To share your road closures with Waze, some information is required. You must change the 

fields indicated below as required so all road closures that are created capture the information 

needed by Waze. 
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To set fields transmitted to consumer apps as required, complete the following steps: 

1. Verify that you are signed in to your ArcGIS organization and browse to the Road Closures 
app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab and click Set the widget in this controller to open the page for an 
in-panel widget. 

4. Hover over the Create New Closure widget and click the Configure this widget button 

 to open the widget configuration window. 

5. Click the Smart Actions tab. 

6. Click Add New. 

7. In the Group Name text box, type Required Fields. 

8. Click the Layer for Expression drop-down arrow and choose Road Closures. 

9. Click the Edit Expression button. 

10. Click Add expression and set the expression to OBJECTID is not blank. 

11. Click OK. 

12. Expand the Road Closure layer and check the check box for following fields as required: 

– Street Name 

– Reason 

– Description 

– Direction 

– Start Time 

– End Time 

13. Click OK twice. 

14. Save the app. 

 

Configure the Road Closures layer to share with Waze 
One of the partners that your community can share data with is Waze through the Waze for 

Cities program. To share your data with Waze, follow the steps found in the Waze partners 

Overview page. To share your feed, you must create a JSON request from the Public Road 

Closures feature layer. 

To create the request URL required by Waze, follow the steps below: 

1. Verify that you are signed in to your ArcGIS organization and browse to the 
RoadClosures_public item. 

2. Open the item page and click the Road Closures layer under Layers. 

3. From the layer URL, click Copy. 

4. Paste the URL into a text editor. 
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5. Copy the code below and paste it into the text editor at the end of the URL you pasted in 
the previous step. 

  /query?where=1%3D1&outFields=OBJECTID,street,subtype,description,directio
n,starttime,endtime,type,reference&outSR=4326&returnZ=false&f=geojson 

  Tip: 

  For more information on querying a feature layer, see Query a feature layer. 

6.  Provide the URL to Waze. 

  

https://www.esri.com/en-us/privacy/overview
https://www.esri.com/en-us/legal/overview
https://developers.arcgis.com/rest/services-reference/query-feature-service-layer-.htm
https://links.esri.com/localgovernment/help/waze-roadclosures


    Back to top 

Copyright © 2023 Esri. All rights reserved. | Privacy | Legal Page 197 

Use Road Closures 
The Road Closures solution delivers a set of capabilities that help you inventory road closures 

and related detours, communicate closures and detours with the public, and share authoritative 

closure information with consumer applications, such as Waze. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note:  

Use your organization's data or configured apps to follow these workflows. 

 

 

Create road closures 
You will assume the role of an employee in the public works department. You have received 

plans for streets that will need to be closed. You will draw the closures on the map, place the 

road blocks, and identify the detour routes. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Road Closures 
solution. 

2. View the Road Closures app. 

  The Road Closures app opens with the Create New Closure widget open on the right. 

3. In the Create New Closure widget, check the Use Preset Values (new features only) 
check box. 

4. Type the contact information for the closure in the appropriate text boxes. 

5. In the Identifier text box, type a unique ID. 

  Note: 

  This information will be added to each closure, road block, and detour you create to 
associate it with the same event. 

6. On the map, use the search field or pan and zoom to the closure location. 

7. In the widget, click the Both Directions template. 

8. Click the map and begin to draw a line at an intersection; click to add a vertex and double-
click to finish the closure line. 

  After you finish drawing the closure on the map, a Road Closures form appears on the 
right. 

9. Complete the form with as much information as possible. 

10. Click Save. 

11. Click the Road Blocks template. 

12. On the map, click the intersection on one side of the closure. 
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Note:  

The road block is automatically populated with the information from the closure it 
intersects, so you don’t have to reenter it. 

13. Click Save. 

14. Click the Road Detours template. 

15. On the map, sketch the alternate route around the closure and double-click to finish 
drawing the line. 

  Note: 

  If the detour intersects the closure at the start and end, it automatically pulls the details 
from the closure. 

16. Click Save. 

 

Update closure details 
You will continue as an employee in the public works department. Dates for a road closure have 

been extended. You will update the end date of the closure and its associated road blocks and 

detour. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Road Closures 
solution. 

2. View the Road Closures app. 

3. In the upper right of the app, click the Update Existing Closures button to open the 
widget. 

4. In the Update Existing Closures widget, click the Extent tool. 

5. On the map, drag a box around the road closure, including the associated road blocks and 
detour. 

6. In the Update Existing Closures pop-up, click the End Time drop-down arrow and 
choose a new date. 

7. Click Save. 

  Closures that are no longer active, with an end date that is before today, will continue to 
show on the map but will have a transparency applied. This feature is helpful when you 
have reoccurring events; for example, past closures can be selected and updated with new 
dates. 
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Road Network Data Management 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Road Network Data Management 
Road Network Data Management can be used to maintain an authoritative inventory of roads, 

intersections, and physical road characteristics and track legal agreements executed with a 

public works agency. 

It provides a series of workflows and standard road layers that streamline the maintenance of a 

public road repository, their physical characteristics, and legal agreements defining 

maintenance services provided by the organization. Road Network Data Management is 

typically implemented by public works and transportation departments that want to develop and 

maintain a public road repository that supports a variety of maintenance functions. 

The Road Network Data Management solution delivers a set of capabilities that help you 

maintain a standard set of public road layers, streamline road data management workflows, 

track maintenance agreements, and continuously improve the quality of public road information. 

 

Requirements 
Road Network Data Management requires the following: 

• ArcGIS Enterprise 10.7.1 - 10.8.1 

• ArcGIS Pro 2.5 or later (Standard or Advanced) 

 

Information products 
Road Network Data Management includes the following information products: 

Item Description 

Minimum user 

type 

Road Network 

Data Management 

An ArcGIS Pro project used by mapping technicians 

to maintain an authoritative inventory of public roads, 

road intersections, and physical road characteristics 

GIS 

Professional 

Standard 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Road Network Data Management 
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Use Road Network Data Management 
The Road Network Data Management solution delivers a set of capabilities that help you 

maintain a standard set of public road layers, streamline road data management workflows, 

track maintenance agreements, and continuously improve the quality of public road information. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note:  

Use your organization’s data or configured apps to follow these workflows. 

 

 

Manage road network data 
You will start by assuming the role of a mapping technician responsible for maintaining an 

inventory of public roads, road intersections, and physical road characteristics. The Road 

Network Data Management ArcGIS Pro project includes a series of tasks to help guide you 

through these workflows. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the Road Network 
Data Management solution. 

2. Download the Road Network Data Management desktop application template, and then 
unzip the folder. 

3.  From the unzipped folder, open the Road Network Data Management ArcGIS Pro project 
in ArcGIS Pro. 

4. In the Catalog pane, expand the Tasks folder, and then double-click the Road Network 
Data Management task item. 

  Note: 

  If you do not see the Catalog pane, from the View tab, in the Windows group, click 
Catalog Pane. 

5. In the Tasks pane, expand the How to use Road Network Data Management task group 
to see the collection of tasks. 

 

Add roads 
Roads are line segments representing centerlines of all public roadways or carriageways that 

support asset management and mapping. Typically, this information is compiled from 

authoritative road centerlines maintained for addressing purposes. 

1. To add new public roads, follow the steps in the Add roads task. 
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Add intersections 
When creating new roads, existing roads are split at intersections along the new road. An 

inventory of road intersections with the names of relevant crossroads is often required by 911 

systems and to manage right-of-way assets. 

1. To add new road intersections, follow the steps in the Add intersections task. 

 

Add road characteristics 
A series of map layers is used to track the characteristics (for example, ownership, functional 

classification, speed limit, physical characteristics, and special routes) of each public road. The 

feature classification and type schema for the roads is based on a functional classification of 

roads provided by the Federal Highway Administration (FHWA). Specific attributes and default 

values vary for each feature type. 

1. To add new road characteristics, follow the steps in the Add road characteristics task. 

 

Track maintenance agreements 
You will now assume the role of an engineer or operations staff at a public works agency. You 

are responsible for managing the legal agreements defining maintenance services provided by 

the agency for assets within the public right-of-way. 

1. In a browser, from the Road Network Data Management solution, view the Road 
Maintenance Agreements app. 

  The app opens with the Create Maintenance Agreement open on the right. 

2. In the Create Maintenance Agreement widget, choose a template. 

3. Click the map to start a sketch. 

4. Click the map to add additional vertices and double-click to finish the sketch. 

  After you finish the sketch, the Road Maintenance Agreements legal agreement form 
opens in the Create Maintenance Agreement widget. 

5. Complete the details of the legal agreement. 

6. Click Save. 

7. At the top right, click the Filter Maintenance Agreement button to open the widget.  

8. Filter for the asset type that you just added. 

9. On the map, select an agreement to view its details. 
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ROW Permitting 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to ROW Permitting 
ROW Permitting can be used to manage permit applications required to construct, operate, use, 

or maintain a facility within the public right-of-way. 

It provides a single destination for right-of-way permit applications and supports comprehensive 

right-of-way permit review workflows in a community. Capturing the location of proposed work 

along with other permit information streamlines the permit review process and helps 

communicate where work is occurring in the public right-of-way. ROW Permitting is typically 

implemented by public works agencies and other local government organizations that want to 

reduce the time to apply for and receive approval for a right-of-way permit. 

The ROW Permitting solution delivers a set of capabilities that help you collect and organize 

permit applications, coordinate the permit review process, gather feedback during permit review, 

and share approved permits with internal and external stakeholders. 

 

Requirements 
ROW Permitting requires the following: 

• ArcGIS Enterprise 10.6.1 - 10.8.1 

 

Information products 
ROW Permitting includes the following information products: 

Item Description Minimum user type 

ROW Permit An ArcGIS Survey123 form used by contractors 

and property owners to apply for a permit to 

construct, operate, use, or maintain a facility within 

the right-of-way 

Editor (required if 

form is used for 

internal purposes 

only) 

ROW Permit 

Manager 

A Crowdsource Manager app used by public works 

agencies to facilitate the right-of-way permit 

process and manage the status of a permit 

application 

Editor 
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ROW Permit 

Review 

A Crowdsource Polling app used by government 

agencies to review right-of-way permit applications 

and offer comments during the review process 

Editor 

ROW Permit 

Public 

Comment 

A Crowdsource Polling app used by the general 

public and interested parties to review permit 

applications and comment on proposed 

construction activity 

Not required 

ROW Permit 

Locator 

An ArcGIS Web AppBuilder app used by the 

general public and other interested parties to locate 

pending and approved right-of-way permits in their 

community 

Not required 

ROW Permit 

Dashboard 

An ArcGIS Dashboards app used by public works 

executives to monitor the status of right-of-way 

permits in their community 

Viewer 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of ROW Permitting 
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Use ROW Permitting 
The ROW Permitting solution delivers a set of capabilities that help you collect and organize 

permit applications, coordinate the permit review process, gather feedback during permit review, 

and share approved permits with internal and external stakeholders. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

Note:  

Use your organization's data or configured apps to follow these workflows. 

 

 

Submit a permit application 
First, you will assume the role of a resident in the community. You want to host a block party in 

your neighborhood and close the street for the weekend. 

1. In a browser, from the ROW Permitting solution, view the ROW Permit form. 

2. In the Applicant Information section, provide your contact information. 

3. Leave the Contractor Information section blank, as this work does not require a 
contractor. 

4. In the Job Information section, search for the street that you want to close, and then place 
the point along that street. 

5. For Type, choose Temporary Use. 

6. For Subtypes, check the Neighborhood Festival check box. 

7. For Description, provide a brief description. 

8. For Site Plan \ Construction Drawings, if applicable, upload a drawing of where the road 
blocks should begin and end. 

9. For Proposed Start Date and Proposed Completion Date, choose dates for the closure. 

10. For Lane Closure Required, choose No. 

11. Sign the form, and then click Submit. 

 

Manage permit status 
You will now assume the role of a supervisor in the public works department. It is your job to 

review and triage permit requests and ensure the permit application is reviewed by the correct 

people. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the ROW Permitting 
solution. 
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2. View the ROW Permit Manager app. 

  All permit applications are listed in the table at the top. The table can be sorted and filtered 
in various ways. 

3. Click a permit with a status of Submitted. 

  The permit application details open at the lower left. 

4. On the Details tab, review the permit application information, and then click the Edit 

Record button . 

5. For Status, choose StaffReview. 

6. Click Save. 

  The permit is now displayed in the ROW Permit Review app and can be shared with other 
departments or agencies to provide their feedback and approval. After all departments 
have approved the permit, you'll change the status in the ROW Permit Manager app to 
BoardReview. 

7. Click the Edit Record button again. 

8. For Status, choose BoardReview. 

9. Click Save. 

  The permit is now displayed in the ROW Permit Public Comment app and can be shared 
with the general public for feedback. If public feedback is positive and you are ready to 
approve the permit, you'll change the status to Approved. 

10. Click the Edit Record button again. 

11. For Status, choose Approved. 

12. Click Approved/Denied Date and choose the current date. 

13. For Approved State Date and Approved Completion Date, specify values that signify the 
dates that the permit is valid. 

14. Click Save. 

 

Conduct internal review 
You will now assume the role of a supervisor in the public safety department. A permit 

application requesting a street closure has been submitted. You will review the permit details to 

confirm that all the necessary information is provided and that you don’t have any concerns. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the ROW Permitting 
solution. 

2. View the ROW Permit Review app. 

3. On the right, click a permit application in the list. 

  Tip: 

  If no permit applications are listed, return to the previous workflows and ensure that at least 
one permit application has a status of StaffReview. 
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4. Review the details, and then click the Add a comment button. 

5. For Organization, choose Public Works. 

6. Provide your name and comments. 

7. For Action Taken, choose Approved. 

8. Click Submit. 

 

Find approved and pending permits 
As an engaged resident, you are interested in learning more about the active and planned work 

in the community. 

1. In a browser, from the ROW Permitting solution, view the ROW Permit Locator app. 

  The app opens with the Locate ROW Permit widget open on the right. 

2. In the Locate ROW Permit widget, search for an address; alternatively, click the location 
on the map. 

  Any permits that are pending or approved appear at the bottom of the widget. 

3. If necessary, use the slider to increase the search distance and view additional permit 
applications. 

4. Click Pending or Approved, and then explore the permits that are within the specified 
search distance of the address. 

5. At the top of the list, click the Back button to return to the permit list and continue exploring 
nearby permits. 

Note: 

Pending permits have a Comment hyperlink that opens the ROW Permit Public Comment 
app. This app can be used by the general public to provide their feedback or concerns on 
the proposed work. 

 

Provide public comments 
Many communities have statutory public notice requirements that community members must be 

given the opportunity to express concerns about proposed developments and work within the 

public right-of-way. As a concerned resident, you will review the pending permits in the 

community and provide feedback instead of attending a council or commission meeting. 

1. In a browser, from the ROW Permitting solution, view the ROW Permit Public Comment 
app. 

2. Click a permit application in the list. 

  Tip: 

  If no permit applications are listed, return to the previous workflows and ensure that at least 
one permit application has a status of BoardReview. 
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3. Review the details, and then click the Add a comment button. 

4. Provide your name, address, and comments. 

5. Click Submit. 

 

Monitor permit applications 
Finally, you will assume the role of a supervisor in the public works department. It is your job to 

ensure that permits are moving through the application process and being approved or denied 

in a timely manner. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the ROW Permitting 
solution. 

2. View the ROW Permit Dashboard app. 

3. On the left, adjust the filters to refine the results. 

4. On the right, in the Permits panel, click a permit application to view a pop-up with 
application details; alternatively, click a permit on the map. 
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School Locator 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to School Locator 
School Locator can be used to share district and attendance zone boundaries with the general 

public. 

It provides 24/7 access to an organization, and the location-enabled search helps residents 

quickly find which school district their household is assigned to and understand which schools 

their children will attend. This transparent approach improves communication with the public 

and saves many parents time because they do not need to call the district for school 

assignments. The solution also helps residents and home buyers make important decisions 

when considering where, and when, to make a real estate move. School Locator is typically 

implemented by government agencies and school districts that want to educate the public and 

promote public education resources available in their community. 

The School Locator solution delivers a set of capabilities that help you share school district and 

attendance zone boundaries; highlight school performance; and promote available elementary, 

middle, and high school educational resources. 

 

Requirements 
School Locator requires the following: 

• ArcGIS Enterprise 10.6 - 10.8.1 

 

Information products 
School Locator includes the following information products: 

Item Description 

Minimum 

user type 

School 

Locator 

An ArcGIS Web AppBuilder app used by the general public to 

locate elementary and secondary schools and view school 

districts and attendance zone boundaries 

Not required 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of School Locator 
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Configure School Locator 
In this topic, you'll learn how to configure the School Locator solution to meet specific needs in 

your organization. 

 

Load data 
In some cases, you may already have this information in ArcGIS or another mapping system. 

Review the layers provided with the solution and determine what source data you want to load. 

Then, load your existing data into the layers provided with the solution before sharing the maps 

or apps. 

Once you have determined what source data must be loaded, complete one or more of the 

following data-loading workflows. 

 

Load data from a shapefile 
Load data into the SchoolDistricts layer from a shapefile by completing the following steps: 

1. Create a .zip file of your shapefile. 

2. Sign in to your ArcGIS organization and browse to the feature layer you want to populate. 

3. Open the item page and click Update Data > Append Data to Layer. 

4.  Click Choose File and browse to your .zip file, and click Open. 

5. Click Upload and Continue. 

6. Click Choose the layer that you wish to append data into drop-down arrow and choose 
the layer that contains the updated data. 

7. Uncheck Update existing features. 

8. Click Show field matching and map the fields between the two layers. 

9. Click Apply Updates. 

 

Configure directions 
Follow the steps below to connect to a routing service and configure the widget to enable 

directions in the app. 

 

Configure widget 
To configure an app to use routes and provide directions, complete the following steps: 

1. Sign in to your ArcGIS organization and browse to the ArcGIS Web AppBuilder app. 

2. Open the item page and click Edit Application. 

3. Click the Widget tab and click Set the widget in this controler to open the page for an in-
panel widget.  
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4. Hover over the Near Me widget and click the Configure this widget button to open the 
widget configuration window. 

5. Check the Enable Directions check box if it is not checked. 

6. Click the Direction Settings tab, click Set, and choose a routing service. 

7. Click Next and choose one or more route layers, click OK, and click OK again. 

8. Save the app and share it with everyone. 

9. Open the app. 

 

Esri premium content 
The app draws routes and provides directions using the ArcGIS Online World Route Service. 

This service requires subscriber access because it consumes credits. See Configure Living 

Atlas content to enable access to premium content. 

Learn more about credit usage when creating simple routes 
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Use School Locator 
The School Locator solution delivers a set of capabilities that help you share school district and 

attendance zone boundaries; highlight school performance; and promote available elementary, 

middle, and high school educational resources. 

Note:  

Use your organization’s data or configured apps to follow these workflows. 

 

 

Find schools and attendance zones 
You will assume the role of a resident in the community and want to learn more about schools 

and attendance zone boundaries in your area. 

1. In a browser, sign in to your ArcGIS organization, and then browse to the School Locator 
solution. 

2. View the School Locator app. 

3. In the Locate School widget, under Search for an address or locate on map, type an 
address in the community and press Enter. You can also click the map to set a location. 

  The list updates to display school attendance zones that serve the location entered. 

4. Review the list of school attendance zones. 

  Using the list, you can see information related to which school your child will attend, 
enrollment numbers, the school district, and directions. 

5. In the school attendance zones results list, click Elementary School Attendance Zone. 

  The map zooms to corresponding school attendance zone boundaries and highlights the 
associated school your child will attend based on your searched address. 

  The Information tab displays details regarding which school your child will attend, current 
enrollment numbers, and the name and size of the school district. 

6. Click the Directions tab. 

  The tab displays turn-by-turn directions from the searched address to the school location. 

7. Click the Back button to return to the school attendance zones results list. 

8. Repeat step 4 for both Middle School Attendance Zone and High School Attendance 
Zone. 
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Shelter Locator 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Shelter Locator 
Shelter Locator can be used to share emergency shelters activated during an incident or event. 

It provides continuous access to an organization, and the location-enabled search helps 

residents quickly find shelter information. This transparent approach improves communication 

with the public and promotes efficient use of transportation and shelter resources. Shelter 

Locator is typically implemented by emergency management agencies that want to avoid 

unnecessary travel when conditions require residents to seek protection outside of their homes. 

The Shelter Locator solution delivers a set of capabilities that help you share shelter locations 

and promote the current operating status of shelters when an incident or event occurs. 

 

Requirements 
Shelter Locator requires the following: 

• ArcGIS Enterprise 10.7 - 10.8.1 

 

Information products 
Shelter Locator includes the following information products: 

Item Description 

Minimum 

user type 

Shelter 

Locator 

An ArcGIS Web AppBuilder app used by the general public to 

locate emergency shelters activated during an incident or event 

and understand their current operating status 

Not required 
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Release notes 
The following are the release notes: 

Version Description 

1.0 • First release of Shelter Locator 
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Configure Shelter Locator 
Learn how to configure the Shelter Locator solution to meet specific needs in your organization. 

 

Load emergency shelters 
You may have emergency shelters that you want to use in the Shelter Locator solution. To 

accomplish this objective, you will need to load your data into the EmergencyShelters layer 

provided with the app. 

Note: 

To append your data, it must be in either a shapefile format. 

To load your facilities information from another data source, complete the steps below: 

1. If necessary, sign in to your ArcGIS organization. 

2. At the top of the site, click Content. 

3. On the My Content tab, type Shelter Locator in the search box. 

4. Under the Item Type, click Layers and click Feature Layers. 

  Note: 

  Some of the feature layers have a suffix added, such as public. These are layer views of 
the of the original source feature layer. These layer views are used to share information 
with the public without showing all the details or allowing the public to edit the layers. The 
original source layers do not have a suffix. 

5. Click Emergency Shelters to view the item details. 

6. Click Update Data and select Append Data to Layer. 

7. Under Filename, choose your shapefile. 

8. Click Upload and click Continue. 

9. Click Show field matching to match the fields from the spreadsheet to the fields in the 
selected feature layer. 

10. After you have matched the fields, click Apply Updates. 

11. Click the Data tab in the banner of the item page to confirm your data has loaded 
successfully. 

Tip: 

When the Emergency Management Operations solution and the Shelter Locator solution 
are deployed by the same user, the EmergencyShelters layer is shared between the 
solutions. This allows the emergency shelter status to be updated using the Operations 
Response app. The shelter status is then visible in the Shelter Locator and other apps that 
are part of the Emergency Management Operations solution. 
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Use Shelter Locator 
The Shelter Locator solution delivers a set of capabilities that help you share shelter locations 

and promote the current operating status of shelters when an incident or event occurs. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Locate an emergency shelter 
You will assume the role of a resident in the community and want to learn more about available 

shelters in your area. 

Follow the steps below to locate a shelter using the sample data. 

1. In a browser, sign in to your ArcGIS organization, browse to the Shelter Locator item, and 
choose view application. 

2. In the Locate Shelter pane, drag and use the buffer distance slider to set a distance of 3 
miles. 

  The slider allows a user to define a distance once an address is entered or a location is 
identified on the map. 

3. In the Locate Shelter pane, under Search for an address or locate on map, type an 
address. 

4. In the Locate Shelter pane search results, click a shelter to review its information, such as 
its address, hours of operation, status, and contact information. 

5. In the Locate Shelter pane, click the Information tab and review additional information 
about the selected shelter. 

  The information in the pop-up varies by location, depending on the services offered by 
each shelter. 
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Target Hazard Analysis 

 

This solution documentation has been archived and is no longer updated. Content and links 

may be outdated. 

Mature phase 
Nov 2023 - Oct 2025 

Retired phase 
Nov, 2025 

 

Introduction to Target Hazard Analysis 
Target Hazard Analysis can be used to identify properties and buildings that could result in a 

loss of life, or have a negative impact on the community, if a fire were to occur. 

Many fire departments are taking proactive steps to assess risk and mitigate the impact of a fire 

in their community. The first step in this risk assessment is the identification of buildings or 

properties that may harm the community if a fire were to occur. Occupancy, size, life safety and 

economic impact are some of the criteria used to assess the risk of a building or property. 

Understanding risk can be a time consuming process and reducing the time it takes to conduct 

an assessment saves fire departments money. It also allows them to evaluate their community 

on a regular basis and measure the effectiveness of mitigation strategies. Target Hazard 

Analysis is typically implemented by fire departments that want to understand risk in their 

community and use the assessment to prioritize preplanning activities, fire inspections and other 

community risk activities. 

The Target Hazard Analysis solution delivers a set of capabilities that help you calculate a 

hazard score for each building or property and understand where a fire may negatively impact a 

community. 

 

Requirements 
Target Hazard Analysis requires the following: 

• ArcGIS Enterprise 10.7 - 10.8.1 

• ArcGIS Pro 2.5 or later (Basic, Standard or Advanced) 
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Information products 
Target Hazard Analysis includes the following information products. 

Item Description 

Minimum user 

type 

Target 

Hazard 

Analysis 

An ArcGIS Pro project package used by fire service 

personnel to identify properties and buildings that could result 

in a loss of life, or have a negative impact on the community, 

if a fire were to occur. 

GIS 

Professional 

Basic 

 

Release notes 
The following are the release notes: 

Version Description 

1.0 First release of Target Hazard Analysis 
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Use Target Hazard Analysis 
The Target Hazard Analysis solution delivers a set of capabilities to calculate a hazard score 

with user-defined criteria such as occupancy type, life safety, building size, economic impact, 

and fire flow requirements. 

In this topic, you’ll learn how to use the solution by assuming the role of a user and performing 

the workflows below. 

 

Understand hazard criteria 
Before using Target Hazard Analysis it is important to understand the criteria used, tools and 

tasks provided, and the data requirements. Gaining this understanding before you begin will 

help you use it effectively and produce target hazard results. To conduct a target hazard 

analysis, it is necessary to determine the evaluation criteria. The criteria are used to assess the 

potential impact of a fire on each building. The greater the potential impact, the greater the 

target hazard score. Certain attributes are required to perform a target hazard analysis of 

buildings or parcels. Information is provided to describe the minimum attributes you will need for 

each property. 

To learn more about the criteria contained in Target Hazard Analysis, follow these steps: 

1. Sign in to your ArcGIS organization and browse to the Target Hazard Analysis Desktop 
Application Template. 

2. Open the item page and click Download. 

3.  Unzip and open the Target Hazard Analysis ArcGIS Pro project. 

4. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

5. In the Catalog pane, expand the Tasks folder, and double-click the Target Hazard 
Analysis task item. 

6. In the Task Pane, click the Getting started task group to expand the collection of tasks. 

 

Perform building analysis 
This workflow uses occupancy, life safety, floor area, height, fire flow, and economic impact to 

calculate a hazard score on all buildings. Choose this workflow when the minimum attribute 

information is available in your buildings layer. If some of the required attributes are in your 

parcels layer, you can transfer the required attributes from a parcel layer to a buildings layer as 

part of this workflow. 

You will assume the role of a fire fighter responsible for conducting a target hazard analysis on 

all buildings in your community. The Target Hazard Analysis ArcGIS Pro project includes a 

series of tasks to help guide you through this workflow. 

1.  Open the Target Hazard Analysis ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 
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3. In the Catalog pane, expand the Tasks folder, and double-click the Target Hazard 
Analysis task item. 

4. In the Task Pane, click the Perform target hazard analysis with buildings task group to 
expand the collection of tasks. 

5. Click on each task and follow the steps provided. 

 

 

Perform parcel analysis 
This workflow uses occupancy, life safety, floor area, height, fire flow, and economic impact to 

calculate a hazard score on all parcels. Choose this workflow if you do not have building 

information and all of the necessary information is available in your parcel layer. 

You will assume the role of a fire fighter responsible for conducting a target hazard analysis on 

all parcels in your community. The Target Hazard Analysis ArcGIS Pro project includes a series 

of tasks to help guide you through this workflow. 

1.  Open the Target Hazard Analysis ArcGIS Pro project. 

2. On the View tab, in the Windows group, click Catalog, and click Catalog Pane. 

3. In the Catalog pane, expand the Tasks folder, and double-click the Target Hazard 
Analysis task item. 

4. In the Task Pane, click the Perform target hazard analysis with parcels task group to 
expand the collection of tasks. 

5. Click on each task and follow the steps provided. 
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